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Chapter 1:  
Introduction 

DataSuite is the latest software release from fourtec, integrating its existing, legacy 
software platforms into one unified application providing support for a wide range of 
fourtec products. You can now monitor and compare data from multiple systems on 
one, single view.  

 

The DataSuite solution supports simultaneous connection of the following fourtec 
data acquisition systems:  

 DataNet 

          

 DaqLink 

    

 

 MicroLite II 

       

 MicroLogPRO II 

       

 

Each product is supported in the DataSuite modular platform by specific product 
modules, with each module having a 30 day trial period. DataSuite is installed with all 
product modules included, but module activation is required per module. Once the 
trial period ends, the software won’t detect the loggers without activation using a 
unique serial number. 

Note: MicroLite software module is free and doesn’t require activation. 
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DataSuite key features include: 

 Software GUI based on proven fourtec platforms 

 Multiple data view features 

 Map view displaying unit location, signal path and strength 

 Alarm features with 4 alarm levels sending email and SMS notifications 

 Reporting module for creating and generating reports with selected distribution 

 Analysis features including dew point analysis, FO Pasteurization, histogram, 
statistics with export to Excel and CSV formats 

 FDA Title 21 CFR Part 11 compliancy (in future versions) 

 API for DataNet system integration 

 

Seamless Migration from Legacy fourtec Software 

Existing fourtec users enjoy a seamless upgrade from DataNet software to the 
DataSuite software. 

All data files and system configurations are migrated. And existing license keys 
remain valid, so there is no need to purchase additional licenses.  

The Uptodata software update mechanism allows for easy download and installation 
of new DataSuite releases. 

Existing MicroLite I users can continue using the current MicroLab Lite software, or 
install DataSuite for MicroLite (for free) and enjoy the enhanced features of the 
DataSuite platform. 

 

User Guide Overview 

This user guide includes the DataNet, DaqLink, MicroLite, and MicroLogPRO II 
products. 

It is comprised of the following chapters:  

 Chapter 1: Introduction 

 Chapters 2-4: DataNet  

 Chapters 5-7: DaqLink  

 Chapters 8-10: MicroLite II 

 Chapters 11-13: MicroLogPRO II  

 Chapter 14: Using the DataSuite Software 

 Chapter 15: Updating DataSuite Software and Firmware 

 Appendices A-H 

 

DataSuite CFR Compliancy * Available December 2011 

DataSuite includes an additional CFR module which together with the separate 
DatPass Administrative software achieves compliance with FDA Title 21 CFR Part 
11. Among other features, it defines the users that can log into the DataSuite 
software, their passwords and the digital signatures the users are permitted to sign 
data within electronic records (files). DatPass also maintains an audit trail to keep 
track of all activities performed within the system and user privileges can be defined 
as well. The CFR module includes a 30 day trial period following which the module 
must be activated using a unique Serial Number.  
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Chapter 2:  
DataNet Overview 

This chapter provides a general overview of the DataNet system as well as the 
concept behind the ZigBee RF protocol. 

2.1. DataNet Introduction 

The Wireless Intelligent Logging Network 

fourtec’s next generation data logging system is the DataNet, a 16-bit, mobile data 
acquisition network based on the innovative and reliable ZigBee technology. This 
solution provides an intelligent sensor mesh system with 100% data receipt and no 
data loss.   

The DataNet system is comprised of a family of data logging units, as well as a 
Receiver to manage the intelligent network and Repeaters to extend the transmission 
range. The data loggers measure a broad range of parameters and include models 
that feature between one and four inputs for direct measurement and recording of 
PT-100, thermocouple, 0 to 1 V, 4 to 20 mA, contact, frequency and pulse sensors, 
as well as internal temperature and relative humidity sensors. These models range 
from loggers with graphic display, AC or battery power supply, and power 
amplification, to models with no display and battery power only.  

Data is transmitted from the end units to a Receiver connected to a central computer. 
The system leverages the ZigBee protocol, a 2.4 GHz license-free frequency RF 
band, to ensure full data integrity. By adding DataNet Repeater units or loggers with 
power amplification to the network, you can extend the transmission range and form 
a reliable mesh network of up to 65,000 units. 

With its high resolution and fast Analog to Digital converter (ADC), DataNet data 
loggers meet the majority of data acquisition requirements in most industrial 
applications. Every DataNet logger unit is embedded with a unique serial number and 
can be loaded with a descriptive comment for safe identification. An internal clock 
and calendar keeps track of the time and date of every sample measured. 

DataNet loggers can automatically activate external alarm events when data is 
outside a specified range. Email and SMS notifications can be sent to predefined 
contacts.  

The DataNet system is powered by the powerful DataSuite software. The Windows 

 based software is the central management interface of the DataNet network. Data 
is monitored online and can be displayed in graphs or tables. You can analyze data 
with various mathematical tools, or export data to a spreadsheet. Detailed reports 
can also be generated from the system, collating a wealth of relevant system data. 

The software also enables you to configure, calibrate or update the firmware of 
DataNet units wirelessly.  

 

Key DataNet benefits include: 

 Reliable transmission ensuring no data loss 

 Long-range monitoring 

 Ability to constantly expand transmission range by adding additional Repeaters, 
or turning loggers into Repeaters 
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 Portable units facilitating easy deployment in various environments 

 Remote programming and firmware updates  

 65,000+ possible end units per network 

 16-bit resolution 

 Low-power consumption 

 Long battery life 

 Minimal costs thanks to wireless infrastructure 

 Feature-rich software, including multi-network support per PC 

2.2. What is ZigBee? 

ZigBee is a standards-based protocol built around the IEEE * 802.15.4 wireless 
protocol, providing the network infrastructure required for wireless, low power 
network applications.  

The mesh network eliminates single points of failure by providing multiple pathways 
for data to travel. 

* IEEE is the Institute of Electrical and Electronics Engineers, a non-profit 
organization dedicated to furthering technology involving electronics and electronic 
devices. 

2.3. The ZigBee Concept 

The Coordinator: This device creates and maintains the network. Once the network 
is up and running, the coordinator behaves as just another device on the network. 
There is only one Coordinator in a ZigBee network.  

The Router: A router relays data packets/messages between devices on the network 
and increases the distance between these devices.  

The End Unit: This device sends and receives information to other devices on the 
network. It is usually a control or a sensor unit, often battery operated. A ZigBee end 
unit cannot relay messages.  

ZigBee Terminology DataNet Terminology 

Coordinator Receiver 

Router Repeater 

End Unit Data Logger 

 

ZigBee enables mesh networking which supports a wireless, yet integrated 
environment with communication between many coordinators, routers and end units 
in environments where multiple applications are being monitored.  

2.3.1. ZigBee Mesh Network Operation 

 

Figure 1: ZigBee network diagram 
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In a mesh network, all the router units are aware of their environment meaning a 
router knows with units are close by. When a router sends a message to a specific 
unit, it relays the message until it gets to the destination. 

 

Network recovery from a unit failure 

In a mesh network, when a router fails, the network automatically finds a different 
path via a different router for the message relay. 

This ensures maximum protection against a network breakdown. 

2.3.2. Why is ZigBee Technology Key for Data Logging? 

ZigBee technology has proved to be ideal for data acquisition networks which require 
meter reading, parametric display of data such as temperature or humidity and 
responsive action when parameters are crossed. This is due to the fully automated, 
flexible and reliable nature of the protocol. With the Mesh Network system, the 
ZigBee standard redresses misbalances in any data logging system, responding to 
weaknesses, inefficiencies, new network structure (with the additional or removal of 
devices) through self correction.  

2.4. The DataNet System  

The basic DataNet system will contain at least one of the following units: 

 DataNet data logger – Part Number DNL804, DNL808, DNL810, DNL804-BXT, 
DNL808-BXT, DNL810-BXT, DNL910, DNL920, DNL910-PA, DNL920-PA 

 Receiver/Repeater unit – Part Number DNR900 

 Mini Repeater – Part Number DNR800 

 Mini-USB cable  

 Power adapter (one per DataNet unit ordered) 

 DataSuite Software CD with unique serial number 

2.4.1. The Data Logger  

There are seven distinct data logger models compatible with the DataNet system. 
These are the so-called end units of the system. These loggers support up to four 
external sensors and two internal sensors, temperature and humidity, depending on 
the specific model. Data is recorded and stored to the logger’s internal memory and 
transmitted over the network to the DataSuite software running on the PC.  

The data logger is programmed to consume as little power as possible during 
operation, in order to conserve the battery life. When not transmitting or recording 
data the units are in sleep mode and they wake up when needed.  

The battery for the DNL910 and DNL920 is rechargeable and can run up to several 
months on one charge, depending on the logger configuration.  

The DNL910-PA and DNL920-PA loggers include power amplification (PA), enabling 
longer transmission range compared to the non-PA units, and as a result have high 
power consumption. The PA units therefore must be connected to AC power at all 
times otherwise its battery will drain after a few hours.  

The battery for the DNL804, DNL808 and DNL810 is not rechargeable and can run 
up to ten months before being replaced, depending on the logger configuration. 
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The DNL8XX-BXT models provide extended battery life to the existing Mini DataNet 
loggers, for up to 3 years with 4 x AA 3.6V batteries connected. 

 

Refer to section ‎4.9.7 for more information.  

Note: Battery life depends on the logger sampling rate, transmission rate, type of 
sensor, network architecture and number of measured sensors. 

The seven DataNet models can be divided into two groups:  

 DataNet loggers (with LCD) 

 Mini DataNet loggers (without LCD) 

DataNet Loggers (with LCD) 

  

Part Number: DNL920 and DNL920-
PA 

Part Number: DNL910 and 
DNL920-PA 

Four external channel RF data logger 
with two internal sensors, Humidity 
and Temperature. 

* PA model includes Power Amplifier 
for long-range transmission.  

Four external channel RF data 
logger with internal Temperature 
sensor. 

* PA model includes Power Amplifier 
for long-range transmission. 

Transmission Range:  
DNL920: 4 dBm 

DNL920-PA: 17 dBm 

Memory Capacity: ~59,000 samples 

Power supply: AC or battery 
operated 

Transmission Range:  

DNL910: 4 dBm 

DNL910-PA: 17 dBm 

Memory Capacity: ~59,000 
samples 

Power supply: AC or battery 
operated 
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Mini DataNet Loggers (without LCD) 

 

 

 
 

 

 

 

 

 

 

 

DNL804 DNL804-
BXT 

DNL808 DNL808-BXT DNL810 DNL810-
BXT 

Single channel RF data 
logger supporting external 4 
to 20 mA  input 

Single channel RF data 
logger supporting external 
temperature NTC 10KΩ 
probe 

Dual channel RF data 
logger with internal 
Temperature and 
Humidity sensors. 

DNL8XX-BXT Models 

BXT models include built-in battery pack supporting up to 4 x AA 3.6 batteries, for 
extended battery life of 3-years (depending on sampling rate). Functionality is identical 
to regular Mini DataNet loggers. Only external casing and battery supply is different.  

Transmission Range:  

4 dBm 

Memory Capacity: 
~59,000 samples 

Power supply:  
Battery operated 

Transmission Range: 

4 dBm 

Memory Capacity: ~59,000 
samples 

Power supply:  
Battery operated 

Transmission Range:  

4 dBm 

Memory Capacity: 
~59,000 samples 

Power supply:  
Battery operated 

2.4.2. The Receiver/Repeater  

Note: The DNR900 can work in one of two modes, Receiver or Repeater. The 
DNR800 only works as a Repeater. 

The Receiver DNR900, acts as a bridge between the DataNet network and the PC. 
It is connected to the PC via USB cable and is used to create the network to which 
you add your data loggers. The Receiver is externally powered but also includes a 
rechargeable battery for back up (in case the external power fails).  

More than one Receiver may be detected by the software, enabling the running of 
multiple DataNet networks from one PC. 

Note: Each Receiver can detect up to 8 data loggers and 16 Repeaters. To detect 

more data loggers, Repeaters are required. 

The Repeater is considered the backbone of the network, as it enhances the 
network range by receiving and transmitting between end unit and Repeater until it 
reaches the PC. There are two Repeater models, the DNR900 with LCD and the 
DNR800 Mini Repeater, without LCD. Both are externally powered via the AC 
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adapter but the DNR900 also includes a rechargeable battery back-up (in case the 
external power fails).  

The Repeaters are the end units’ parent units, meaning each Repeater has specific 
end units under their responsibility (their children). They route the transmissions to 
and from the end units to the Receiver (or other Repeaters in the network).  

Each Repeater holds the data sent to the end units while the end units are in sleep 
mode. At a specific interval the end unit wakes up and receives the data from its 
parent (Repeater). 

Note: Each Repeater can detect up to 24 data loggers and 16 Repeaters including 
the parent unit. If the number of loggers exceeds this capability, additional Repeaters 
are required. 

Receiver/Repeater with LCD 

 

Part Number: DNR900 

Repeater Transmission Range: 17 dBm 

End Units per Receiver: ~65,000 
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Mini Repeater (without LCD) 

 

Part Number: DNR800 

Repeater Transmission Range: 20 dBm 

End Units per Receiver: ~65,000 

2.4.3. Hardware Accessories 

The DataNet system includes the following accessories: 

 Mini-USB cable for connecting PC to DataNet Receiver 

 Power adapter to power DataNet Receiver, Repeater and data loggers 

2.4.4. DataSuite Software  

The user interface for the DataNet system, the DataSuite software CD is provided 
together with the DataNet hardware and includes the following features: 

 Multiple Network management 

 Data display, management, storage and data diagnostics 

 Alarm settings: Email and SMS notifications, visual and audible alarms 

 Reports module 

 Wireless sensor definition  

 Wireless sensor calibration  

 Wireless firmware update (boot over the air) 

 Data download via USB  

 Automatic software update (via fourtec server) 

 

The DataSuite for DataNet module is run together with additional modules such as 
DaqLink and MicroLogPRO II to allow multiple data view from multiple logger models 
within one graph view. 

The software interface is described in detail in ‎Chapter 14: Using the DataSuite 
Software. 
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Chapter 3:  
DataNet Implementation Guide  

fourtec strongly recommends first time users of the DataNet system read this chapter 
before drilling down into the many features of the system described later in the user 
guide. The Implementation Guide will give you a clear understanding of the basic 
aspects of setting up the system, and getting your network up and running.  

Once you are familiar with the technical aspects of setting up the network as outlined 
in this chapter, please consult section ‎3.8 for fourtec’s recommended approach to 
initial deployment of the DataNet system. 

Example 

Below is a diagram depicting a supermarket deployment of a DataNet system, 
illustrating how the devices may be positioned to provide full coverage within the 
facility. 

 

Figure 2: Example of DataNet network application 

3.1. DataNet Network Architecture 

The DataNet network architecture consists of layers of loggers and Repeaters, 
forming a mesh network monitored by the Receiver unit connected to the workstation 
PC. 

The basic architecture is as follows: 

 Maximum nodes per network: 65,000 

 DNR900 Receiver recognizes up to 8 loggers and 16 Repeaters 

 DNR900 Repeater and DNR800 Mini Repeater recognizes up to 24 loggers and 
16 Repeaters (including parent unit) 

 DNL910 and DNL920 (including the PA models) in Short Range Repeater mode 
(refer to section ‎3.8.5) recognizes up to 24 loggers and 16 Repeaters 

The diagrams below show the architecture of a typical DataNet mesh network. 
Repeaters and loggers, which are being used as Short Range Repeaters in Figure 4 
(see section), can be added to the network in order to extend the range and improve 
its robustness. Each such device has end units communicating with it, but this route 
may change as the RF environment changes. This is the ZigBee self correcting 
mechanism at play.     
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Figure 3: Standard DataNet mesh network architecture 

 

 

Figure 4: DataNet network with Short Range Repeaters 

3.2. Pre-setup Requirements 

Prior to commencing with the DataNet implementation you must have the following 
requirements in place: 

PC 

 24/7 availability 

 Reliable AC power 

 Sufficient hard disk space to store loggers’ data 

 One free USB port 

 

DataNet devices 

 One DNR900 DataNet Receiver 

 At least one DataNet logger DNL910, DNL920, DNL910-PA, DNL920-PA, or Mini 
DataNet logger DNL804, DNL808 or DNL810 (or BXT models) 

 At least one DNR900 DataNet Repeater or DNR800 Mini Repeater, depending on 
your RF environment  
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Mini-USB cable 

The mini-USB cable connects the DNR900 Receiver to the PC (and is supplied with 
the PC Suite software kit). 

3.3. Launching the Software 

1. Install the DataSuite software on the PC workstation. Refer to section ‎14.1: 
Installing DataSuite Software on page 129 for more details. 

2. Once the software and associated components have been installed, launch 

DataSuite from your DataSuite desktop shortcut .  

3. Software activation window will open. Select the DataNet module button. To start 
the 30-day Trial version, select the Start trial option and click Next. To activate 
the software refer to chapter ‎14.3. 

4. The main DataSuite window is launched. The default view is called Map View. 

 

Figure 5: Main DataSuite window 

5. Check for DataSuite updates. Go to Help > Check for Updates from the 
DataSuite main menu to check for newer versions of the DataNet module 
software and firmware released since you purchased your system. For more 
details on the Update feature go to ‎Chapter 15: Updating DataSuite Software and 
Firmware. 

3.4. Connecting the Receiver 

1. Only once the DataSuite software has been installed and activated (either by 
starting the Trial or activating the module with a serial number), connect the 
DataNet Receiver/Repeater unit (DNR900) to the fourtec-supplied power adapter.  

Note: Only use adapters provided by fourtec. Use of the wrong adapter could 

damage your DataNet units.  

 

2. Turn on the unit by pressing the Scroll button  on the front keypad. The unit 
will beep when turned on. 

3. Verify that the unit is in Receiver mode by seeing the following screen on the 
LCD:  
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4. The ID will be unique to your Receiver network. If the unit is in Repeater mode, 
switch it to Receiver mode. Go to section ‎4.15 for more details. 

5. Connect the mini-USB cable to the computer and to the Receiver’s mini-USB 

port. The DataNet Receiver icon  will immediately appear in the top left 
corner of the Map View. 

 

Figure 6: Adding Receiver icon to Map View 

6. A green icon indicates that the Receiver is online.  

Note: If the Receiver is not recognized by the software try connecting the mini-USB 
cable to another USB port on the PC. Or select Devices > Detect Device in the main 
menu. 

7. Should you disconnect the Receiver’s USB cable or power adapter (and the 

battery eventually dies), the Receiver icon will be grayed out:   

8. Right-click the Receiver icon and select Form New Network from the context 
menu. The Receiver will then form a new network based on your RF environment 
rather than use the network formed in the factory. This will ensure optimal 
network performance. Refer to section ‎3.8: Optimizing the Network for more 
details. 

9. Check the DataNet network ID that was formed by the Receiver by placing the 
mouse cursor over the Receiver icon. The network ID as well as network name, 
Receiver firmware version and unit serial number is displayed. 

 

Figure 7: Receiver tooltip  

Note: You can move the Receiver icon elsewhere on the screen by going to Tools > 

Lock Map View and unselecting this option. 

Receiver 

ID: 123.456.789 



 

25 

3.5. Adding the Data Logger to the Network 

Once you have connected your Receiver and established a network you are ready to 
add data loggers and build your system. 

3.5.1. Charging DataNet Loggers 

This section refers to charging the DNL910 or DNL920 loggers. The Mini DataNet 
units are battery operated only. 

Note: Only use adapters provided by fourtec. Use of the wrong adapter could 
damage your DataNet units.  

 

Note: DataNet units do not charge when switched off. 

 

If the loggers will run from the battery supply make sure to first charge each of the 
loggers for 16 hours before use in order maximize the battery life. A fully charged 
battery can last several months, depending on your logger configuration. Refer to 
section ‎4.9.7 or more details on battery life. 

If the loggers will run from the AC power supply, when first connected to the AC 
adapter the logger will always initiate the 16 hour charge cycle.  

However, if you reconnect the AC charger within one hour of disconnection from the 
unit, the logger will not start a new 16 hour charging cycle as long as battery level is 
at least 90%. 

 

Note: For loggers measuring data with the internal temperature sensor, it is critical to 
note that during the charge cycle the logger will heat up thereby causing the internal 
temperature sensor reading to rise up to 10 ˚C above ambient temperature. Once the 
charging process is complete, the logger will cool down and the internal temperature 
sensor readings will return to normal.  

For loggers remaining connected to AC power, to prevent the logger from heating up 
again following the initial charge cycle, the logger will receive a one minute trickle 
charge each day rather than stay continually charged. This is sufficient to ensure the 

logger doesn’t self-discharge and will maintain the logger’s full charge status. 

Refer to section ‎4.9.3 for more details on the DataNet loggers’ power supply. 

3.5.2. Connecting DNL910 and DNL920 Loggers to the 
Network 

* Includes the PA models  

1. Turn on the logger by pressing the Scroll button . The unit will beep when 
turned on. As soon as the unit is turned on, the LCD screen will display the 
following message: 

 

fourtec DataNet 

Logger 
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2. The logger will then start scanning for networks. The LCD will indicate how many 
networks were found in range, and will announce when the scan is complete. 
Locked networks will not be listed. 

 

To join the network created by your Receiver (there may be other networks created 
by your colleagues) scroll through the found networks on the LCD (using the logger 

Scroll button) and press the Enter button  when you reach the required network. 
In the example below, the network required is the second network found. You can 
also rescan the networks by pressing Enter on the Rescan networks screen, which is 
reached by scrolling through all the found networks. 

 

 

Note: If the logger did not detect a network, the unit will turn off in order to conserve 

the battery. 

3. Once you select the network, the logger will automatically join that network and a 
new message will be displayed on the LCD: 

 

Note: If the message ‘Join failed’ appears on the LCD, then rescan for the network 
and try again. If the logger continually fails to join, then form a new network on the 
Receiver. 

4. The LCD will then indicate the following status message: 

 

If the Receiver is disconnected for any reason, the following message is displayed:  

 

5. When the logger joins the network, the Logger icon  will automatically 
appear in the Map View.  

a. The  symbol indicates the signal strength of the logger in the network.  

b. The  symbol indicates that the logger is running from internal battery 

supply. The  symbol indicates that the logger is running from external 
power supply. 

c. The  symbol indicates that the logger is a new addition to the network and 
has not yet been configured (setup). 

Scan for network Scan for network 

Found 2 networks

Scan complete  Scan for network Scan for network 

Found 2 networks

Scan complete  

Network 1:

ID: 014.061.082  

Network 2:

ID: 026.167.85  

Rescan networksNetwork 1:

ID: 014.061.082  

Network 2:

ID: 026.167.85  

Network 1:

ID: 014.061.082  

Network 2:

ID: 026.167.85  

Rescan networks

fourtec 

No Receiver 

fourtec DataNet 

Ready 

Joined network: 

ID: 026.167.85   
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6. Repeat steps 1-3 for every logger in your system. 

7. In order to find the physical location of the logger you can right-click on the 
Logger icon in Map View and select Call Unit (Beep). The logger will then beep. 

3.5.3. Connecting Mini DataNet Loggers and Mini Repeater 

to the Network 

The Mini DataNet loggers (DNL804, DNL808, DNL810 and BXT units) and Mini 
Repeater (DNR800) don’t have LCD screens therefore the process of joining these 
units to the network differs than that of the DataNet models with LCD.  

Follow the steps below to connect these devices to a specific network. 

1. Right-click the Receiver icon and select Mini DataNet Device Filter to first define 
the Mini DataNet devices that are allowed to connect to the network. Enter the 
SN of each Mini DataNet device in the text window and click Add. Click Remove 
to remove a SN of a device you don’t wish to join the network. 

 

Figure 8: Mini DataNet Device Filter dialog 

 

If a Mini DataNet device tries to join the network but it is not in the list then the 
software will send the Leave Network command to the device as it tries to 
connect to the network. 

When a device tries to connect to a network and the software is down it will 
continue to the next available network. If the software is up either the software will 
accept it or it will send the Leave Network command. 

2. Ensure the network is not locked. Go to the Network menu and uncheck the 
Lock Network menu item. 

3. Take the first Mini DataNet device and from an Off state give the button on the 
front panel a short press. The green LED will blink once every second until the 
logger joins the network. The device icon will appear in the Map View. 
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4. Repeat Steps 1 to 3 for all Mini DataNet devices you wish to join to the network. 

5. For more details on joining Mini DataNet units to the network, refer to section 
‎4.13.  

3.5.4. Loading Map View Background 

Load an image into DataSuite showing a map of your facility in order to place the 
Receiver and Logger icons in their relative positions. As you add more loggers to the 
system, this will prove very helpful.  

 Double click the Map View background to browse to the image directory and load 
the image. Remember to unlock the Map View in order to move the icons around. 

 Right-click the Map View background and two options will be available: Load 
Wallpaper and Reset Wallpaper, which resets to the default fourtec wallpaper. 

 

Figure 9: Map View background image example 

3.6. Configuring the Logger 

Once you connected your DataNet loggers to the network, you must configure them 
in order to start acquiring data. 

1. Right-click on the Logger icon you wish to configure. Select Setup from the 
context menu. 

2. The Setup window will be launched. 
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Figure 10: Logger Setup window 

 

This dialog provides non-editable information such as the serial number, battery 
level, reception level and firmware version of the current unit.  

On the Device Setup and Alarm Setup tabs, the user is able to configure the 
following parameters:  

 Unit's comment  

 Sampling rate  

 Transmission interval 

 Samples averaging  

 Temperature units °C/°F (on the logger LCD. Not applicable for Mini DataNet 
loggers) 

 Active sensors  

 Custom sensors' names  

 Alarm levels  

 Alarm duration  

 Alarm delay  

 Alarm pre delay 

3. Select the sensors you wish to connect to the logger for data acquisition. It 
doesn’t matter which order you select the sensors. You may only have Input 4 
selected, for example, and Inputs 1 to 3 left unselected. 

4. Select the sampling rate and transmission interval (rate at which the data is 
transmitted from the logger to the Receiver). 

5. Unless you have Alarm levels you wish to edit (see the Alarms Setup tab), click 
either Setup and Run (to send the setup and immediately log data), or Setup 
Only (to send the setup but only log data at your command). 

6. If you selected Setup Only in step 4, right-click the Logger icon and select Run 
from the context menu to start logging data. 

7. To stop the logger, right-click the Logger icon and select Stop from the context 
menu. 
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Note: Running the logger clears the logger memory. All previously recorded data will 
be erased when you begin a new logging session. 

3.7. Viewing Data  

Once you run the logger, you have several ways of viewing the online data that is 
being acquired. 

 Online graph/table/statistics views 

 Logger icon tooltip 

 Sensor view 

3.7.1. Online Data Views 

Double clicking the Logger icon or selecting Display Data in the Logger icon context 
menu will open the online graph. 

This graph is updated in real-time with the newly recorded data. 

You can switch between Graph, Table and Statistics views to view the data in 
different formats.  

      

Figure 11: Online data – Graph view 

 

Figure 12: Online data – Table view 
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Figure 13: Online data – Statistics view  

3.7.2. Logger Tooltip 

Close the online data window and return to Map View. Scroll over the Logger icon 
and you will see a tooltip displaying the relevant logger information, including real-
time data.  

 

Figure 14: Logger tooltip 

This tool-tip is updated with every newly recorded sample. 

3.7.3. Sensor View 

Click the Sensor View icon  in the tool bar to switch to this view. Here, you can 
monitor the data by viewing data display of each individual sensor, rather than of 
each logger. 

 

Figure 15: Sensor view 

 

 If the sensor is in alarm, the sensor window will change color from green to red 
(just as the Logger icon would) 

 Double-clicking the individual sensor window will open the data in the online 
Graph view 

 Scrolling over the sensor window with the mouse cursor will display the logger 
tool tip with relevant logger data (similar to Map View)  

Refer to section ‎14.5.2 for more details on using the Sensor View. 
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Note: By going to Tools > Switch Sensor View Mode you can reduce the size of 
the sensor window to display only the sensor type and sensor data. Recommended 

for networks containing many loggers. 

3.8. Optimizing the Network 

This section outlines a number of features and suggestions for optimizing the 
DataNet network and getting the best performance out of the end units and parent 
units.  

For example, when you first setup your network, you want to ensure that the loggers 
are placed in the optimum position in order to receive and transmit data to/from the 
DataSuite software. 

Refer to the DataNet specifications to guide you on the range of the DataNet units. 
With this knowledge, and based on the layout of your facility, you should have a good 
idea of the likely positional layout of your units. 

3.8.1. Signal Test Utility 

Rather than setup the system on a trial and error basis, DataNet has a Signal Test 
utility built in to the logger firmware, which gives you a clear idea of the strength of 
the signal of each logger to the Receiver, and the quality of the data link between 
Receiver and logger. 

 

Perform the following test on each logger in your system while deciding where to 
position the logger: 

1. Using the Scroll button, scroll through the main menu on the logger until you 
reach the following display: 

 

 

2. Press the Menu button to run the test. 

The signal level and link quality will be displayed. As you move the logger further 
away from the Receiver, you will see these two parameters drop from a maximum 
of 100%.  

When the logger is out of range of the Receiver, you will see the following screen:  

 

3. To exit the Signal test, press the Scroll button. 

3.8.2. Overcoming RF Obstacles 

A universal issue concerning any wireless system is how to overcome a hostile RF 
environment. DataNet’s ZigBee RF protocol has been designed for these hostile RF 
environments that routinely exist onsite. ZigBee can overcome competing wireless 
noise and other problems communicating the data.  
Its mesh networking capabilities allows it to re-route signal traffic around temporary 

Out of range 

 

s   

Signal level: 

Run test -> Menu 

 

s   
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or permanent physical obstacles, radio-frequency interference, Repeater error or 
other such failures.  

The robustness of the system is such that there is no single point of failure, ensuring 
data recovery from end units on the network.  

Tips on overcoming RF barriers 

 When first creating the network in the environment where the loggers will be 
deployed, form a new network on the Receiver. There may be local interference 
on the 2.4 GHz free bandwidth. The ZigBee protocol, when forming a new 
network, selects the least noisy channel (out of 16 available channels). Within this 
channel the units can change RF slots (by hopping) but cannot move to other 
channels while running. By running on a channel on a network created in another 
environment e.g. in the office, this channel may become noisy and therefore 
transmission range may be less than expected. 

 When placing units in an indoor or outdoor environment, bear in mind that walls, 
furniture, metal objects, etc. limit the RF coverage thereby reducing the range of 
the units.  

 Add Repeaters (DNR800 or DNR900) in range of end units and parent unit to 
enhance RF coverage and improve robustness of network. Have as many 
alternative transmission routes as possible in order to eliminate single points of 
failure.  

 When placing Repeater ensure it is not on the limit of its range to the end unit or 
parent unit (Repeater or Receiver), to avoid periods of unavailability due to 
changing RF conditions. 

 Add Short Range Repeaters (DNL910, DNL920 or PA models) to overcome RF 
interference nearby to the loggers. 

 The higher the Receiver is positioned the better reception quality it will obtain. 

3.8.3. Showing the Network Path 

For All Networks  

By going to DataNet Network > Show All Network Paths in the DataSuite main 
menu, the software will show the actual path that the system uses to communicate 
between Receiver and logger, for all online networks and associated units. 

 

For Specific Networks  

Right-click on the Receiver icon and select Show Network Paths to see paths for a 
specific network. 

 

For Specific Units  

You can also select Show Network Path from the logger context menu to display the 
individual path from the unit to the parent unit (e.g. Receiver or Repeater). 

 

 

Figure 16: Showing network paths – Example 1 
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Figure 17: Showing network paths – Example 2 

 

The screenshot above shows a system of three loggers (red squares) and two 
Repeaters (blue circles) transmitting to the Receiver. 

The arrows show the path between the units. Note that they are bi-directional, 
meaning that the system is a two-way system with units both transmitting and 
receiving data. 

 A green path indicates a strong signal 

 A yellow path indicate a medium strength signal 

 A red path indicates a weak signal 

3.8.4. Adding Repeaters to the Network 

Loggers which aren’t in range of the Receiver can transmit to the Receiver via a 
Repeater/Short Range Repeater, which is in range. As DataNet is built using mesh 
networking technology Repeaters (DNR800 or DNR900) can be added to the system 
to enhance the network range.  

The DNR900 Receiver/Repeater is the same device, just configured differently from 
the main menu when turned on. Refer to section ‎4.14.3 to learn how to switch the 
DNR900 unit type to Repeater. 

The DNR800 only functions as a Repeater. 

3.8.5. Short Range Repeater  

You may also enable a logger (DNL910, DNL920 or the PA models) to operate as a 
Repeater in addition to its logging capabilities. In this mode the logger is referred to 
as a Short Range Repeater (SRR).  

When in SRR mode the logger maintains the transmission range in accordance with 
its specifications. Therefore, the DNL910 and DNL920 will transmit at 4 dBm and the 
DNL910-PA and DNL920-PA, with its built-in power amplification, will transmit at a 
greater range of 17 dBm.  

To switch a logger to SRR mode, simply right-click the logger icon in the DataSuite 
software Map View and select Enable Short Range Repeater Mode. 
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Note: In SRR mode the logger must be connected to AC power at all times as the 
power consumption is much greater. 

3.9. Recommended Approach to Deploying 

DataNet Units 

Now that you have a general understanding of how the DataNet system functions, 
you may wish to use fourtec’s recommended approach for initial deployment of the 
system. This approach will ensure a smooth and efficient deployment of your 
DataNet units and you may then tweak this approach based on experience you gain 
while using the system.  

Note: When deploying the system bear in mind that several factors could cause 
interference with the system, such as electromagnetic pulses, metal shielding in the 
vicinity of the transmissions, other devices using the same 2.4 GHz band, etc. Be 
familiar with your environment before deploying the system. Also refer to section ‎3.8. 

 

1. After you have charged the DataNet units and are ready to deploy them in your 
facility, collect all units - data logger end units, Receiver and Repeaters (if 
relevant) – and bring them to your PC workstation.  

2. Connect the Receiver to the PC and form a network. Turn on the units and one 
by one bring them online so you can view their icons in the DataSuite software’s 
Map View. 

3. Configure each of the units via the Setup feature. At this stage it is not necessary 
to configure the type of sensors you will be using, or sample rate, alarm levels, 
etc. The point of this step is to configure each of the units with a logger or 
Repeater name that indicates where in your facility they will be deployed. For 
example, Room 15 Freezer or Floor 2 Bio Lab. This will make it much easier for 
you to recognize the units in the Map View once you have deployed them. Once 
in place, you can reconfigure the units however you like.  

4. It is also recommended, if possible, to change the Map View default background 
to a diagram or map of your facility. You can then move the logger or Repeater 
icons accordingly so you can have a visual representation of their location in the 
facility. 

5. Take each logger and begin to distribute in your facility in the precise location you 
would like them to be based. Once in position you can then run the Signal Test 
on each logger to verify that you have a good signal to the Receiver. If you are 
out of range and there is no alternative location for the logger, you will most likely 
have to add at least one Repeater to the network, or replace the existing logger 
with a PA logger for longer transmission range.  

6. Once each of the loggers is in position return to the PC and in Map View, verify 
that each of the loggers is online. You can also use the Show Network Paths 
feature to see the path of the logger to the Receiver, and the strength of the 
transmission.  

7. If you determine that you need to add Repeater/s to the network in order to bring 
end units online or enhance the transmission where the signal is weak, then 
deploy the Repeater/s with the following points in mind: 

a. There must be an electrical socket accessible at the location of the Repeater 
as they must be powered externally in order to run for more than a few hours. 

b. Place the Repeater/s as high from the ground as possible in order to enhance 
the wireless signal from its antenna.  
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c. Expose the Repeater/s to as many end units as possible. For example, if 
there is a room with several offline end units requiring a Repeater, position 
the Repeater next to the room so that it is in range of as many of these end 
units as possible, so you don’t have to add more Repeaters.  

8. After you have deployed the Repeater/s return to the software and using the 
Show Network Paths feature verify that all end units are now successfully 
transmitting to the Receiver, either on their own or via a parent Repeater. You 
can continue to tweak the position of the units until you are satisfied with the 
quality of the transmission. 

9. Now that the units are in place the last step of initial deployment is to reconfigure 
each unit to start data acquisition. Configure the sensor setup, sample rate, 
transmission rate, alarm levels, Email/SMS notifications, etc. as you see fit.  

3.9.1. DataNet Site Survey 

fourtec has constructed a Site Survey document to aid all DataNet integrators prior, 
during and after every DataNet system installation. 

Please contact the fourtec Help Desk for this document, which includes detailed 
instructions on surveying various aspects of the DataNet site prior to deployment to 
ensuring there are no RF problems, for example.  

Check lists often prove indispensible when certifying the installation – two such lists 
are provided below. 

Installation Overview Check List 

1. Install DataSuite software. Launch in Trial version. 

2. Check for software/firmware updates 

3. Register software Serial Number (online/offline registration) 

4. Connect Receiver to PC USB port and detect Receiver 

5. Form New Network 

6. Enter SN to Mini DataNet Device Filter 

7. Connect DataNet units to network and update firmware (if required) 

8. Connect sensors and perform logger Setup 

9. Deploy loggers, with optimal RF reception and power supply 

10. Review network paths in software 

11. Setup alarm levels and notifications 

12. Connect modem 

13. Setup Report 

14. Send fourtec network screenshot 

 

Post-Installation Check List 

1. Formed a new network at the start of installation 

2. Network is locked 

3. DataSuite software and device firmware are up to date 

4. PC is connected to the Internet 

5. All units are online with green network paths 

6. Configured alarm levels for relevant inputs 
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7. Tested sending of SMS/email notifications 

8. GSM Modem is connected with the green online icon 

9. At least 2 x DNR900 (one Receiver, one Repeater) to allow Sub Receiver 

10. Data files path on PC/network is correct 

11. Logger battery readings/AC power supply is stable 

12. All online readings are as expected 

13. Configured reports to be sent automatically 

14. Software SN has been activated 

15. Run Application on Windows Startup in Options is selected 

16. Sent DataNet screenshot to fourtec support for approval 
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Chapter 4:  
DataNet Hardware Overview 

This chapter details the hardware features of the DataNet system components: the 
data loggers and the Receiver/Repeater. 

4.1. Data Logger Front Panel Layout 

4.1.1. DNL910 and DNL920  

Apart from the color scheme, the DNL910, DNL920 and PA data logger models have 
the same front panel design. 

 

Figure 18:  DNL910 data logger front panel 

LCD screen 

Displays logger status, logger data, Min/Max values and network 
information. 

 

Menu/Enter button 

Use to enter logger menu options and to execute logger commands. 

Scroll button 

Use to scroll though menu items and to power on unit. 

4.1.2. DNL804, DNL808 and DNL810 

The Mini DataNet logger models have the same front panel design. 

Scroll button

Menu/Enter button

LCD screen

Scroll button

Menu/Enter button

LCD screen
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Figure 19:  DNL808 data logger front panel 

Multi-function button: Use to execute logger commands. 

Dual–color LED indicator: Indicates status of logger such as joining 
network, leaving network, etc. 

 

4.1.3. DNL804, DNL808 and DNL810-BXT – External 

Battery Pack 

The Mini DataNet BXT models have the same front panel design. 

 

Figure 20:  DNL804-BXT data logger front panel 

Multi-function button: Use to execute logger commands. 

Dual–color LED indicator: Indicates status of logger such as joining 
network, leaving network, etc. 

Multi-function 

button

Dual-color 

LED indicator

Multi-function 

button

Multi-function 

button

Dual-color 

LED indicator

Multi-function 

button

Dual-color 

LED indicator

Multi-function 

button

Multi-function 

button

Dual-color 

LED indicator
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4.2. Data Logger External Connections 

4.2.1. DNL910 and DNL920 

External connections of the DNL910, DNL920 and PA models are exactly the same. 

  

Figure 21:  DNL920 data logger external connections 

 

Mini USB Port 

To enable data download direct to PC via USB port. 

12 V Power Socket 

To connect logger to external power supply (negative center). 

Sensor Inputs 

Pluggable screw terminal blocks marked In-1 to In-4 (from left to 
right), to connect wide range of sensor types for data acquisition. All 
four inputs can be used simultaneously. Sensors can be connected 
in any order. 

To connect a sensor to the DataNet data logger, unplug the screw 
terminal, connect the sensor’s wires to the terminals, and then plug 
the terminal back to the corresponding socket on the input block. 

Excitation socket 

Output power socket used to power external sensors, power derived 
directly from the external power supply adaptor.   

Mini USB port

12 V power socket 

Negative Center

Four sensor 

inputs

Excitation

Mini USB port

12 V power socket 

Negative Center

Four sensor 

inputs

Excitation
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4.2.2. DNL804 and DNL804-BXT 

 

Figure 22:  DNL804 and DNL804-BXT data logger external 
connections 

 

External antenna: For extended transmission distance of the logger. 

External 4 to 20 mA input: Standard input for connecting to sensor 
with 4 to 20 mA output. 

4.2.3. DNL808 and DNL808-BXT 

 

Figure 23:  DNL808 and DNL808-BXT data logger external connections 

 

External antenna: For extended transmission distance of the logger. 

External NTC 10KΩ input: Standard input for connecting to NTC probe. 

External NTC 10KΩ probe: fourtec-supplied NTC probe (part of DNL808 
and BXT kit). 

External 

antenna

External Current 

4 to 20 mA input

External 

antenna

External Current 

4 to 20 mA input

External 

antenna

External NTC 10 

KΩ probe

External NTC 10 

KΩ input

External 

antenna

External NTC 10 

KΩ probe

External NTC 10 

KΩ input
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4.2.4. DNL810  

The DNL810 doesn’t have any external connections. It has two internal sensors only, 
temperature and humidity. 

4.3. DNR800 Mini Repeater Front Panel Layout 

 

Figure 24:  DNR800 Mini Repeater front panel 

Multi-function button: Use to execute logger commands. 

Dual–color LED indicator: Indicates status of Repeater such as joining 
network, leaving network, etc. 

 

4.4. DNR900 Receiver/Repeater Front Panel 

Layout 

 

Figure 25:  Receiver/Repeater front panel 

LCD screen 

Displays Receiver/Repeater status and network information. 

Menu/Enter button 

Use to enter logger menu options and to execute logger commands. 

Scroll button 

Use to scroll though menu items and to power on unit. 

Multi-function 

button

Dual-color 

LED indicator

Multi-function 

button

Dual-color 

LED indicator

Scroll button

Menu/Enter button

LCD screen
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4.5. DNR800 Mini Repeater External Connections 

 

Figure 26:  Mini Repeater external connections 

12 V Power Socket 

To connect unit to external power supply. Plug in an AC/DC 9-12 V 
adaptor to power the unit. There is no battery supply so when 
disconnected from the adapter the unit will shutdown. The adaptor 
should meet the required specifications. Refer to ‎Appendix A: DataNet 
Specifications. 

4.6. DNR900 Receiver/Repeater External 

Connections 

 

Figure 27:  Receiver/Repeater external connections 

Mini USB Port 

To connect Receiver to PC and be detected by DataSuite software. 

Connect the mini USB Type B plug (rectangle plug) of the supplied USB 
communication cable to the Receiver and the USB Type A plug (flat 
plug) to the computer. 

Refer to section ‎4.10.  

12 V Power Socket 

To connect unit to external power supply. Plug in an AC/DC 9-12 V 

12 V power socket

Negative Center

External Alarm

Mini USB port
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adaptor to power the unit. To use as a Receiver or Repeater and 
maintain network integrity, the unit should be powered at all times. 
Connecting external power to the unit automatically charges the internal 
back-up battery. The adaptor should meet the required specifications. 
Refer to ‎Appendix A: DataNet Specifications. 

External Alarm 

Connect external alarm e.g. siren, audible alarm, to this input. Whenever 
a logger on the network is in alarm status, the external alarm will be 
activated. Refer to section ‎4.7.6 for more details. 

4.7. Data Logger Sensor Overview 

This section provides an overview of the hardware specifications of the DataNet data 
loggers.  

4.7.1. Internal Sensor Types 

The DNL810, DNL910, DNL920, DNL910-PA and DNL920-PA loggers include 
internal sensors, depending on the logger model. 

Sensor Measurement 
Range 

Accuracy Logger Model 

Digital Humidity  5% to 95% ±3% (in DataSuite 
software) 

±4% (on logger LCD) 

DNL920 

DNL920-PA 

DNL810 

DNL810-BXT  

Digital Temperature  -20 ºC to 50 ºC ±0.5 ºC DNL920 

DNL920-PA 

±0.4 ºC DNL810 

Temperature PT100  -20 ºC to 50 ºC ±0.3 ºC  DNL910 

DNL910-PA 

4.7.2. External Sensor Types 

DNL910, DNL920 and PA Models 

Each of the four input channels of these data logger models are multi-purpose and 
can be individually configured to any of the following types and ranges.  

Sensor Measurement 
Range 

Accuracy Available Inputs 

Current  4 to 20 mA ± 0.5 % In-1 to In-4 

Contact Open (0) /  
Close (1) 

N/A In-1 to In-4 

Frequency 20 Hz to 4 KHz N/A In-4 only 

Pulse Counter 1 to 65,536 pulses 

0 to 4 KHz 

N/A In-4 only 

Temperature PT100 -200 to 400 ºC -200 to -60 ºC ±0.5 % In-1 to In-4 
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Sensor Measurement 
Range 

Accuracy Available Inputs 

(2-wire) 60 to 400 ºC ±0.5 % 

-60 to 60 ºC ±0.3 ˚C 

Temperature TC-J -200 ºC to 1,000 ºC -200 to -60 ºC ±0.5 % 

60 to 1,000 ºC ±0.5 % 

-60 to 60 ºC ±0.5 ˚C 

In-1 to In-4 

Temperature TC-K -200 ºC to 1,000 ºC -200 to -60 ºC ±0.5 % 

60 to 1,000 ºC ±0.5 % 

-60 to 60 ºC ±0.5 ˚C 

In-1 to In-4 

Temperature TC-T -200 ºC to 400 ºC -200 to -60 ºC ±0.5 % 

60 to 400 ºC ±0.5 % 

-60 to 60 ºC ±0.5 ˚C 

In-1 to In-4 

Voltage 0 to 1 V ± 0.5 % In-1 to In-4 

Voltage 0 to 50 mV ± 0.5 % In-1 to In-4 

 

DNL804 and DNL804-BXT 

Sensor Measurement 
Range 

Accuracy 

Current  4 to 20 mA 0.5 % 

 

DNL808 and DNL808-BXT 

Sensor Measurement 
Range 

Accuracy 

Temperature 
NTC 10 KΩ 

-50 to 150 ºC -50 to 60 ˚C: ±0.3 ˚C 

60 to 150 ˚C: ±0.5 % 

4.7.3. Sensor Connection 

Connect the sensor/s to the terminal block/s at the top of data logger: 

 

Figure 28: DataNet logger sensor inputs 

 

Sensors do not have to be added successively. You may only configure In-4, or 
configure In-1 and In-3, for example, when setting up the logger via the software. 
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4.7.4. External PT-100 and NTC Sensor Connection 

The PT-100 (for the DNL910, DNL920 and PA models) and NTC (for DNL808) 
sensors, as supplied by fourtec comes pre-wired to the data logger’s terminal block.  

The PT-100 positive polarity (red) and ground (white) wires are connected to the + 
input of the terminal block. The negative polarity (black) wire is connected to the – 
input on the terminal block.  

4.7.5. Programming Limitations for DNL910 and DNL920 

The standard sampling rate for all sensors on all inputs is from a maximum of one 
sample every second to a minimum of one sample every two hours. However, there 
are certain limitations using a specific combination of sensors, which must be taken 
into account when programming the DataNet data loggers.  

Note: The software integrates all programming limitations automatically when 
configuring the loggers.  

Please refer to the table below for DataNet programming limitations, where:  

PT100, Thermocouple J, K or T  = A 

Internal Digital Temperature (on 
DNL920) 

= B 

 

Sensor 
Combination 

Maximum Sampling Rate Example Setup 

3 x A 

4 x A 

A + B 

One sample every three seconds In-1: PT-100 

In-2: TC-J 

In-3: TC-J 

(2 x A) + B 

(3 x A) + B 

One sample every four seconds Internal: Temp 

In-1: TC-T 

In-2: PT-100 

(4 x A) + B One sample every five seconds Internal: Temp 

In-1: TC-T 

In-2: TC-J 

In-3: PT-100 

In-4: PT-100 

Table 1: Data Logger programming limitations 

4.7.6. External Alarm Output 

The DataNet system supports connection of an external alarm e.g. siren, audible 
alarm, to the Receiver external alarm input or to In-1 of the DNL910, DNL920 and PA 
model data loggers.  

When connected to the Receiver, the external alarm will be activated whenever a 
logger on the network is in alarm status. When connected to the data logger, the 
external alarm will be activated only when that specific logger is in alarm status. 

Once there is no alarm status, the external alarm will be deactivated. 
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Data Logger External Alarm 

In-1 of the DNL910, DNL920 and PA models serves either as a standard sensor 
input or as an external alarm output. Configure In-1 as Alarm Normally Open or 
Alarm Normally Closed in the logger Setup window in the DataSuite software. 

Normally Open will result in the alarm being activated during alarm status (the circuit 
will be closed).  

Normally Closed will result in the alarm being activated when logger is not in alarm 

and therefore deactivated when there is an alarm (the circuit will be opened). 

Connect In-1 to your external alarm device.  

Use the Alarm Setup tab in the Setup dialog to define the logger alarm settings. If 
these settings are breached then the alarm will be activated. 

 

Receiver External Alarm 

By connecting the external alarm to the Ext Alarm input on the Receiver, any alarm 
on the entire network will activate the external alarm. 

Use the Alarm Setup tab in the Setup dialog to define the logger alarm settings. 
Whenever the Receiver receives an alarm status from any logger on the network, the 
external alarm will be activated. No additional configuration in the software is 
required. 

 

External Alarm Schematic 

See the schematic below explaining how to hook up an external alarm to the DataNet 
unit. 

 

Figure 29: External alarm schematic 

 

 + from DNR900 goes to – of the Relay inputs 

 + of Relay input goes to battery that powers the Relay 

 Load inputs of the Relay go to the Alarm device e.g. siren, lights, etc. 

 - of the battery goes to – of DNR900. 

Note: Maximum load of the Relay is 50 mA, 3 V. 

- +

Relay

- +

- +
Alarm device 

(e.g. siren)

+

-
3-4 V battery 

to power relay

- +

Relay

- +

- +
Alarm device 

(e.g. siren)

+

-
3-4 V battery 

to power relay
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Refer to ‎Appendix A: DataNet Specifications for the full external alarm output 
specification. 

4.7.7. Polarity 

Current, voltage, thermocouples and user defined sensors have distinct polarity. Be 
careful to connect them in the right polarity. 

4.7.8. Frequency/Pulse Counter 

Connect the signal wires to In-4 terminal blocks, and select Frequency or Pulse 
counter for Input 4 from the logger Setup window in the DataSuite software. Inputs 1 
to 3 are still available for other sensors. 

 

The Frequency/Pulse counter is optically isolated from the internal circuitry and can 
simultaneously measure a signal source, together with another input. 

4.7.9. User Defined Sensors 

DataSuite provides a simple and straightforward tool for defining a limited number of 
custom sensors. Almost any sensor or transducer with 0 – 1 V or 4 – 20 mA output is 
accepted by the DataNet logger and its electrical units are automatically scaled to 
meaningful user-defined engineering units. 

The sensor definitions are stored in the logger’s memory and are added to the 
sensors list. The sensor’s readings are displayed in the user defined units only in the 
DataSuite software. Future versions will also support displaying the user defined 
engineering units on the logger LCD. 

Refer to section ‎14.8.1 for more details.  

4.7.10. Sensor Alarms 

Via the software, users can define minimum and maximum alarm levels for each 
input individually. Users can define pre-low and pre-high alarm levels, for an 
additional level of safety in case the logger is approaching an actual breach of alarm. 

The DataNet logger display indicates when the sensor reading is in alarm of any 
type. The symbols AL-H, AL-L, AL-P-H or AL-P-L are visible next to the 
corresponding input readings.  

Refer to section ‎14.18 for more details. 

4.7.11. Sensor Calibration 

The DataNet data logger is shipped fully calibrated. However, further calibration can 
be applied via the DataSuite software. The calibration parameters are sent to the 
data loggers wirelessly and stored in the logger’s memory.  
Users may calibrate individual input as well as all inputs at once. Calibration settings 
may be saved and then loaded into the logger at a later date if the calibration settings 
have changed. 

Refer to section ‎14.19.4 for more details. 
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4.8. Unit Serial Number and Comment 

Every DataNet data logger and Receiver/Repeater unit is embedded with a unique 
serial number.  

The data logger only can be loaded with a descriptive comment to identify its task 
and location. You may add or edit the comment of any logger on the network via the 
DataSuite software.  

Every time data is transferred to the computer it is labeled both with the logger’s 
serial number and comment and is displayed in the graph or data table view. 

The unit serial number is also marked on a sticker on the back of the product.  

4.9. Power Supply 

4.9.1. DNR900 in Receiver Mode 

The Receiver unit is powered via the USB port of the PC, when connected via the 
mini USB cable. In addition, the unit can run for a limited time (up to three hours) 
from an internal NiMh rechargeable battery. To charge the internal battery, connect 
the unit to the AC power supply supplied with the DNR900. The internal battery pack 
is generally used as a back up power supply in the event the external power supply 
fails.  

Note: When in Receiver mode, the unit must be connected to external power at all 
times. While running on internal power, the unit will run for only several hours before 
shutting down and therefore shutting down the DataNet network which the Receiver 
is managing. 

4.9.2. DNR800 and DNR900 in Repeater Mode 

The DNR800 must be connected to external AC power at all times. This device does 
not have an internal battery so when the external power supply is disconnected the 
unit will shutdown.  

When in Repeater mode, the DNR900 must be connected to external AC power at all 
times using the supplied AC charger. Otherwise, when the internal backup batteries 
drains and shuts down the unit, all the end units dependent on the Repeater to 
transmit to the Receiver, will not be detected by the software. The user won’t be able 
to monitor data readings from these units until the Repeater comes back online. 

When connected to external power supply, the Repeater battery will not be charged 
when the unit is turned off. This will allow the system to protect the battery from 
overheating. 

4.9.3. DNL910 and DNL920 Data Loggers 

The DNL910, DNL920 and PA data loggers run from an internal NiMh rechargeable 
battery as well as from external AC power supply.  

Note: The PA (power amplifier) models must be connected to AC power at all times 
due to the high power consumption of these units.  

Depending on the logger configuration, from a fully charged battery, the non-PA data 
logger can run for up to several months. Refer to section ‎4.9.7 for more details on 
battery life. 
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Note: Charge the data logger units for 16 hours before using them for the first time. 

When connected to external power supply, the data logger battery will not be 
charged when the unit is turned off. This will allow the system to protect the battery 
from overheating. 

 

First Time Charging 

From a fully drained battery, you must charge the battery for 16 hours to bring it to a 
full charge. Once the charge cycle is complete, the logger will run from the external 
power supply, without draining (or charging) the internal battery. In order to maintain 
a fully charged battery and ensure the battery doesn’t self-discharge, the battery 
charger will daily charge the unit for a minute to maintain the battery capacity. 

Note: Before storing the DataNet units make sure you have unplugged all the 

sensors and turned the units off via the keypad.  

Standard Charging 

When a logger is reconnected to the AC charger it will begin the 16-hour charge 
cycle, no matter what the status of the battery. Once the charging cycle is complete 
the logger will run from external power supply. 

The one exception to this scenario is if the charger is reconnected within an hour of 
disconnection and the battery level is at least 90%. In this situation the charging 
process will not restart. 

 

Effect of Charging Battery on Temperature Sensor 

For loggers measuring data with the internal temperature sensor, it is critical to note 
that during the charge cycle the logger will heat up thereby causing the internal 
temperature sensor reading to rise by up to 10 ˚C above ambient temperature. Once 
the charging process is complete, the logger will cool down and the internal 
temperature sensor readings will return to normal.  

For loggers remaining connected to AC power, to prevent the logger from heating up 
again following the initial charge cycle, the logger will receive a one minute trickle 
charge each day rather than stay continually charged. This is sufficient to ensure the 
logger doesn’t self-discharge and will maintain the logger’s full charge status. 

4.9.4. Mini DataNet DNL8XX-BXT Data Loggers 

The Mini DataNet loggers are powered by non-rechargeable internal 2/3 AA lithium 
batteries. There is no external power supply for these loggers. 

Depending on the logger configuration, the battery can last up to 10 months before 
they need to be replaced. 

Replacing the Mini DataNet Battery 

To replace the batteries on the Mini DataNet loggers, follow these instructions: 

1. Stop the unit from the DataSuite software. 

2. Turn off the unit using the logger button.  

3. Remove the two screws located on the top panel of the logger (where the 
antenna is connected) and with care pull out the internal compartment containing 
the logger circuit board and battery.  

4. Remove and replace the battery, ensuring the correct polarity of the battery. 

5. Push the internal compartment back into place.  
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6. Secure the panel with the two screws.  

Note: With the DNL808 also disconnect the external sensor to avoid damaging it. 

4.9.5. Mini DataNet DNL8XX Data Loggers 

The Mini DataNet Extended Battery Pack includes a modified plastic casing for the 
three existing Mini DataNet models. This new casing features a battery pack 
supporting up to 4 x 2/3 AA 3.6 V batteries, for extending the logger’s battery life. 
Functionality of this design is no different than the standard loggers. 

With all 4 batteries connected, battery life of up to 3 years, depending on sampling 
and transmission rates is expected. 

There is no external power supply for these loggers. 

Note: 2 batteries are supplied with every order of a BXT model. 

 

Replacing the Mini DataNet BXT Battery 

To replace the batteries on the Mini DataNet loggers, follow these instructions: 

1. Stop the unit from the DataSuite software. 

2. Turn off the unit using the logger button.  

3. Remove the screw located on the battery case panel at the bottom of the logger 
and open the panel to expose the battery pack. 

  

4. Remove the battery pack taking care not to pull the wires out of place, and 
replace the batteries, ensuring the correct polarity of the battery. 

5. Push the battery pack back into place.  

6. Secure the panel with one screw.  

4.9.6. Power Adapter 

The DataNet power adapter is used to power the DNR900, DNL910, DNL920 and PA 
model units. The mains adaptor (AC/DC adaptor) converts mains power (from a wall 
outlet) to a voltage suitable to the DataNet hardware unit. 

 Output: Capacitor filtered 9 to 12 VDC, 300 mA  

 Female plug, center negative 

 

Note: Only use fourtec-supplied power adapters to avoid damaging the units with 
incorrect power supply. 
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4.9.7. Data Logger Battery Life 

Battery life depends on the logger sampling rate, transmission rate, type of sensor, 
network architecture and number of measured sensors.  

 DNL910 and DNL920 can last up to six months on a charged battery. 

 DNL8XX can last up to 10 months on a new battery.  

 DNL8XX-BXT can last up to 3 years with all four batteries connected.  

 

The table below provides some example scenarios of standard logger configurations 
and expected battery life. 

Logger 
Model 

Sensor Setup Sample 
Rate 

Transmission 
Rate 

Battery 
Life 

DNL910  Internal Temperature 

 4 x Thermocouple 

15 minutes 15 minutes Five 
months 

DNL910 1 x PT-100 15 minutes 15 minutes Six months 

DNL808 1 x NTC 10 KΩ 15 minutes 15 minutes 10 months 

DNL810  Internal Temperature 

 Internal Humidity 

15 minutes 15 minutes 10 months 

Table 2: Data logger battery life scenarios 

4.10. USB Communication Cable 

A mini USB communication cable is supplied as part of the DataSuite software kit. 
This cable has the following roles: 

 To connect the Receiver to the DataSuite PC workstation, allowing the Receiver 
to communicate with the DataSuite software and manage the DataNet network.  

 To power the Receiver when connected to the PC (the internal battery is not 
charged). 

 To enable data download directly via USB for DNL910, DNL920 and PA model 
loggers. 

 To enable firmware update directly via USB for DNL910, DNL920 and PA model 
loggers as well as DNR900. 

 To enable shutdown directly via USB of DNL910, DNL920 and PA model loggers.  

Note: The USB driver is installed as part of the software installation process. Without 
this driver the PC won’t detect the Receiver. To avoid compatibility problems do not 
connect the Receiver to the PC before installing the USB driver. 

 

Figure 30: USB communication cable 

Type A plug 

Connect to device USB port 

Type B plug  

Connect to PC USB port 
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4.11. DataNet Keypad Overview 

Note: Explanations for DNL units also apply to the PA models 

4.11.1. DNL910, DNL920 and DNR900 Keypad 

The DNL910, DNL920 and DNR900 units each have two buttons on the keypad, 
used to navigate through the LCD menu options, as well as turn on the units. 

Refer to section ‎4.12 to learn how to operate the data loggers and sections ‎4.13 and 
‎4.15 to learn how to operate the Receiver and Repeater. 

 

The Menu button  has two functionalities: 

Navigate to the main menu. When pressed from 
within a submenu, the display will take you back to the 
main menu.  

Selecting an option from one of the menus. When 
pressed on one of the main menu items, it will take you 
to the sub menu options. 

The Scroll button  has two functionalities: 

 When the unit is off, pressing this button will power 
the unit on.  

 Scrolls through the menu options. 

4.11.2. DNL8XX and DNL8XX-BXT Keypad 

The Mini DataNet units have one button on the keypad. This 
button is multi-functional and is used to perform various 
functions such as: 

 Turning on/off the unit 

 Starting signal test 

 Leaving the network 

 Locating device icon in software Map View 

 

Refer to section ‎4.13 to learn how to operate the Mini DataNet 
and Mini Repeater devices. 
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4.12. Operating the DNL910 and DNL920  

This section explains how to operate the DNL910, DNL920 and PA model loggers 
and provides an overview of the menu options on the units’ LCD screen. 

4.12.1. Turning on the Unit 

In order to view the logger menu options, the unit must be powered on by pressing 

the Scroll button  on the keypad. Ensure the logger is charged or connected to 
the AC adapter. 

Once the unit is switched on it will emit a short beep and the screen will read Search 
Parent until the Parent unit e.g. Receiver, is detected. A welcome message is the 
displayed:  

 

4.12.2. Display Shutdown 

When the data logger is running from batteries only, if the screen is inactive for thirty 
seconds it will turn off. However the logger will continue to operate in the 
background. Press the Scroll button to enable the LCD screen again. The screen will 
not turn off during firmware upgrade. 

When connected to external power supply the logger screen will always stay on. 

4.12.3. Joining a Network 

When a logger is powered on or reset, it will automatically scan for a network after 
the welcome message has appeared.  

There are four scenarios that can occur while scanning for a network: 

Scenario 1: The unit can’t find the last network that it was connected to. For 
example, the logger is a new unit which was never previously joined a network. 

Scenario 2: The unit scans and finds the last network it was connected to, and joins 
that network. 

Scenario 3: The unit can’t find any networks at all. 

Scenario 4: The unit found a network but failed to join. 

 

Read below for more details on each scenario. 

Scenario 1 

If the unit can’t find the last network that it was connected to (for example, it’s a new 
unit), the unit will display all the networks that are in range: 

 

Where # is the number of networks found 

Scan for network 
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Found # network 
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Once the scan has been completed the following screen appears: 

 

If more than one network was found, the user will need to select the network ID that 
he wants to connect to. The user uses the Scroll button to scroll through the Network 
IDs. The relevant network is selected using the Enter button.  

 

Once the network has been selected the following screen will be displayed.  

 

 

To rescan the networks, simply select the Rescan Networks option and the logger 
will start the scanning process again. 

 

If only one network was found the system will automatically connect to that network 
without the user needing to select the network manually. 

 

The logger display will return to the welcome message, which consists of the logger 
name (editable via the software) and the network status: 

 Ready - If connection to the DataSuite software is established. 

 Software is down - If established connection to the Receiver but the DataSuite 
software is down (PC is off, software is not open, etc.) 

 No Parent Signal – The parent unit, either the Receiver or Repeater, is not 
detected by the logger therefore the logger is not transmitting its data to the 
network.  

   

The logger will continue to search for the parent unit (at specific intervals) and the 
screen will continue to read Search Parent until the parent is found. 

Scenario 2 

When the unit scans for networks and finds the last network that it was connected to 
it will automatically connect to the last known network. 

 

Network 1:

ID: 014.061.082  

Network 2:

ID: 021.207.175  

Network 1:

ID: 014.061.082  

Network 2:

ID: 021.207.175  

Rescan networks

Scan for network 

Found 1 network

Scan complete  Joined to network:

ID: 021.207.175  

Scan for network 

Found 1 network

Scan complete  Joined to network:

ID: 021.207.175  

Scan for network 

Found 1 network

Scan complete  Joined to network:

ID: 021.207.175  

fourtec DataNet 

Ready

fourtec DataNet 

Software is down

fourtec DataNet

No Parent Signal

fourtec DataNet 

Ready

fourtec DataNet 

Software is down

fourtec DataNet

No Parent Signal

Joined Network: 

ID: 021.207.175   

Joined network: 
ID: 021.207.175   
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As in Scenario 1, the logger display will then return to the welcome message 
displaying the unit name and status.  

Scenario 3 

The system can’t find any networks at all. 

If no networks were found, the unit will display the following screens. 

 

Scenario 4 

The unit found a network but failed to join. 

The unit will perform up to 99 retries to join the network before scanning for networks 
again. Press any of the unit buttons to cease the attempts to join the network. 

A unit may fail to join a network if it is far from the Receiver, requiring several hops to 
reach the Receiver, or the network itself is large with many units. The attempt to join 
a network is made in under a second in real-time and on high traffic network, it may 
result in failure to join.  

Moving the unit closer to the Receiver can help the logger to join successfully. If the 
logger still can’t join, form a new network or contact fourtec technical support. 

4.12.4. Main Menu Options 

There are three menu categories on the data logger: 

 View Data  

 Status 

 Min/Max Values 

Note: If the unit is not in Run mode only the Status menu options will be available.  

 

Press the Menu button to reach the main menu display. Scroll through the main 
menu options (View Data, Status and Min/Max Values) using the Scroll button. Once 
you reach the main menu option you need, press Enter to select that option and 
enter the sub menus. 

 

View Data Menu  

 

 

Note: View Data is the default page when the unit is running.  

If there is more than one sensor running, the screen will auto scroll between the 
sensors showing the sensor name and senor value. These are real-time displays. 

The display will switch back to the View Data screen after five minutes if none of 
logger buttons have been pressed.  

If the sensor breached any of the predefined alarm levels, then the alarm symbol will 
be displayed alongside the data reading.  

Scan for network 

Found 0 network

Scan complete  No found networks:

Rescan networks 

        
         View Data   
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For example: 

 

The logger display alarm symbols are: 

 AL-HI : Alarm High 

 AL-Lo : Alarm Low 

 AL-P-H : Pre Alarm High 

 AL-P-L : Pre Alarm Low 

` 

Status Menu 

 

The Status menu contains the following sub menus, all reachable by using the Scroll 
button.  

The sub menus are outlined below in the order in which they appear on the logger 
display. 

 

Name and Status 

As explained previously, the unit name (or Comment) is displayed on the first row 
and the second row indicates the logger status.  

If the logger is running, then the following screen is displayed. 

 

 

Mark Unit on PC 

To indicate the logger icon in the software’s Map View, press the Enter button when 
this screen is displayed. The logger’s icon located in the Map View will blink a 
number of times. 

Batt Level (battery level) 

If the power adapter is not connected the battery percentage will be displayed. 

If the power adapter is connected Battery charging will be displayed.  

 

Signal Level Test   

The Signal Level test allows the user to check the signal strength and quality of the 
link between the logger and its parent unit. This test is used to determine optimal 
positioning of the logger during deployment.  

Batt Level:      

Battery charging 

 

Batt Level:     67% 

fourtec DataNet 
Logger running  
 

        
          Status  

In-TMP 
24˚C         AL-Lo 
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By pressing the Menu button the unit will show the signal level and link quality in 
percentage terms. 

If there is no connection with a parent unit, an Out of range message will be 
displayed. 

 

 Signal level: Indicates the reception level between end unit and parent unit. If the 
level falls below 20% then the logger should be placed in a better location or a 
Repeater should be added. 

 Link quality: Calculation of the data transmitted with no errors from the logger to 
the parent unit. If the level falls between 85% then the logger should be placed in 
a better location or a Repeater should be added. The lower the link quality %, the 
more retries are needed in order for the logger to send all of its data.  

Note: The signal level may be low but the link quality can still be 100%. 

 

You will not be able to run the Signal Level test when the logger has lost its 
connection to the network. If you tried, then the following screens are displayed:  

 

 

Firmware Version  

This menu informs the user of the logger firmware version. This is helpful when you 
need to upgrade the system firmware, to check the current version. Or when 
contacting fourtec technical support, with any technical issues. 

 

The firmware version is commonly referred to by the numbers in bold in the screen 
above. For example, the firmware version which is supported by this user guide is 
v2.30.  

S/N 

This menu displays the unit’s eight digit SN. 

 

 

S/N 12345678 

Firmware version: 
2.03.04.02.30.00 

s   

No Parent signal fourtec DataNet 
No Parent found  

Out of range Signal level:   80 
Link quality:   95 

Signal level: 
Run test -> Menu 
 

s   
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Network Data 

This menu displays the unique network ID to which the unit is currently connected. 
This ID will match the network ID displayed in the software in the Receiver icon’s 
tooltip in the Map View. 

 

Device Mode 

There are two possible device modes: 

 Logger 

Device is operating as standard data logger 

 Logger – Repeater 

Device is operating as a Short Range Repeater. Refer to section ‎3.8.5 for more 
details. 

 

Leave Network  

If this option is selected, the unit will first leave the network and then reset itself. The 
scan network procedure described in section ‎4.12.3 will begin. The only exception to 
this procedure is that even if the last connected network is found during the scan, the 
unit will not automatically connect to it.  

 

Note: If the logger was in Run mode prior to sending the Leave Network command 
the software will download all data from the unit first and then force it to leave the 
network.  

 

Reset Unit  

When the unit is reset, upon start up it will automatically scan for networks. The unit 
will automatically connect to the previously connected network assuming it was found 
in the network scan. 

Following reset the unit will continue to operate according to its last set up instruction. 
For example, if the logger was in Run mode, then after reset it will continue to run 
and record data. 

 

Turn Off Unit 

Selecting this option will shut the unit down. You can turn the unit on again by 
pressing the Scroll button.  

It is recommended to turn off the unit when it is not in use. 

 

Turn off unit 

Leave network 

Network data: 
ID: 014.061.082 

s   
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Note: Turning off the logger when in Short Range Repeater mode can have adverse 
affects on your network, as other units may be dependent on the Repeater for 
transmitting its data to the Receiver. To prevent the SRR from being a point of failure 
if shut off, ensure the network is robust enough by having alternative routes for the 
end units to reach the Receiver.  

Min/Max Values Menu  

Each sensor’s minimum/maximum readings (taken from the current logging session) 
will be displayed on two rows.  

The first row indicates the sensor type, along with the measurement units e.g. V, and 
the alarm indication if there is an active alarm on this sensor. 

The second row indicates the minimum and maximum measured value and the units. 
H and L represent High and Low values, respectively. 

 

4.12.5.  Additional Logger Screens 

Unit Beep 

When the DataSuite software activates the Call Unit feature, the logger will beep and 
the following screen will be displayed:  

 

Refer to section ‎14.16.5 for more details. 

 

No Parent Signal 

When a logger’s parent unit, such as a Repeater or Receiver, goes offline then the 
following screen is immediately displayed on the logger: 

 

For example, this could happen if the Receiver managing the network has formed a 
new network, so there is no Receiver managing the previous network. Or if the 
parent unit is a Repeater, and it goes offline, then the logger will display this 
message.  

Once it has determined that the parent signal is lost, it will try to establish a 
connection with the network via another Repeater but if it fails then the following 
screen is displayed: 

 

 

You will have to leave the network and rescan for a new network. 

 

fourtec DataNet 
No Parent found 

No Parent signal 

          Unit Beep 
fourtec DataNet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In-TMP ˚C 
26.06H     25.61L 
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Loading Firmware  

When updating the firmware of the data logger via the software’s Firmware Update 
Center, the logger screen will display the update progress. When complete the main 
logger status screen will be displayed.  

Also refer to ‎Chapter 15: Updating DataSuite Software and Firmware. 

 

Note: Logger must be in Stop mode before firmware can be updated. 

4.13. Operating the Mini DataNet DNL8XX, 

DNL8XX-BXT and DNR800 

This section explains how to operate the DNL804, DNL808, DNL810, DNL8XX-BXT 
and DNR800 Mini DataNet units using the multi-functional button on the logger front 
panel. There is no LCD screen on the Mini DataNet models.  

Ensure the device Serial Number has been added to the Mini DataNet Device Filter 
before continuing. Refer to section ‎3.5.3. 

A useful tip for remembering the LED functionality is that a green LED indicates a 
logger turning on or joining a network, and a red LED indicates a logger is shutting 
down or leaving a network. 

4.13.1. Turning Mini DataNet Units Off  

DNL8XX and DNL8XX-BXT 

To conserve battery, the Mini DataNet LED does not provide an indication of on/off 
status. If you wish to operate the logger it is best to first be sure the unit is turned off 
before continuing. 

1. To turn the unit off: 

2. Press and hold the logger button until the LED emits a fixed, red light for at least 
three seconds. 

3. Release the logger button.  

 

DNR800 

The DNR800 Mini Repeater is powered by external AC power supply only. There is 
no battery backup. When disconnected the unit is shutdown immediately and is 
disconnected from the network.  

4.13.2. Turning Mini DataNet Units On and Joining a 

Network 

DNL8XX and DNL8XX-BXT 

The action of turning on a unit means that it will also join a network. 

When the unit is off: 

1. Give the logger button a short press.  

Loading firmware  
Progress: 55% 
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2. The logger will search for a network. The LED will blink green at one second 
intervals until either of the following two scenarios occurs: 

 The logger automatically finds a network. The LED will be fixed green for 
five seconds and the logger icon will display and blink for eight seconds in the 
software Map View. 

The logger will connect to the first network it find which recognizes its Serial 
Number, as entered in the Device Filter. 

 The logger doesn't find a network. After 60 seconds   of failed attempts to 
find a network, the logger will shut down. 

Note: The logger won’t find a network if its serial network wasn’t entered in 
the Device Filter, the Receiver isn’t online or if the network is locked (go to the 
Network menu to unlock). 

3. Once the logger has joined the network you may configure it to start recording 
data. Refer to section ‎14.17. 

 

DNR800 

The DNR800 functionality for joining a network is the same as for the other Mini 
DataNet units. The only difference is that to turn on the Mini Repeater, you can also 
just connect the unit to its external power supply. When turned on it will automatically 
search for networks. 

4.13.3. Rescanning for Networks 

If the unit has joined another network i.e. not yours, then you will have to leave that 
network and rescan for new networks. This requires first shutting off the unit and then 
leaving the current network.  

1. Make sure the unit serial number is entered into the Mini DataNet Device Filter.  

2. Turn the unit off by pressing and holding the unit button until the LED emits a 
fixed, red light for at least three seconds. 

3. Release the unit button. 

4. To leave the network, press the unit button again for three seconds. The LED will 
blink red three times to indicate Leave Network command has been received. 
The unit icon will be removed from the software Map View.  

5. To rescan for network, give the unit button a short press. The unit will search for a 
network and will indicate it has joined a network by emitting a solid green LED for 
five seconds. 

Note: If there are multiple DataNet networks in your environment make sure that the 
unit SN is listed in the Device Filter of only one of these networks, otherwise you 
can’t control which network it will join first and you will have to rescan the networks 
several times. 

4.13.4. Leave Network  

To leave the current network, when the unit is on: 

1. Press and hold the unit button until the LED emits a fixed, red light for at least 
three seconds. 

2. Release the unit button. 
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3. To leave the network, press the unit button again for three seconds. The LED will 
blink red three times to indicate Leave Network command has been received. 
The unit icon will be removed from the software Map View. The unit is now off. 

4.13.5. Running Signal Test 

You may run a signal test on the logger or Mini Repeater to check the signal strength 
to the parent unit. 

Right-click the unit icon on the Map View and select the Signal Test option. The 
signal test will be performed on the unit with the following parameters indicating 
signal quality: 

 Good: LED blinks orange at for 0.5 second intervals 

 Low: LED blinks orange at one second intervals 

 Unit is out of range: LED emits steady orange light   

Note: Power consumption of logger battery during signal test increases significantly 

so do not overuse this feature.  

4.13.6. Call Unit from Software 

To locate the unit via the software, right-click the unit icon on the Map View and 
select the Call Device (LED) option. The unit LED will alternate between slow green 
and red blinks and after several blinks it will stop.  

4.14. Operating the DNR900 in Receiver Mode 

This section explains how to operate the Receiver using the menu options on the 
units’ LCD screen, as how to change the DNR900 unit type from Receiver to 
Repeater.  

4.14.1. Turning on the Unit 

In order to view the Receiver menu options, the unit must be turned on by pressing 

the Scroll button  on the keypad. Ensure the unit is charged or connected to the 
AC adapter. 

Once the unit is turned on it will display a series of status messages, finishing with 
the welcome screen below: 

 

4.14.2. Receiver Menus 

When the unit is selected to work as a Receiver (as opposed to working as a 
Repeater) the following menus are displayed on the unit. 

Receiver 
ID:  021.180.012 
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T 
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Network Name and ID 

When the unit is switched on the following screen is displayed, indicating the default 
network name and the unique network ID formed by this Receiver. The network 
name can be changed via the DataSuite software. 

 

Receiver version 

This menu informs the user of the Receiver firmware version. This is helpful when 
you need to upgrade the system firmware, to check the current version. Or when 
contacting fourtec technical support, with any technical issues. 

Reset Unit    

When the unit is reset, upon start up it will reconnect the network it previously formed 
and managed.  

 

Turn Off Unit 

Selecting this option will shut the unit down. You can turn the unit on again by 
pressing the Scroll button. When the Receiver is shutdown the network will be down 
as well, as the end units won’t be able to transmit to the Receiver. 

 

It is recommended to turn off the unit when it is not in use. 

4.14.3. Changing Receiver to Repeater 

For users of DNR900 firmware 2.45 and higher, use the DataSuite software to 
change the DNR900 from Receiver mode to Repeater mode. Refer to section ‎14.16 
for more details. 

For users of firmware versions lower than 2.45, follow the instructions below. 

 

Scroll through the Receiver menu until you reach the menu Change Unit Type to 
Repeater. 

 

 

Press the Enter button to proceed with changing the unit to Repeater mode. Once 
you perform this action, any network the unit may have formed while in Receiver 
mode will be down, and you will need to form a new network with another Receiver 
unit, and join your existing loggers to that new network. 

Note: Once you change the Receiver to a Repeater, you will only be able to 
download data from loggers on the Receiver’s network via direct USB connection or 
by using the Substitute Receiver feature (see section ‎4.15.6). 

Change unit type 
to Repeater 
 

 

 

 

 

 

 

 

 

 

 

 

 

Turn off unit 

Reset unit 

DataNet Network 
ID:  021.180.012 
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Once the unit is in Repeater mode, you will need to leave the network it is connected 
to, and scan for a new network. Only once the Repeater joins the network will other 
units on that network detect it.  

Refer to section ‎4.15 for more details on operating a Repeater and joining a new 
network.  

4.14.4. Additional Receiver Screens 

Loading Firmware  

When updating the firmware of the Receiver via the software’s Firmware Update 
Center, the Receiver screen will display the update progress. When complete the 
main Receiver status screen will be displayed. 

 

4.15. Operating the DNR900 in Repeater Mode 

This section explains how to operate the Repeater and provides an overview of the 
menu options on the units’ LCD screen. 

Refer to section ‎4.14.3 to learn how to switch the DNR900 from Receiver to Repeater 
mode. 

4.15.1. Turning on the Unit 

In order to view the Repeater menu options, the unit must be turned on by pressing 

the Scroll button  on the keypad. Ensure the unit is connected to the AC 
adapter. 

Once the unit is switched on it will emit a short beep and the screen will display a 
welcome message:  

 

4.15.2. Display Shutdown 

When the Repeater is running from batteries only, if the screen is inactive for thirty 
seconds it will turn off. However the Repeater will continue to operate in the 
background. Press the Scroll button to enable the LCD screen again. The screen will 
not turn off during firmware upgrade. 

When connected to external power supply the Repeater screen will always stay on. 

4.15.3. Joining a Network 

When a Repeater is powered on or reset, it will automatically scan for a network after 
the welcome message has appeared.  

There are four scenarios that can occur while scanning for a network: 

fourtec DataNet 
Ready 
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Loading firmware  
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Scenario 1: The unit can’t find the last network that it was connected to. For 
example, the Repeater is a new unit which was never previously joined a network. 

Scenario 2: The unit scans and finds the last network it was connected to, and joins 
that network. 

Scenario 3: The unit can’t find any networks at all. 

Scenario 4: The unit found a network but failed to join. 

 

Read below for more details on each scenario. 

Scenario 1 

If the unit can’t find the last network that it was connected to (for example, it’s a new 
unit), the unit will display all the networks that are in range: 

 

Where # is the number of networks found 

 

Once the scan has been completed the following screen appears: 

 

If more than one network was found, the user will need to select the network ID that 
he wants to connect to. The user uses the Scroll button to scroll through the Network 
IDs. The relevant network is selected using the Enter button.  

 

Once the network has been selected the following screen will be displayed.  

 

 

To rescan the networks, simply select the Rescan Networks option and the logger 
will start the scanning process again. 

 

If only one network was found the system will automatically connect to that network 
without the user needing to select the network manually. 

 

The Repeater display will return to the welcome message, which consists of the 
Repeater name (editable via the software) and the network status: 

Ready - If connection to the DataSuite software is established. 

Network 1:

ID: 014.061.082  

Network 2:

ID: 021.207.175  

Network 1:

ID: 014.061.082  

Network 2:

ID: 021.207.175  

Rescan networks

Scan for network 

Found 1 network

Scan complete  Joined to network:

ID: 021.207.175  

Scan for network 

Found 1 network

Scan complete  Joined to network:

ID: 021.207.175  

Scan for network 

Found 1 network

Scan complete  Joined to network:

ID: 021.207.175  

Joined network: 
ID: 021.207.175   
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Software is down - If established connection to the Receiver but the DataSuite 
software is down (PC is off, software is not open, etc.) 

No Parent Signal – The parent unit, either the Receiver or another Repeater, is not 
detected by the Repeater therefore it is not transmitting its data to the network.  

   

The Repeater will continue to search for the parent unit (at specific intervals) and the 
screen will continue to read Search Parent until the parent is found. 

 

Scenario 2 

When the system scans for networks and finds the last network that it was connected 
to it will automatically connect to the last known network. 

 

As in Scenario 1, the logger display will then return to the welcome message 
displaying the unit name and status.  

 

Scenario 3 

The system can’t find any networks at all. 

If no networks were found, the unit will display the following screens. 

 

Scenario 4 

The unit found a network but failed to join. 

The unit will perform up to 99 retries to join the network before scanning for networks 
again. Press any of the unit buttons to cease the attempts to join the network. 

A unit may fail to join a network if it is far from the Receiver, requiring several hops to 
reach the Receiver, or the network itself is large with many units. The attempt to join 
a network is made in under a second in real-time and on high traffic network, it may 
result in failure to join.  

Moving the unit closer to the Receiver can help the logger to join successfully. If the 
logger still can’t join, form a new network or contact fourtec technical support. 

4.15.4.  Menu Options 

Use the Scroll button to scroll through the menu options.  

Name and Status 

The unit name is displayed on the first row and the second row indicates the 
Repeater status.  

fourtec DataNet 

Ready

fourtec DataNet 

Software is down

fourtec DataNet

No Parent Signal

fourtec DataNet 

Ready

fourtec DataNet 

Software is down

fourtec DataNet

No Parent Signal

Scan for network 

Found 0 network

Scan complete  No found networks:

Rescan networks 

Joined Network: 
ID: 021.207.175   
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Mark Unit on PC 

To indicate the Repeater icon in the software’s Map View, press the Enter button 
when this screen is displayed. The Repeater’s icon located in the Map View will blink 
a number of times. 

 

Batt Level (battery level) 

 If the power adapter is not connected the battery percentage will be displayed. 

 If the power adapter is connected Battery charging will be displayed.  

 

Signal Level Test   

The Signal Level test allows the user to check the signal strength and quality of the 
link between the Repeater and its parent unit. This test is used to determine optimal 
positioning of the Repeater during deployment.  

 

 

By pressing the Menu button the unit will show the signal level and link quality in 
percentage terms. 

If there is no connection with a parent unit, an Out of range message will be 
displayed. 

 

 Signal level: Indicates the reception level between end unit and parent unit. If the 
level falls below 20% then the logger should be placed in a better location or 
another Repeater should be added. 

 Link quality: Calculation of the data transmitted with no errors from the Repeater 
to the parent unit. If the level falls between 85% then the Repeater should be 
placed in a better location or another Repeater should be added. The lower the 
link quality %, the more retries are needed in order for the Repeater to send all of 
its data. 

Note: The signal level may be low but the link quality can still be 100%. 

 

You will not be able to run the Signal Level test when the Repeater has lost its 
connection to the network. If you tried, then the following screens are displayed: 

Out of range 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Signal level:   80 
Link quality:   95 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Signal level: 
Run test -> Menu 
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Battery charging 
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Firmware Version  

This menu informs the user of the Repeater firmware version. This is helpful when 
you need to upgrade the system firmware, to check the current version. Or when 
contacting fourtec technical support, with any technical issues. 

 

The firmware version is commonly referred to by the numbers in bold in the screen 
above. For example, the firmware version which is supported by this user guide is 
v2.30.  

 

S/N 

This menu displays the unit’s eight digit SN. 

 

 

Network Data 

This menu displays the unique network ID to which the unit is currently connected. 
This ID will match the network ID displayed in the software in the Receiver icon’s 
tooltip in the Map View. 

 

 

Go to Substitute Receiver Mode 

Refer to section ‎4.15.6 for more details. 

 

Change Unit Type to Receiver 

Select this option to change your unit from Repeater to Receiver mode. A new 
network ID will be formed.  

 

Press the Enter button to proceed with changing the unit to Receiver mode. 

 

Leave Network  

If this option is selected, the unit will first leave the network and then reset itself. The 
scan network procedure described in section ‎4.12.3 will begin. The only exception to 

Change unit type 
to Receiver 

Network data: 
ID: 014.061.082 

s   

S/N 12345678 

Firmware version: 
1.03.01.02.30.00 

s   

No Parent signal fourtec DataNet 
No Parent found  
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this procedure is that even if the last connected network is found during the scan, the 
unit will not automatically connect to it.  

 

 

Reset Unit  

When the unit is reset, upon start up it will automatically scan for networks. The unit 
will automatically connect to the previously connected network assuming it was found 
in the network scan. 

 

Turn Off Unit 

Selecting this option will shut the unit down. You can turn the unit on again by 
pressing the Scroll button. 

It is recommended to turn off the unit when it is not in use. 

 

Note: Turning off the Repeater can have adverse affects on your network, as other 
units may be dependent on the Repeater for transmitting its data to the Receiver. To 
prevent the Repeater from being a point of failure if shut off, ensure the network is 
robust enough by having alternative routes for the end units to reach the Receiver.  

4.15.5. Additional Repeater Screens 

Unit Beep 

When the DataSuite software activates the Call Unit feature, the Repeater will beep 
and the following screen will be displayed:  

 

Refer to section ‎14.16.5 for more details. 

 

No Parent Signal/No Parent Found 

When a Repeater’s parent unit, such as another Repeater or the Receiver, goes 
offline then the following screen is immediately displayed on the logger: 

 

For example, this could happen if the Receiver managing the network has formed a 
new network, so there is no Receiver managing the previous network. Or if the 
parent unit is a Repeater, and it goes offline, then this Repeater will display the 
message above.  

Once it has determined that the parent signal is lost, it will try to establish a 
connection with the network via another Repeater but if it fails then the following 
screen is displayed: 

No Parent signal 

Unit Beep 
fourtec DataNet 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Turn off unit 

Leave network 
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You will have to leave the current network and rescan for a new network. 

 

Loading Firmware  

When updating the firmware of the Repeater via the software’s Firmware Update 
Center, the Repeater screen will display the update progress. When complete the 
main Repeater screen will be displayed. 

 

4.15.6. Working in Substitute Receiver Mode 

In the event that the network Receiver suffers hardware failure, is damaged or cannot 
operate for any reason, the DataNet network cannot function as an online monitoring 
system.  

In such an event any network with a functioning Repeater can restore network 
functionality i.e. transmission of data from logger to software, by using the Repeater 
to temporarily replace the Receiver.  

By doing so, the Repeater will be defined as a Substitute Receiver, maintaining the 
original network ID, and full Receiver functionality except for the ability to add new 
loggers to the network. Until a new, permanent Receiver is obtained, this feature 
provides an excellent backup enabling continuous data transfer preventing the time 
consuming task of moving all devices to a new network.  

To enable Substitute Receiver mode: 

1. Ensure the original network Receiver is switched off. 

2. Connect the Repeater to the PC via mini-USB cable. 

3. From the Repeater menu, select Go to Substitute Receiver mode. 

4. The LCD screen will display Sub Receiver and the network ID. To move to 
standard Repeater mode, select Change unit type to Repeater from the menu. 

4.16. Data Logger Memory Management 

All DataNet data loggers operate using a cyclic memory mechanism. When the 
logger memory is full, the logger will not stop recording data. It will continue by writing 
over the first samples recorded to the logger memory. 

As DataNet is an online monitoring system, the logger data is regularly transmitted to 
the Receiver, so any erased samples will already be safely recorded to the DataNet 
data file folders.  

The only scenario where data may be erased is if the Receiver is offline for a period 
longer than the data logger’s Recording Time (as displayed in the Setup dialog). The 
Recording Time indicates how long the logger can record data for until the memory is 
full. In this case, the logger memory will fill up and due to the cyclic mechanism, start 
erasing the first recorded samples. Any samples not transmitted to the computer will 
be permanently lost. It must be noted that this scenario is highly unlikely. 

Loading firmware  
Progress: 55% 

fourtec 
No Parent found 
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Chapter 5:  
DaqLink Overview 

This chapter provides a general overview of the DaqLink system. 

5.1. DaqLink Introduction 

Light, Portable and Independent Logging 

With built-in temperature and humidity sensors, plus four external probe inputs the 
DaqLink standalone data logger ensures a low cost, reliable and accurate solution. 
The DaqLink logger is a 16-bit, mobile data acquisition device for continuous indoor 
or outdoor data monitoring.  

The DaqLink system is comprised of two data logger models, measuring a broad 
range of parameters on four external inputs for direct measurement and recording of 
PT-100, thermocouple, 0 to 1 V, 4 to 20 mA, contact, frequency and pulse sensors, 
as well as internal temperature and relative humidity sensors.  

With its high resolution and fast Analog to Digital converter (ADC), DaqLink data 
loggers meet the majority of data acquisition requirements in most industrial 
applications. Every DaqLink logger unit is embedded with a unique serial number and 
can be loaded with a descriptive comment for safe identification. An internal clock 
and calendar keeps track of the time and date of every sample measured. 

DaqLink loggers can automatically activate external alarm events when data is 
outside a specified range. Email and SMS notifications can be sent to predefined 
contacts. 

The DaqLink system is powered by the powerful DataSuite software. The Windows 

 based software is the central management interface of the DaqLink network. 
When connected via USB cable to the PC, DaqLink data can be monitored online 
and displayed in real-time graphs or tables. Analyze data with various mathematical 
tools, or export data to a spreadsheet.  

The software also enables you to configure, calibrate or update the firmware of 
DaqLink units via direct USB connection.  

Key DaqLink benefits include: 

 Real-time logging - Online operation with data results on screen 

 Independence - Manual or PC operation with on-site monitoring via two-row LCD 
display 

 Intuitively - Simple keypad and easy-to-navigate menus 

 Long life - Low-power consumption and rechargeable battery lasting up to six 
months 

 Flexibility - Four alarm levels with visual LCD, and audible alarms 

 Non-stop logging - Continuous data storage to large onboard memory and 
periodic USB downloads 

5.2. The DaqLink System  

The basic DaqLink system contains at least one of the following units: 

 DaqLink data logger – Part Number DBSA710 or DBSA720 
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 Mini-USB communication cable  

 Power adapter (one per DaqLink unit ordered) 

 DataSuite software CD containing user guide 

5.2.1. The Data Logger  

There are two data logger models compatible with the DaqLink system. These 
loggers support up to four external sensors and two internal sensors, temperature 
and humidity, depending on the specific model. Data is recorded and stored to the 
logger’s internal memory and transmitted over the network to the DataSuite software 
running on the PC.  

The data logger is programmed to consume as little power as possible during 
operation, in order to conserve the battery life. When not transmitting or recording 
data the units are in sleep mode and they wake up when needed.  

The battery for the DBSA710 and DBSA720 is rechargeable and can run up to 
several months on one charge, depending on the logger configuration.  

Refer to section ‎4.9.7 for more information.  

Note: Battery life depends on the logger sampling rate, transmission rate, type of 

sensor, and number of measured sensors. 

DaqLink Data Loggers 

  

Part Number: DBSA720 Part Number: DBSA710 

Four external channel data logger with 
two internal sensors, Humidity and 
Temperature 

Four external channel data logger with 
internal Temperature sensor 

Memory Capacity: ~59,000 samples 

Power supply: AC or battery operated 

Memory Capacity: ~59,000 samples 

Power supply: AC or battery operated 

5.2.2. Hardware Accessories 

The DaqLink system includes the following accessories: 

 Mini-USB cable for connecting data logger to PC 

 Power adapter to power the data logger 
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Chapter 6:  
DaqLink Implementation Guide  

fourtec recommends first time users of the DaqLink system read this chapter before 
drilling down into the many features of the system described later in the user guide. 
The Implementation Guide will give you a clear understanding of the basic aspects of 
setting up the system, and getting the data logger up and running.  

6.1. Pre-setup Requirements 

Prior to commencing with the DaqLink implementation you must have the following 
requirements in place: 

PC 

 24/7 availability, if online data monitoring is required 

 Reliable AC power 

 Sufficient hard disk space to store loggers’ data 

 One free USB port 

 

DaqLink devices 

At least one DaqLink logger DBSA710 or DBSA720. 

 

Mini-USB cable 

The mini-USB cable connects the data logger to the PC for logger configuration and 
data download (and is supplied with the DataSuite software kit). 

6.2. Launching the Software 

1. Install the DataSuite software on the PC workstation. Refer to section ‎14.1: 
Installing DataSuite Software on page 129 for more details. 

2. Once the software and associated components have been installed, launch 

DataSuite from your DataSuite desktop shortcut  

3. The main DataSuite window is launched. The default view is called Map View. 
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Figure 31: Main DataSuite window 

4. Check for DataSuite updates. Go to Help > Check for Updates from the 
DataSuite main menu to check for newer versions of the DaqLink module 
software and firmware released since you purchased your system. For more 
details on the Update feature go to ‎Chapter 15: Updating DataSuite Software and 
Firmware. 

6.3. Connecting the Logger 

Note: Multiple DaqLink loggers may be detected by the PC at a time.  

1. Only once the DataSuite software and USB driver have been installed, connect 
the DaqLink data logger (DBSA710 or DBSA720) to the fourtec-supplied power 
adapter.  

Note: Only use adapters provided by fourtec. Use of the wrong adapter could 

damage your DaqLink units.  

 

2. Turn on the unit by pressing the Scroll button  on the front keypad. The 
unit will beep when turned on. 

3. Connect the mini-USB cable to the computer and to the data logger’s mini-USB 
port.  

4. From the DaqLink main menu, go to Devices > Detect Device. The data logger 
icon will appear in the Map View indicating that the logger is detected.  

 

Figure 32: Adding data logger icon to Map View 

Note: If the logger is not recognized by the software try connecting the mini-USB 
cable to another USB port on the PC. Or select Devices > Detect Device again in 

the main menu. 
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5. Should you disconnect the logger’s USB cable or power adapter (and the battery 

eventually dies), the logger icon will be grayed out:  

Note: You can move the logger icon elsewhere on the screen by going to Tools > 

Lock Map View and unselecting this option. 

6.4. Charging DaqLink Loggers 

This section refers to charging the DBSA710 or DBSA720 loggers.  

Note: Only use adapters provided by fourtec. Use of the wrong adapter could 

damage your DaqLink units.  

 

If the loggers will run from the battery supply make sure to first charge each of the 
loggers for 16 hours before use in order maximize the battery life. A fully charged 
battery can last several months, depending on your logger configuration.  

If the loggers will run from the AC power supply, when first connected to the AC 
adapter the logger will always initiate the 16 hour charge cycle.  

Note: For loggers measuring data with the internal temperature sensor, it is critical to 
note that during the charge cycle the logger will heat up thereby causing the internal 
temperature sensor reading to rise up to 10 ˚C above ambient temperature. Once the 
charging process is complete, the logger will cool down and the internal temperature 
sensor readings will return to normal.  

For loggers remaining connected to AC power, to prevent the logger from heating up 
again following the initial charge cycle, the logger will receive a one minute trickle 
charge each day rather than stay continually charged. This is sufficient to ensure the 
logger doesn’t self-discharge and will maintain the logger’s full charge status. 

Refer to section ‎4.9.3 for more details on the DaqLink loggers’ power supply. 

6.5. Loading Map View Background 

Load an image into the DataSuite software showing a map of your facility in order to 
place the Logger icons in their relative positions. As you deploy more standalone 
loggers, this will prove very helpful.  

 Double click the Map View background to browse to the image directory and load 
the image. Remember to unlock the Map View in order to move the icons around. 

 Right-click the Map View background and two options will be available: Load 
Wallpaper and Reset Wallpaper, which resets to the default fourtec wallpaper. 

6.6. Configuring the Logger 

Once the software has detected the DaqLink logger, you must configure the unit in 
order to start acquiring data. 

1. Right-click on the Logger icon. Select Setup from the context menu. 

2. The Setup window will be launched. 
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Figure 33: DaqLink Logger Setup window 

This dialog provides non-editable information such as the serial number, battery 
level, and firmware version of the current unit.  

On the Device Setup and Alarm Setup tabs, the user is able to configure the 
following parameters:  

 Unit's comment  

 Sampling rate  

 Memory State 

 Averaging points 

 Temperature units °C/°F (on the logger LCD) 

 Anti-tamper mode 

 Active sensors  

 Custom sensors' names  

 Alarm levels  

 Alarm duration  

 Alarm delay  

 Alarm pre delay 

3. Select the Memory State, Online or Optimized Memory Modes.  

4. Select the sensors you wish to connect to the logger for data acquisition. It 
doesn’t matter which order you select the sensors. You may only have Input 4 
selected, for example, and Inputs 1 to 3 left unselected. 

5. Select the sampling rate anywhere from 1 every second to 1 every 18 hours. 

6. Unless you have Alarm levels you wish to edit (see the Alarms Setup tab), click 
either Setup and Run (to send the setup and immediately log data), or Setup 
Only (to send the setup but only log data at your command). 

7. If you selected Setup Only in step 5, right-click the Logger icon and select Run 

from the context menu to start logging data or click  in the main tool bar. 
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8. The Logger icon will appear as follows when in Run mode: .  

9. To stop the logger, right-click the Logger icon and select Stop from the context 
menu. 

Note: Running the logger clears the logger memory. All previously recorded data will 

be erased when you begin a new logging session. 

6.7. Viewing Data  

Once you run the logger, you have several ways of viewing the online data that is 
being acquired. 

 Online graph/table/statistics views 

 Logger icon tooltip 

 Sensor view 

6.7.1. Online Data Views 

Double clicking the Logger icon or selecting Display Data in the Logger icon context 
menu will open the online graph. 

This graph is updated in real-time with the newly recorded data. 

You can switch between Graph, Table and Statistics views to view the data in 
different formats.  

      

Figure 34: Online data – Graph view 

 

Figure 35: Online data – Table view 
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Figure 36: Online data – Statistics view  

6.7.2. Logger Tooltip 

Close the online data window and return to Map View. Scroll over the Logger icon 
and you will see a tooltip displaying the relevant logger information, including real-
time data.  

 

Figure 37: Logger tooltip 

This tool-tip is updated with every newly recorded sample. 

6.7.3. Sensor View 

Click the Sensor View icon  in the tool bar to switch to this view. Here, you can 
monitor the data by viewing data display of each individual sensor, rather than of 
each logger. 

 

Figure 38: Sensor view 

 

 If the sensor is in alarm, the sensor box will change color from green to red (just 
as the Logger icon would). 

 Double-clicking the individual sensor box will open the data in the online Graph 
view. 

6.8. Downloading Data  

If the logger is being used as a standalone device you will have to connect it to the 
computer via USB cable in order to download the data to the software. 

1. Connect logger to PC and go to Devices > Detect Device in the main menu. 
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2. To download data right-click the logger icon and select Download Data. 

3. View the downloaded data by double-clicking the logger icon.  
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Chapter 7:  
DaqLink Hardware Overview 

This chapter details the hardware features of the DaqLink data loggers.  

7.1. Data Logger Front Panel Layout 

7.1.1. DBSA710 and DBSA720  

Apart from the color scheme, the DBSA710 and DBSA720 data logger models have 
the same front panel design. 

 

Figure 39:  DBSA710 data logger front panel 

LCD screen 

Displays logger status, logger data, and Min/Max values. 

Menu/Enter button 

Use to enter logger menu options and to execute logger commands. 

Scroll button 

Use to scroll though menu items and to power on unit. 

7.2. Data Logger External Connections 

7.2.1. DBSA710 and DBSA720 

External connections of the DBSA710 and DBSA720 are exactly the same. 

  

Scroll button

Menu/Enter button

LCD screen

Scroll button

Menu/Enter button

LCD screen

Mini USB port

12 V power socket 

Negative Center

Four sensor 

inputs

Excitation

Mini USB port

12 V power socket 

Negative Center

Four sensor 

inputs

Excitation
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Figure 40:  DBSA720 data logger external connections 

 

Mini USB Port 

To enable communication between logger and PC, for configuration and data 
download. 

12 V Power Socket 

To connect logger to external power supply (negative center). 

Sensor Inputs 

Pluggable screw terminal blocks marked In-1 to In-4 (from left to right), to 
connect wide range of sensor types for data acquisition. All four inputs can be 
used simultaneously. Sensors can be connected in any order. 

To connect a sensor to the DaqLink data logger, unplug the screw terminal, 
connect the sensor’s wires to the terminals, and then plug the terminal back to 
the corresponding socket on the input block. 

Excitation socket 

Output power socket used to power external sensors, power derived directly 
from the external power supply adaptor.   

7.3. Data Logger Sensor Overview 

This section provides an overview of the hardware specifications of the DaqLink data 
loggers.  

7.3.1. Internal Sensor Types 

The DBSA710 and DBSA720 loggers include internal sensors, depending on the 
logger model. 

 

Sensor Measurement 
Range 

Accuracy Logger 
Model 

Digital Humidity  5% to 95% 

±3% (in DataSuite 
software) 

±4% (on logger LCD) 

DBSA720 

Digital 
Temperature  

-20 ºC to 50 ºC ±0.5 ºC DBSA720 

Temperature 
PT100  

-20 ºC to 50 ºC ±0.3 ºC  DBSA710 
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7.3.2. External Sensor Types 

DBSA710 and DBSA720 

Each of the four input channels of these data logger models are multi-purpose and 
can be individually configured to any of the following types and ranges.  

Sensor Measurement Range Accuracy Available Inputs 

Current  4 to 20 mA ± 0.5 % In-1 to In-4 

Contact Open (0) /  
Close (1) 

N/A In-1 to In-4 

Frequency 20 Hz to 4 KHz N/A In-4 only 

Pulse Counter 1 to 65,536 pulses 

0 to 4 KHz 

N/A In-4 only 

Temperature 
PT100 (2-wire) 

-200 to 400 ºC -200 to -60 ºC ±0.5 % 

-60 to 60 ºC ±0.3 ˚C  

60 to 400 ºC ±0.5 % 

In-1 to In-4 

Temperature TC-J -200 ºC to 1,000 ºC -200 to -60 ºC ±0.5 % 

-60 to 60 ºC ±0.5 ˚C  

60 to 1,000 ºC ±0.5 % 

In-1 to In-4 

Temperature TC-K -200 ºC to 1,000 ºC -200 to -60 ºC ±0.5 % 

-60 to 60 ºC ±0.5 ˚C  

60 to 1,000 ºC ±0.5 % 

In-1 to In-4 

Temperature TC-T -200 ºC to 400 ºC -200 to -60 ºC ±0.5 % 

-60 to 60 ºC ±0.5 ˚C  

60 to 400 ºC ±0.5 % 

In-1 to In-4 

Voltage 0 to 1 V ± 0.5 % In-1 to In-4 

Voltage 0 to 50 mV ± 0.5 % In-1 to In-4 

7.3.3. Sensor Connection 

Connect the sensor/s to the terminal block/s at the top of data logger: 

 

Figure 41: DaqLink logger sensor inputs 

 

Sensors do not have to be added successively. You may only configure In-4, or 
configure In-1 and In-3, for example, when setting up the logger via the software. 
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7.3.4. External PT-100 Sensor Connection 

The PT-100 sensor, as supplied by fourtec, comes pre-wired to the data logger’s 
terminal block.  

The PT-100 positive polarity (red) and ground (white) wires are connected to the + 
input of the terminal block. The negative polarity (black) wire is connected to the – 
input on the terminal block.  

7.3.5. Programming Limitations for DBSA710 and 

DBSA720 

The standard sampling rate for all sensors on all inputs is from a maximum of one 
sample every second to a minimum of one sample every 18 hours. However, there 
are certain limitations using a specific combination of sensors, which must be taken 
into account when programming the DaqLink data loggers.  

Note: The software integrates all programming limitations automatically when 

configuring the loggers.  

Please refer to the table below for DaqLink programming limitations, where:  

PT100, Thermocouple J, K or T  = A 

Internal Digital Temperature (on 
DBSA720) 

= B 

 

Sensor 
Combination 

Maximum Sampling Rate Example Setup 

3 x A 

4 x A 

A + B 

One sample every three seconds In-1: PT-100 

In-2: TC-J 

In-3: TC-J 

(2 x A) + B 

(3 x A) + B 

One sample every four seconds Internal: Temp 

In-1: TC-T 

In-2: PT-100 

(4 x A) + B One sample every five seconds Internal: Temp 

In-1: TC-T 

In-2: TC-J 

In-3: PT-100 

In-4: PT-100 

Table 3: Data Logger programming limitations 

7.3.6. External Alarm Output 

The DaqLink system supports connection of an external alarm e.g. siren, audible 
alarm, to In-1 of the DBSA710 and DBSA720 data loggers.  

When connected to the logger, the external alarm will be activated only when that 
logger is in alarm status. 

Once there is no alarm status, the external alarm will be deactivated. 
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Data Logger External Alarm 

In-1 of the DBSA710 and DBSA720 serves either as a standard sensor input or as an 
external alarm output. Ensure the logger is connected to AC power if connected to an 
external alarm.  

Configure In-1 as Alarm Normally Open or Alarm Normally Closed in the logger 
Setup window in the DataSuite software. 

Normally Open will result in the alarm being activated during alarm status (the circuit 
will be closed).  

Normally Closed will result in the alarm being activated when logger is not in alarm 
and therefore deactivated when there is an alarm (the circuit will be opened). 

Connect In-1 to your external alarm device and connect the logger to AC power.  

Use the Alarm Setup tab in the Setup dialog to define the logger alarm settings. If 
these settings are breached then the alarm will be activated. 

External Alarm Schematic 

See the schematic below explaining how to hook up an external alarm to the DaqLink 
unit. 

 

 

Figure 42: External alarm schematic 

 + from DBSA710/720 goes to – of the Relay inputs 

 + of Relay input goes to battery that powers the Relay 

 Load inputs of the Relay go to the Alarm device e.g. siren, lights, etc. 

 - of the battery goes to – of DBSA710/720. 

Note: Maximum load of the Relay is 50 mA, 3 V. 

Refer to ‎Appendix B: DaqLink Specifications for the full external alarm output 
specification. 

7.3.7. Polarity 

Current, voltage, thermocouples and user defined sensors have distinct polarity. Be 
careful to connect them in the right polarity. 

- +

Relay

- +

- +
Alarm device 

(e.g. siren)

+

-
3-4 V battery 

to power relay

- +

Relay

- +

- +
Alarm device 

(e.g. siren)

+

-
3-4 V battery 

to power relay
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7.3.8. Frequency/Pulse Counter 

Connect the signal wires to In-4 terminal blocks, and select Frequency or Pulse 
counter for Input 4 from the logger Setup window in the DataSuite software. Inputs 1 
to 3 are still available for other sensors. 

 

The Frequency/Pulse counter is optically isolated from the internal circuitry and can 
simultaneously measure a signal source, together with another input. 

7.3.9. User Defined Sensors 

DaqLink provides a simple and straightforward tool for defining a limited number of 
custom sensors. Almost any sensor or transducer with 0 – 1 V or 4 – 20 mA output is 
accepted by the DaqLink logger and its electrical units are automatically scaled to 
meaningful user-defined engineering units. 

The sensor definitions are stored in the logger’s memory and are added to the 
sensors list. The sensor’s readings are displayed in the user defined units only in the 
DataSuite software. Future versions will also support displaying the user defined 
engineering units on the logger LCD. 

Refer to section ‎14.8.1 for more details.  

7.3.10. Sensor Alarms 

Via the software, users can define minimum and maximum alarm levels for each 
input individually. Users can define pre-low and pre-high alarm levels, for an 
additional level of safety in case the logger is approaching an actual breach of alarm. 

The DaqLink logger display indicates when the sensor reading is in alarm of any 
type. The symbols AL-H, AL-L, AL-P-H or AL-P-L are visible next to the 
corresponding input readings.  

Refer to section ‎14.18 for more details. 

7.3.11. Sensor Calibration 

The DaqLink data logger is shipped fully calibrated. However, further calibration can 
be applied via the DataSuite software. The calibration parameters are sent to the 
data loggers via USB connection and stored in the logger’s memory.  
Users may calibrate individual inputs as well as all inputs at once. Calibration settings 
may be saved and then loaded into the logger at a later date if the calibration settings 
have changed. 

Refer to section ‎14.19.4 for more details. 

7.4. Unit Serial Number and Comment 

Every DaqLink data logger unit is embedded with a unique serial number.  

The data logger only can be loaded with a descriptive comment to identify its task 
and location. You may add or edit the logger comment via the DataSuite software.  

Every time data is transferred to the computer it is labeled both with the logger’s 
serial number and comment and is displayed in the graph or data table view. 

The unit serial number is also marked on a sticker on the back of the product.  
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7.5. Power Supply 

7.5.1. DBSA710 and DBSA720 Data Loggers 

The DBSA710 and DBSA720 data loggers run from an internal NiMh rechargeable 
battery as well as from external AC power supply. Depending on the logger 
configuration, from a fully charged battery, the data logger can run for up to several 
months. Refer to section ‎4.9.7‎7.5.3 for more details on battery life. 

Note: Charge the data logger units for 16 hours before using them for the first time. 

When connected to external power supply, the data logger battery will not be 
charged when the unit is turned off. This will allow the system to protect the battery 
from overheating. 

First Time Charging 

From a fully drained battery, you must charge the battery for 16 hours to bring it to a 
full charge. Once the charge cycle is complete, the logger will run from the external 
power supply, without draining (or charging) the internal battery. In order to maintain 
a fully charged battery and ensure the battery doesn’t self-discharge, the battery 
charger will daily charge the unit for one minute to maintain the battery capacity. 

Note: Before storing the DaqLink units make sure you have unplugged all the 

sensors and turned the units off via the keypad.  

Standard Charging 

Whenever a logger is reconnected to the charger it will begin the 16-hour charge 
cycle, no matter what the status of the battery. Once the charging cycle is complete 
the logger will run from external power supply. 

 

Effect of Charging Battery on Temperature Sensor 

For loggers measuring data with the internal temperature sensor, it is critical to note 
that during the charge cycle the logger will heat up thereby causing the internal 
temperature sensor reading to rise by up to 10 ˚C above ambient temperature. Once 
the charging process is complete, the logger will cool down and the internal 
temperature sensor readings will return to normal.  

For loggers remaining connected to AC power, to prevent the logger from heating up 
again following the initial charge cycle, the logger will receive a one minute trickle 
charge each day rather than stay continually charged. This is sufficient to ensure the 
logger doesn’t self-discharge and will maintain the logger’s full charge status. 

7.5.2. Power Adapter 

The DaqLink power adapter is used to power the DBSA710 and DBSA720 units. The 
mains adaptor (AC/DC adaptor) converts mains power (from a wall outlet) to a 
voltage suitable to the DaqLink hardware unit. 

 Output: Capacitor filtered 9 to 12 VDC, 300 mA  

 Female plug, center negative 
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Note: Only use fourtec-supplied power adapters to avoid damaging the units with 
incorrect power supply. 

7.5.3. Data Logger Battery Life 

Battery life depends on the logger sampling rate, type of sensor, and number of 
measured sensors.  

DBSA710 and DBSA720 can last up to six months on a charged battery depending 
on logger configuration. 

7.6. USB Communication Cable 

A mini USB communication cable is supplied as part of the DataSuite software kit. 
This cable connects the DaqLink data logger to the DaqLink PC workstation. When 
connected to the PC the logger can communicate with the software for configuration 
and data download purposes, for example.  

The USB cable also powers the logger when connected to the PC but it does not 
charge the internal battery. 

Note: The USB driver is installed as part of the software installation process. Without 
this driver the PC won’t detect the logger. To avoid compatibility problems do not 

connect the logger to the PC before installing the USB driver. 

 

Figure 43: USB communication cable 

7.7. DaqLink Keypad Overview 

7.7.1. DBSA710 and DBSA720 Keypad 

The DBSA710 and DBSA720 units each have two buttons on the keypad, which are 
used to navigate through the LCD menu options, as well as turn on the units. 

Refer to section ‎4.12 to learn how to operate the data loggers.  

 

The Menu button  has 
two functionalities: 

Navigate to the main menu. 
When pressed from within a 
submenu, the display will take you 
back to the main menu.  

Selecting an option from one of 
the menus. When pressed on one 
of the main menu items, it will take 

Type A plug 

Connect to logger USB port 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type B plug  

Connect to PC USB port 
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you to the sub menu options. 

The Scroll button  has two 
functionalities: 

When the unit is off, pressing this 
button will power the unit on.  

Scrolls through the menu options. 

7.8. Operating the DBSA710 and DBSA720  

This section explains how to operate the DBSA710 and DBSA720 loggers and 
provides an overview of the menu options on the units’ LCD screen. 

7.8.1. Turning on the Unit 

In order to view the logger menu options, the unit must be powered on by pressing 

the Scroll button  on the keypad. Ensure the logger is charged or connected to 
the AC adapter. 

Once the unit is switched on it will emit a short beep and the screen will display a 
welcome message:  

 

7.8.2. Display Shutdown 

If the logger screen is inactive for thirty seconds it will turn off. However the logger 
will continue to operate in the background. Press the Scroll button to enable the LCD 
screen again. The screen will not turn off during firmware upgrade. 

7.8.3. Main Menu Options 

There are three menu categories on the data logger: 

 View Data  

 Status 

 Min/Max Values 

Note: If the unit is not in Run mode only the Status menu options will be available.  

 

Press the Menu  button to reach the main menu display. Scroll through the 
main menu options (View Data, Status and Min/Max Values) using the Scroll button. 
Once you reach the main menu option you need, press Enter to select that option 
and enter the sub menus. 

 

DaqLink DBSA710 
Ready 
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View Data Menu  

 

 

Note: View Data is the default page when the unit is running.  

If there is more than one sensor running, the screen will auto scroll between the 
sensors showing the sensor name and senor value. These are real-time displays. 

The display will switch back to the View Data screen after five minutes if none of 
logger buttons have been pressed.  

If the sensor breached any of the predefined alarm levels, then the alarm symbol will 
be displayed alongside the data reading.  

For example: 

 

The logger display alarm symbols are: 

 AL-HI : Alarm High 

 AL-Lo : Alarm Low 

 AL-P-H : Pre Alarm High 

 AL-P-L : Pre Alarm Low 

 

Status Menu 

 

The Status menu contains the following sub menus, all reachable by using the Scroll 
button.  

The sub menus are outlined below in the order in which they appear on the logger 
display. 

 

Name and Status 

As explained previously, the unit name (or Comment) is displayed on the first row 
and the second row indicates the logger status.  

If the logger is running, then the following screen is displayed. 

 

 

Batt Level (battery level) 

If the power adapter is not connected the battery percentage will be displayed. 

If the power adapter is connected External power will be displayed.  
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Logger Version  

This menu informs the user of the logger firmware version. This is helpful when you 
need to upgrade the system firmware, to check the current version. Or when 
contacting fourtec technical support, with any technical issues. 

 

The firmware version is commonly referred to by the numbers in bold in the screen 
above. For example, the firmware version which is supported by this user guide is 
v1.98.  

S/N 

This menu displays the unit’s eight digit SN. 

 

 

Memory Mode 

There are two possible device modes: 

 Stop when full – when the logger memory is full the logger will stop logging. 

 Cyclic mode – for continuous logging. The logger will continue to log once the 
memory is full by writing over the first recorded samples.  

The memory mode is toggled in the Setup dialog, using the Cyclic Mode checkbox. 

 

When the logger memory is full, the LCD will display Memory Full. 

 

Press Menu to pause logger (when logger is in Run mode) 

By pressing the Menu button, the logger will cease to log data until the Menu button 
is pressed again from the same screen.  

When in Paused mode, the user can still scroll through the logger menu screens and 
use other features. The user must scroll back to the Pause Logger menu in order to 
resume the logger operation. 

 

Reset Unit  

When the unit is reset, upon start up it will automatically reconnect to the DataSuite 
software if a USB connection is established. In addition, if the logger will continue to 
operate according to its last set up instruction. For example, if the logger was in Run 
mode, then after reset it will continue to run and record data. 
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Turn Off Unit / Stop and turn off 

Selecting this option will shut the unit down. You can turn the unit on again by 
pressing the Scroll button.  

If the logger is in Run mode, selecting this option will first stop the logger, and then 
turn it off.  

It is recommended to turn off the unit when it is not in use. 

 

Min/Max Values Menu  

Each sensor’s minimum/maximum readings (taken from the current logging session) 
will be displayed on two rows.  

The first row indicates the sensor type, along with the measurement units e.g. V, and 
the alarm indication if there is an active alarm on this sensor. 

The second row indicates the minimum and maximum measured value and the units. 
H and L represent High and Low values, respectively. 

 

7.8.4.  Additional Logger Screens 

Loading Firmware  

When updating the firmware of the data logger via the software’s Firmware Update 
Center, the logger screen will display the update progress. When complete the main 
logger status screen will be displayed.  

Also refer to ‎Chapter 15: Updating DataSuite Software and Firmware. 

 

Note: Logger must be in Stop mode before firmware can be updated. 

Loading firmware  
Progress: 55% 
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Chapter 8:  
MicroLite Overview 

This chapter provides a general overview of the MicroLite I and II data loggers.  

8.1. MicroLite Introduction 

The MicroLite I and II are compact 16-bit USB data loggers designed for accurate 
monitoring of various parameters for a wide range of applications. Typical 
applications include cold chain management, transportation as well as warehousing 
of food, drugs and hi-tech equipment. 

There are two generations of MicroLite data loggers: 

 First generation MicroLite I for Temperature monitoring supported by both the 
DataSuite and MicroLab Lite software (refer to separate MicroLab Lite user guide 
for using MicroLite I with this software)  

 Second generation MicroLite II for Voltage, Current, Temperature and Humidity 
monitoring supported by the DataSuite software. The MicroLite II models have 
enhanced functionality compared to the MicroLite I models. 

 

Key MicroLite benefits include: 

 High functionality low cost multi-trip logger for an unbroken cold chain 

 USB 2.0 interface for fast track communication and firmware updates 

 Unique Boomerang feature that automatically creates and emails PDF data report 
when logger is connected to PC * 

 Rapid data download to Graph, Table view and Excel spreadsheet 

 Online, real-time data streaming to the DataSuite software * 

 Built-in LCD with decimal point readings and LED sampling indicator 

 High accuracy sensors with 16-bit resolution 

 Up to 32,000 sample memory accommodating long-haul transports 

 Reed switch using magnet key to mark time stamps*, activate and stop logging* 

 Up to 2-year battery life 

 Built-in real-time clock and calendar 

 Dust and water proof 

 Cradle wall mounting for fixed monitoring 

 

* MicroLite II models only 

8.2. The MicroLite Packaging  

 MicroLite I – Shipped in a plastic blister containing one MicroLite data logger and 
one small magnet accessory (located in the placeholder on the MicroLite 
packaging).  

 MicroLite II – Shipped in a carton containing:  
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 MicroLite II data logger and attached cradle wall mounting 

 Nylon bag containing magnet key accessory , screws and screw anchors and 
zip ties (for external input models) 

 

Each logger packaging includes a quick start guide to help first-time users get set up. 

 

In order to save battery life, the MicroLite’s are shipped in Stop mode. This means 
that before you can start recording, you must first connect the logger to the computer 
and set it up using the DataSuite software.  

8.2.1. The Data Logger  

The MicroLite I family includes two internal Temperature sensor models:  

LITE5008 and LITE5016 (8K or 16K sample memory models) 

 

The MicroLite II family includes six models:  

 LITE5008P and LITE5032P: MicroLite II Internal Temperature (8K or 32K sample 
memory models) 

 LITE5032P-RH: MicroLite II Internal Temperature/RH 

 LITE5032P-4/20: MicroLite II External 4-20 mA 

 LITE5032P-V: MicroLite II External 0-10 V 

 LITE5032P-EXT: MicroLite II External NTC Temperature 

 

The MicroLite LCD screen continuously displays the most recent samples, and users 
can also define minimum and maximum alarm levels via the software for a specific 
shipment, for example. The LCD screen will also show alarm icons if either level is 
breached. 

The accompanying magnet key is used to activate and stop the device, and mark a 
time stamp. 

Note: Stop and Time Stamp functionality is available for MicroLite II only 

 

The data stored by the MicroLite II can be downloaded to any computer with 
DataSuite installed, for further viewing and analysis, and can also be exported to an 
Excel spreadsheet. 

The data logger is programmed to consume as little power as possible during 
operation, in order to conserve the battery life. When not recording data the units are 
placed in sleep mode after five minutes. The LCD will shut down. The units wake up 
upon connection to USB. The logger will enter sleep mode after 5 minutes of Stop 
mode. 

The MicroLite battery is easily replaceable and can run up to two years, depending 
on the logger configuration.  
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MicroLite Data Loggers 

 

 

 

 

Part Number: LITE5032P-RH Part Number: LITE5008, LITE5008P, 
LITE5016, LITE5032P 

Two internal digital and humidity 
temperature sensors and USB interface 

One internal NTC temperature sensor and 
USB interface 

Memory Capacity: 32,000 samples 

Power supply: Battery operated 

Memory Capacity: Four models:  
MicroLite I: 8,000 and 16,000 samples 
MicroLite II: 8,000 and 32,000 samples  

Power supply: Battery operated 

 

  

Part Number: LITE5032P-4/20 Part Number: LITE5032P-V 

One 4-20 mA current input and USB interface. 
Logger cap contains universal connector for 
current sensor. When cap is removed, USB 
interface is available. 

One 0-10 V voltage input and USB interface. 
Logger cap contains universal connector for 
voltage sensor. When cap is removed, USB 
interface is available. 

Memory Capacity: 32,000 samples 

Power supply: Battery operated 

Memory Capacity: 32,000 samples 

Power supply: Battery operated 
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Part Number: LITE5032P-EXT 

One NTC -50 to 150 C temperature input and 
USB interface. Logger cap contains universal 
connector for temperature sensor. When cap is 
removed, USB interface is available. 

Sensor is included. 

Memory Capacity: 32,000 samples 

Power supply: Battery operated 

8.2.2. Hardware Accessories 

The only accessory required for the MicroLite system is the magnet key, to stop and 
activate the logger as well as to mark time stamps. 
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Chapter 9:  
MicroLite Implementation Guide  

fourtec recommends first time users of the MicroLite system read this chapter before 
drilling down into the many features of the system described later in the user guide. 
The Implementation Guide will give you a clear understanding of the basic aspects of 
setting up the system, and getting the data logger up and running.  

9.1. Pre-setup Requirements 

Prior to commencing with the MicroLite implementation you must have the following 
requirements in place: 

PC 

 24/7 availability, if online data monitoring is required 

 Reliable AC power 

 Sufficient hard disk space to store loggers’ data 

 One free USB port 

 

MicroLite devices 

At least one MicroLite logger. 

9.2. Launching the Software 

1. Install the DataSuite software on the PC workstation. Refer to section ‎14.1: 
Installing DataSuite Software on page 129 for more details. 

2. Once the software and associated components have been installed, launch 

DataSuite from your DataSuite desktop shortcut  

3. The main DataSuite window is launched. The default view is called Map View. 

 

Figure 44: Main DataSuite window 

4. Check for DataSuite updates. Go to Help > Check for Updates from the 
DataSuite main menu to check for newer versions of the MicroLite module 
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software and firmware released since you purchased your system. For more 
details on the Update feature go to ‎Chapter 15: Updating DataSuite Software and 
Firmware. 

9.3. Connecting the Logger 

Note: Multiple MicroLite loggers may be detected by the PC at a time.  

1. Only once the DataSuite software has been installed, connect the MicroLite data 
logger via the USB interface.  

2. Assuming this is the first time the logger is used following purchase, it will be in 
deep sleep mode. When connected to the PC, the logger will automatically turn 
on.  

3. When turned on the LCD will display Hello followed by the firmware version and 
finally, Stop. 

4. When first detected by the DataSuite software, the logger icon will appear in the 
Map View. If the logger icon does not appear, from the DataSuite main menu, go 
to Devices > Detect Device.  

 

Figure 45: Adding data logger icon to Map View 

Note: If the logger is not recognized by the software try connecting the logger to 
another USB port on the PC. Ensure the unit is turned on and select Devices > 
Detect Device again in the main menu. 

5. Should you disconnect the logger’s USB cable the logger icon will be grayed out:

. 

Note: You can move the logger icon elsewhere on the screen by going to Tools > 
Lock Map View and unselecting this option. 

9.4. Loading Map View Background 

Load an image into the DataSuite software showing a map of your facility in order to 
place the Logger icons in their relative positions. As you deploy more standalone 
loggers, this will prove very helpful.  

 Double click the Map View background to browse to the image directory and load 
the image. Remember to unlock the Map View in order to move the icons around. 

 Right-click the Map View background and two options will be available: Load 
Wallpaper and Reset Wallpaper, which resets to the default fourtec wallpaper. 
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9.5. Configuring the Logger 

Once the software has detected the MicroLite logger, you must configure the unit in 
order to start acquiring data. The configuration parameters of the MicroLite I and II 
loggers differ. Refer to the relevant section below. 

9.5.1. MicroLite I Configuration 

1. Right-click on the Logger icon. Select Setup from the context menu. 

2. The Setup window will be launched. 

 

Figure 46: MicroLite I Logger Setup window 

 

This dialog provides non-editable information such as the serial number, battery 
level, model number and firmware version of the current unit.  

On the Properties and Sensors tabs, the user is able to configure the following 
parameters:  

 Unit's comment  

 Sampling rate  

 Averaging points 

 Alarm levels  

 Alarm delay  

3. In the Properties tab: 

a. Select the memory mode: Cyclic or non-Cyclic 
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b. Select the activation mode: Push to Run, Timer Run or leave the checkboxes 
unmarked for immediate activation. 

c. Select the sampling rate anywhere from 1 every second to 1 every 18 hours. 
Refer to the Recording Time to ensure the logger won’t stop or begin cyclic 
recording before the end of your specific measurement session.  

4. In the Sensors tab: 

a. The Temperature sensor must always be selected. 

b. If you require alarm levels, select the relevant checkboxes and enter the 
specific threshold values.  

5. From any of the tabs, click Setup and Run to begin logging or Setup if you wish 
to run the logger later.  

6. The Logger icon will appear as follows when in Run mode:  

7. To stop the logger, right-click the Logger icon and select Stop from the context 
menu.  

Note: Running the logger clears the logger memory. All previously recorded data will 
be erased when you begin a new logging session. 

9.5.2. MicroLite II Configuration 

1. Right-click on the Logger icon. Select Setup from the context menu. 

2. The Setup window will be launched. 

 

Figure 47: MicroLite II Logger Setup window 
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This dialog provides non-editable information such as the serial number, battery 
level, model number and firmware version of the current unit.  

On the Properties and Sensors tabs, the user is able to configure the following 
parameters:  

 Unit's comment  

 Sampling rate  

 Activation and memory modes 

 Averaging points 

 Temperature units °C/°F (on the logger LCD) 

 Active sensors  

 Alarm levels  

 Alarm delay  

3. In the Properties tab: 

a. Select the memory mode: Cyclic or non-Cyclic 

b. Select the activation mode: Push to Run, Timer Run or leave the checkboxes 
unmarked for immediate activation. 

c. If you want the ability to stop the logger during operation, select the ‘Stop on 
key press’ checkbox. 

d. For external input models, if you want the logger to stop recording data when 
the cap is removed, select the ‘Stop on sensor disconnect’ checkbox.  

e. Select the sampling rate anywhere from 1 every second to 1 every 18 hours. 
Refer to the Recording Time to ensure the logger won’t stop or begin cyclic 
recording before the end of your specific measurement session.  

4. In the Sensors tab: 

a. For the Temp/RH model, select the sensors you wish to activate during the 
current logging session. All other models feature just one sensor, and at least 
one sensor must always be selected. 

b. If you require alarm levels, select the relevant checkboxes and enter the 
specific threshold values.  

5. In the Display tab: 

a. Select the appropriate option for the LCD screen. If you wish to conserve 
battery life, and do not require a permanent visual data display, select the 
options to turn on the LCD screen only for alarms or button press.  

6. In the Boomerang Report tab: 

a. Enable the Boomerang feature via this tab. Enter contacts to receive the data 
report via email when logger is connected to another computer with DataSuite 
installed. Refer to section ‎14.25 for more details. 

7. From any of the tabs, click Setup and Run to begin logging or Setup if you wish 
to run the logger later.  

8. The Logger icon will appear as follows when in Run mode:  

9. For the external input logger models, the logger LCD will display NC (No Cap) 
when placed in Run mode. This is because the logger won’t actually begin 
recording data until the logger cap is closed on the logger body (to connect the 
logger to the USB the cap must first be removed). Therefore, ensure that the cap 
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is connected to an external sensor before closing it on the logger to avoid 
erroneous data.  

10. To stop the logger, right-click the Logger icon and select Stop from the context 
menu. Or use the magnet key if you previously enabled the ‘Stop on key press’ 
option. 

Note: Running the logger clears the logger memory. All previously recorded data will 
be erased when you begin a new logging session. 

9.6. Viewing Data  

Once you run the logger, you have several ways of viewing the online data that is 
being acquired. 

 Online graph/table/statistics views 

 Logger icon tooltip 

 Sensor view 

9.6.1. Online Data Views 

Note: Only the MicroLite models featuring internal sensors (Temp and Temp/RH) 

support online data view.  

Double clicking the Logger icon or selecting Display Data in the Logger icon context 
menu will open the online graph. 

This graph is updated in real-time with the newly recorded data. 

You can switch between Graph, Table and Statistics views to view the data in 
different formats.  

      

Figure 48: Online data – Graph view 
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Figure 49: Online data – Table view 

 

 

Figure 50: Online data – Statistics view  

9.6.2. Logger Tooltip 

Close the online data window and return to Map View. Scroll over the Logger icon 
and you will see a tooltip displaying the relevant logger information, including real-
time data.  

 

Figure 51: Logger tooltip 

This tool-tip is updated with every newly recorded sample. 

9.6.3. Sensor View 

Click the Sensor View icon  in the tool bar to switch to this view. Here, you can 
monitor the data by viewing data display of each individual sensor, rather than of 
each logger. 
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Figure 52: Sensor view 

 

 If the sensor is in alarm, the sensor box will change color from green to red (just 
as the Logger icon would). 

 Double-clicking the individual sensor box will open the data in the online Graph 
view. 

9.7. Downloading Data  

If the logger is being used as a standalone device you will have to connect it to the 
computer via USB in order to download the data to the software. 

1. Connect logger to PC and go to Devices > Detect Device in the main menu. 

2. Data download should begin automatically. To manually download data right-click 
the logger icon and select Download Data. 

3. View the downloaded data by double-clicking the logger icon. 
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Chapter 10:  
MicroLite Hardware Overview 

This chapter details the hardware features of the MicroLite data loggers.  

10.1. Data Logger Layout 

Front LCD View (Temp/RH model)

 

 

 

Rear View (Temp/RH model) 
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External Cap View

 

 

LCD screen 

Displays logger status, logger data, alarm level, and engineering units. 

LED 

Blue LED Indicates activation, logging and alarm status 

Magnet Holder 

Insert the magnet key here when performing stop, run, time stamp 
functionality.  

Battery Holder 

Location of replaceable battery compartment 

External Input Cap 

Special cap interfacing the external sensor to the logger’s USB connector.  

10.2. LCD Screen Overview 

The MicroLite has a 3-digit (with one decimal place) 7-segment LCD screen, which is 
able to display the following information: 

 The temperature reading currently recorded 

 If logger is in Stop, Timer Run or Push to Run modes 

 Low or High alarm indication 

 Min/Max readings * 

 Alarm duration * 

 Full logger memory status 

 Marking of a Time Stamp** 

 External Cap is not connected (external input models only) ** 

 Low battery warning  

 

* MicroLite I only 

** MicroLite II only 

External 

input cap

External input cap 

with universal 

connector
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10.2.1. LCD Status Messages  

 USB – Indicates that the logger is connected to the PC via USB  

 Stop -  The logger is currently in Stop mode, not sampling data  

 Run – Visible immediately before the logger is about to start sampling data, once 
the Run command was sent. 

 Push – Indicates the logger is in Push to Run mode, as configured in the logger 
Setup window.  

 tRUN - Indicates the logger is in Timer Run mode, as configured in the logger 
Setup window.  

 F – Indicates the MicroLite Firmware version e.g. 00.83 * 

 T01, T02, etc. – Indicates that a time stamp has been taken * 

 FULL – Indicates that the logger memory has reached full capacity and the 
logger has stopped  

 NC – Indicates that no cap is currently connected to the logger and is relevant for 
the external input models only (Current, Voltage, and Temperature). The logger 
will only start running when the cap is connected to avoid sampling of data before 
the external sensor is connected.* 

 Lo Batt – Indicates the battery level is low and the battery should be replaced 

 

* MicroLite II only 

10.2.2. LCD Mode of Operation  

For the MicroLite II only, in the Display tab in the logger Setup window the user has 
the option to define several modes of operation for the LCD screen when sampling. 

 Always On: The LCD will never turn off 

 LCD is off, and will turn on for 30, 60 or 120 seconds upon alarm state or magnet 
key operation 

 

In addition, when the logger is not sampling (in Stop mode) the LCD will shut down 
after two minutes of inactivity in order to conserve battery life. 

10.3. MicroLite Sensor Overview 

This section provides an overview of the sensor specifications of the MicroLite data 
loggers.  

10.3.1. Internal Sensor Types 

Sensor Measurement 
Range 

Accuracy Logger Model 

Digital Humidity  5% to 95% ±2% LITE5032P-RH 

Digital 
Temperature  

-40 ºC to 80 ºC ±0.3 ºC LITE5032P-RH 



 

108 

Sensor Measurement 
Range 

Accuracy Logger Model 

Temperature 
NTC 

-40 ºC to 80 ºC ±0.3 ºC  

LITE5008 

LITE5008P 

LITE5016 

LITE5032P 

10.3.2. External Sensor Types 

Sensor Measurement 
Range 

Accuracy Logger Model 

Current  4 to 20 mA ±0.5% LITE5032P-RH 

Voltage  0 to 10 V 
±0.5% LITE5032P-RH 

Temperature 
NTC 10K Probe 

-50 to 150 ºC -50 to 60 °C  

± 0.3 °C 

 
60 to 150 °C  

± 0.5% 

LITE5032-EXT 

10.3.3. User Defined Sensors 

DataSuite software provides a simple and straightforward tool for defining a limited 
number of custom sensors. Almost any sensor or transducer with 0 to 10 V or 4 to 20 
mA output is accepted by the MicroLite II Current and Voltage loggers’ universal 
connectors. Electrical units are automatically scaled to meaningful user-defined 
engineering units. 

The sensor definitions are stored in the logger’s memory and are added to the 
sensors list in the Setup window.  

The logger LCD supports the following units for user-defined sensors: mA, V, °C, °F, 
PSI, BAR, PH, and PPM. 

All types of user-defined engineering units are displayed in the DataSuite software.  

Refer to section ‎14.8.1 for more details.  

10.3.4. Sensor Calibration 

The MicroLite data loggers are shipped fully calibrated. However, further calibration 
can be applied via the DataSuite software. The calibration parameters are sent to the 
data loggers via USB connection and stored in the logger’s memory. Refer to section 
‎14.19.4 for more details. 

10.4. Unit Serial Number and Comment 

Every MicroLite data logger unit is embedded with a unique serial number.  

The data logger only can be loaded with a descriptive comment to identify its task 
and location. You may add or edit the logger comment via the DataSuite software.  
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Every time data is transferred to the computer it is labeled both with the logger’s 
serial number and comment and is displayed in the graph or data table view. 

The unit serial number is also marked on a sticker below the unit’s USB connector.  

10.5. MicroLite Battery 

The MicroLite data loggers run from one internal, replaceable CR2032 3V lithium 
battery. Depending on the logger configuration, from a new battery, the data logger 
can run for up to 2 years.  

The battery maintains the logger’s Real-Time Clock (RTC). The logger’s time/date 
settings are synchronized with the PC when you perform a Setup. 

Note: When connected to the PC via USB, the logger will draw its power via the USB 

port and not via the internal battery. 

10.5.1. Battery Level 

The MicroLite battery level indication is provided in the DataSuite software Setup 
dialog. Refer to section ‎14.17.4.  

The battery’s maximum lifespan is approximately two years. This long battery life is 
achieved by the MicroLite putting itself to sleep between data recordings. While in 
sleep mode, the data logger consumes a minimal amount of power. You always have 
the option of disabling the LCD during logging, only to turn on during alarm state. 
Refer to section ‎14.17.4 for more details. 

The MicroLite will wake up for a few micro-seconds whenever it has to record a data 
sample or display new data on the LCD screen. 

10.5.2. Replacing the Battery  

Replacing the battery does not result in any data loss. In addition, the logger’s 
configuration settings are also retained.  

 

 

As shown in the figure above, the MicroLite internal lithium battery is located under a 
removable plastic cover. 

To replace the battery, simply use the groove in the plastic cover to twist the cover 
open, and pull out the battery. When twisting the cover back into position, ensure that 
the small ridge on the battery cover is in line with the similar ridge on the logger case, 
as indicated in the figure below. 

Internal 
battery 
compartment 
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Note: Be sure to twist the plastic cover properly back into a sealed position, to 

maintain the MicroLite’s dust and waterproof compliancy. 

After replacing the battery, the MicroLite LCD will be in Stop mode.  

10.6. USB Connection 

The MicroLite interfaces with the computer via any of its USB Host ports. No USB 
driver installation is required in order to be detected by the computer and by the 
DataSuite software. The software will automatically detect the device upon 
connection to the PC. 

10.7. Logger Cap for External Input Models 

The MicroLite II external input models (current, voltage, temperature) feature an 
industrial screw-to-wire interface located inside the logger cap. This enables 
connection with the logger’s USB connector making the data sampling possible. 
When the cap is not connected to the logger no sampling is possible. Hence these 
models do not support online data sampling. 

10.1. Using the MicroLite Magnet 

The MicroLite includes the magnet key accessory in the logger packaging. 

This magnet is used to activate the logger when in Push to Run mode, and for the 
MicroLite II only, stop the logger, and mark a time stamp.  

There is a reed relay on the MicroLite’s circuit board which is closed when placing 
the magnet in the magnet holder, and depending on the duration, will trigger a 
specific function.  

10.2. Operating the MicroLite  

This section explains how to operate the MicroLite loggers and provides an overview 
of the logger functionality. The MicroLite II contains enhanced functionality compared 
to the MicroLite I. 

10.2.1. MicroLite Working Modes 

MicroLite is always set in one of five possible working modes. These modes are all 
activated via the DataSuite software or using the magnet key. 

 

Ensure ridge on 
cover and on 
logger case are in 
line 
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Stop 

MicroLite is idle and is not recording. When stopping, the logger it immediately 
ceases to record data, instead displaying STOP on the LCD.  

For MicroLite II only, to stop the logger directly from the unit, select the Turn off on 
key press option in the logger Setup window in DataSuite. While the logger is 
running, place the magnet key in the magnet holder for at least 15 seconds. The 
logger will then stop sampling. A time stamp will also be recorded for this event and 
the T indication will display for 2 seconds. The LCD will then display STOP. 

Run 

MicroLite is recording data. It will stop recording automatically when its memory has 
reached full capacity (8,000, 16,000 or 32,000 samples depending on the model). 
When full the LCD displays FULL. 

Cyclic Run 

Similar to Run mode, but MicroLite will continuously sample data, recording over old 
data when the memory reaches its capacity, beginning with the earliest data 
recording. Cyclic Run mode must be selected from the logger Setup window in 
DataSuite. 

Timer Run  

MicroLite can be configured to start recording at a predetermined time. When 
MicroLite is set for such a run, its status is set to Timer Run. The logger LCD displays 
tRUN. 

Push to Run  

MicroLite will only begin logging data when the user operates the logger’s reed 
switch with the MicroLite magnet key. The logger LCD displays PUSH.  

10.2.2. Turning on the Unit 

To turn on the unit from sleep mode (the LCD and LED are both off) simply connect 
the logger to the PC’s USB port, or place the magnet key in the magnet holder (for 
MicroLite II only). 

10.2.3. Viewing Real-time Data on LCD   

When the MicroLite is sampling data the readings from the sensor are displayed on 
the LCD (alternately, if more than one sensor) followed by the relevant unit e.g. C, F, 
mA or V.  

10.2.4. Viewing Firmware Version  

For the MicroLite II only, when the logger is in Stop or Run mode placing the magnet 
key in the magnet holder for at least 5 seconds will display the device’s current 
firmware version. After two seconds the logger will take a time stamp and then three 
seconds later F will be displayed, with the firmware version shown in the following 
screen e.g. 00.83. 

The firmware version can also be seen in the logger Setup window in DataSuite. 
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10.2.5. Sensor Alarm Levels 

Via the software, users can define minimum and maximum alarm levels for each 
input individually. The MicroLite logger display indicates when any alarm level is 
exceeded.  

Note: When the MicroLite is in Cyclic mode, the Low or High alarm level displayed 
represents the lowest or highest readings recorded since the logger starting logging 

data, irrelevant of how many cycles the logger has recorded.  

 

AL-L – A sensor’s reading is lower than its low alarm level. 

AL-H – A sensor’s reading is higher than its high alarm level. 

The alarm notification remains until the next time you change the logger setup or run 
a new recording session. 

10.2.1. Alarm Duration 

The MicroLite I calculates the duration of an existing alarm and displays it on the 
logger’s LCD. The calculation is made in hours and is indicated on the LCD as H.  

For example, the shortest possible duration of 0.01H means the logger has been in 
alarm for between 0 and 36 seconds.  

A duration of 1.55H means the logger has been in alarm for 93 minutes (1.55 hours). 

If the MicroLite is in a Low and High alarm simultaneously, then it will show the 
duration for both alarms.  

Even if the logger is not currently in alarm state, the duration will still be displayed if 
an alarm previously occurred.  

10.2.2. Marking Time Stamps 

For the MicroLite II only, while the logger is running, placing the magnet key in the 
magnet holder for at least 2 seconds will record a new sample with a time stamp on 
the logger memory.  

Each time stamp can mark a specific event such as the logger has reached its 
destination, if used during to record temperature during product transportation. 

The time stamp is visible both in the DataSuite data graph and table, and the user 
can enter a comment in the table describing the event.  

There is capacity for a maximum of 99 time stamps in the logger memory. When the 
memory is full, the LCD will display FULL when you attempt to mark another time 
stamp. To reset the Time Stamp memory, perform a new logger setup. 

10.2.3. LED Indications 

The MicroLite features a LED primarily to give real-time indication of activation and 
sampling. 

 Connected to USB – The LED will permanently indicate blue as long as the unit 
is connected to the computer via USB and in Stop mode.  

 Normal sampling – The LED will flash blue with each recorded sample, as long 
as the logger is in Run mode. 
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 Marking a time stamp – The LED will blink blue when a time stamp is marked, 
as it is recording a new sample to the logger memory. 
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Chapter 11:  
MicroLogPRO II Overview 

This chapter provides a general overview of the MicroLogPRO II data loggers.  

11.1. MicroLogPRO II Introduction 

Standalone, Portable, Temperature and Humidity Loggers 

Replacing the now discontinued MicroLogPRO EC7XX series, the MicroLogPRO II is 
the latest addition to the established MicroLog line of data loggers. Following in the 
footsteps of the MicroLog and MicroLogPRO, the MicroLogPRO II offers excellent 
value with an updated mechanical design, enhanced software and hardware 
functionality.  

These loggers are used to monitor temperature and humidity in a variety of 
applications, such as perishable goods and controlled environments. Each logger 
can also be connected to external sensors in order to monitor additional parameters 
such as voltage and current.  

 

Key MicroLogPRO II benefits include: 

 High accuracy Temperature, Humidity and Dew Point measurement  

 External sensor input supporting Current, Voltage, Temperature and pH readings 

 Large memory with 52K sample capacity 

 4-digit LCD screen and bi-color LED for alarm indication 

 Two-button keypad for Start/Stop activation and marking time stamps 

 USB communication with PC for setup, data download and updates 

 Low power consumption with 2-year battery life  

 Supported by feature-rich DataSuite software with online alarm capabilities 

11.2. The MicroLogPRO II System  

The basic MicroLogPRO II system contains at least one of the following units: 

 MicroLogPRO data logger – Part Number EC800 or EC850 

 Mini-USB communication cable  

 DataSuite software CD containing user guide 

11.2.1. The Data Logger  

There are two data logger models in the MicroLogPRO II system.  

 EC800: Internal NTC Temperature sensor + one external input 

 EC850: Internal Digital Temperature and Humidity sensors + one external input 

 

The MicroLogPRO II can be used as a standalone device to monitor temperature and 
humidity levels. It can also be connected via USB cable to the PC for online, real-
time data streaming to the DataSuite software.  
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MicroLogPRO II continuously displays the most recent samples, along with the 
maximum and minimum values for a selected time interval. Users can also define 
minimum and maximum alarm levels via the software for a specific shipment, for 
example, and the LCD screen will show alarm icons if either level is breached. 

The logger two-button keypad is used to activate and stop the device, mark a time 
stamp, and display min/max values. 

The data stored by MicroLogPRO II can be downloaded to any computer with 
DataSuite installed, for further viewing and analysis, and can also be exported to an 
Excel spreadsheet. 

 

The data logger is programmed to consume as little power as possible during 
operation, in order to conserve the battery life. When not recording data the units are 
placed in deep sleep mode and they wake up upon key press.  

The battery for the EC800 and EC850 is easily replaceable and can run up to two 
years, depending on the logger configuration.  

Note: Battery life depends on the logger sampling rate, type of sensor, and number 

of measured sensors. 

MicroLogPRO II Data Loggers 

 

 

Part Number: EC800 Part Number: EC850 

One internal NTC temperature sensor 
with external input and USB PC 
interface 

Two internal digital and humidity 
temperature sensors with external 
input and USB PC interface 

Memory Capacity: 52,000 samples 

Power supply: Battery operated 

Memory Capacity: 52,000 samples 

Power supply: Battery operated 

11.2.2. Hardware Accessories 

The only accessory required for the MicroLogPRO II system is the mini-USB cable 
for connecting the device to the PC. 
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Chapter 12:  
MicroLogPRO II Implementation 

Guide  

fourtec recommends first time users of the MicroLogPRO II system read this chapter 
before drilling down into the many features of the system described later in the user 
guide. The Implementation Guide will give you a clear understanding of the basic 
aspects of setting up the system, and getting the data logger up and running.  

12.1. Pre-setup Requirements 

Prior to commencing with the MicroLogPRO II implementation you must have the 
following requirements in place: 

PC 

 24/7 availability, if online data monitoring is required 

 Reliable AC power 

 Sufficient hard disk space to store loggers’ data 

 One free USB port 

 

MicroLogPRO II devices 

At least one MicroLogPRO II logger EC800 or EC850. 

 

Mini-USB cable 

The mini-USB cable connects the data logger to the PC for logger configuration and 
data download (and is supplied with the DataSuite software kit). 

12.2. Launching the Software 

1. Install the DataSuite software on the PC workstation. Refer to section ‎14.1: 
Installing DataSuite Software on page 129 for more details. 

2. Once the software and associated components have been installed, launch 

DataSuite from your DataSuite desktop shortcut  

3. The main DataSuite window is launched. The default view is called Map View. 
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Figure 53: Main DataSuite window 

4. Check for DataSuite updates. Go to Help > Check for Updates from the 
DataSuite main menu to check for newer versions of the MicroLogPRO II module 
software and firmware released since you purchased your system. For more 
details on the Update feature go to ‎Chapter 15: Updating DataSuite Software and 
Firmware. 

12.3. Connecting the Logger 

Note: Multiple MicroLogPRO II loggers may be detected by the PC at a time.  

1. Only once the DataSuite software has been installed, connect the MicroLogPRO 
II data logger to the mini-USB cable. Connect this cable to the computer. 

2. Assuming this is the first time the logger is used following purchase, it will be in 
deep sleep mode. When connected to the PC, the logger will automatically turn 
on.  

To turn on the logger when disconnected from the PC, press the Min/Max Hours 

button  on the front keypad. 

3. When turned on the LCD will display Hello followed by the logger model part 
number, firmware version and finally, Stop. 

4. When first detected by the DataSuite software, the logger icon will appear in the 
Map View. If the logger icon does not appear, from the DataSuite main menu, go 
to Devices > Detect Device.  

 

Figure 54: Adding data logger icon to Map View 
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Note: If the logger is not recognized by the software try connecting the mini-USB 
cable to another USB port on the PC. Ensure the unit is turned on and select 

Devices > Detect Device again in the main menu. 

5. Should you disconnect the logger’s USB cable the logger icon will be grayed out: 

. 

Note: You can move the logger icon elsewhere on the screen by going to Tools > 
Lock Map View and unselecting this option. 

12.4. Loading Map View Background 

Load an image into the DataSuite software showing a map of your facility in order to 
place the Logger icons in their relative positions. As you deploy more standalone 
loggers, this will prove very helpful.  

 Double click the Map View background to browse to the image directory and load 
the image. Remember to unlock the Map View in order to move the icons around. 

 Right-click the Map View background and two options will be available: Load 
Wallpaper and Reset Wallpaper, which resets to the default fourtec wallpaper. 

12.5. Configuring the Logger 

Once the software has detected the MicroLogPRO II logger, you must configure the 
unit in order to start acquiring data. 

1. Right-click on the Logger icon. Select Setup from the context menu. 

2. The Setup window will be launched. 

 

Figure 55: MicroLogPRO II Logger Setup window 

 

This dialog provides non-editable information such as the serial number, battery 
level, model number and firmware version of the current unit.  
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On the Properties and Sensors tabs, the user is able to configure the following 
parameters:  

 Unit's comment  

 Sampling rate  

 Activation and memory modes 

 Averaging points 

 Temperature units °C/°F (on the logger LCD) 

 Active sensors  

 Alarm levels  

 Alarm delay  

3. In the Properties tab: 

a. Select the memory mode: Cyclic or non-Cyclic 

b. Select the activation mode: Push to Run, Timer Run or leave the checkboxes 
unmarked for immediate activation. 

c. If you want the ability to stop the logger during operation, select the ‘Stop on 
key press’ option. 

d. Select the sampling rate anywhere from 1 every second to 1 every 18 hours. 
Refer to the Recording Time to ensure the logger won’t stop or begin cyclic 
recording before the end of your specific measurement session.  

4. In the Sensors tab: 

a. Select the internal and external sensors you wish to activate during the 
current logging session.  

b. If you require alarm levels, select the relevant checkboxes and enter the 
specific threshold values.  

5. In the Display tab: 

a. Select the appropriate option for the LCD screen. If you wish to conserve 
battery life, and do not require a permanent visual data display, select the 
options to turn on the LCD screen only for alarms or button press.  

6. From any of the tabs, click Setup and Run to begin logging or Setup if you wish 
to run the logger later.  

7. The Logger icon will appear as follows when in Run mode: . 

8. To stop the logger, right-click the Logger icon and select Stop from the context 
menu. 

Note: Running the logger clears the logger memory. All previously recorded data will 
be erased when you begin a new logging session. 

12.6. Viewing Data  

Once you run the logger, you have several ways of viewing the online data that is 
being acquired. 

 Online graph/table/statistics views 

 Logger icon tooltip 

 Sensor view 
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12.6.1. Online Data Views 

Double clicking the Logger icon or selecting Display Data in the Logger icon context 
menu will open the online graph. 

This graph is updated in real-time with the newly recorded data. 

You can switch between Graph, Table and Statistics views to view the data in 
different formats.  

      

Figure 56: Online data – Graph view 

 

Figure 57: Online data – Table view 

 

 

Figure 58: Online data – Statistics view  

12.6.2. Logger Tooltip 

Close the online data window and return to Map View. Scroll over the Logger icon 
and you will see a tooltip displaying the relevant logger information, including real-
time data.  
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Figure 59: Logger tooltip 

This tool-tip is updated with every newly recorded sample. 

12.6.3. Sensor View 

Click the Sensor View icon  in the tool bar to switch to this view. Here, you can 
monitor the data by viewing data display of each individual sensor, rather than of 
each logger. 

 

Figure 60: Sensor view 

 

 If the sensor is in alarm, the sensor box will change color from green to red (just 
as the Logger icon would). 

 Double-clicking the individual sensor box will open the data in the online Graph 
view. 

12.7. Downloading Data  

If the logger is being used as a standalone device you will have to connect it to the 
computer via USB cable in order to download the data to the software. 

1. Connect logger to PC and go to Devices > Detect Device in the main menu. 

2. Data download should begin automatically. To manually download data right-click 
the logger icon and select Download Data. 

View the downloaded data by double-clicking the logger icon. 
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Chapter 13:  
MicroLogPRO II Hardware Overview 

This chapter details the hardware features of the MicroLogPRO II data loggers.  

13.1. Data Logger Front Panel Layout 

 

Figure 61:  EC850 data logger front panel 

LCD screen 

Displays logger status, logger data, alarm level, Min/Max values and 
engineering units. 

LED 

Green and red LED Indicates activation, logging and alarm status 

Min/Max Hours button 

Use to view Min/Max values going back 24 hours. Also used to wake up 
logger from sleep mode. 

Min/Max Days button 

Use to view Min/Max values going back 30 days. Also used together with 
Min/Max Hours button to perform other logger functionality. 

Bi-color 

LED

Min/Max Hours button

LCD screen

Min/Max 

Days button

Cradle for wall 

mounting

RH/Temp sensor 

location

Bi-color 

LED

Min/Max Hours button

LCD screen

Min/Max 

Days button

Cradle for wall 

mounting

RH/Temp sensor 

location
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13.2. Data Logger External Connections 

External connections of the EC800 and EC850 are exactly the same. 

   

Figure 62:  EC800 and EC850 external connections 

 

Mini USB Port 

To enable communication between logger and PC, for configuration and 
data download. 

Sensor Inputs 

3-pin socket supporting range of MicroLogPRO II external sensor 
adapters and probes  

Note: The MicroLogPRO II ships with a rubber plug that covers each of 
the external sockets. The plug protects the sockets from moisture and 
dust. Unless you are using the sockets, leave the plugs in. 

13.3. Data Logger Sensor Overview 

This section provides an overview of the hardware specifications of the 
MicroLogPRO II data loggers.  

13.3.1. Internal Sensor Types 

The EC800 and EC850 loggers include internal sensors, depending on the logger 
model. 

 

Sensor Measurement 
Range 

Accuracy Logger 
Model 

Digital Humidity  5% to 95% ±2% EC850 

Digital 
Temperature  

-40 ºC to 80 ºC ±0.2 ºC EC850 

Temperature 
NTC 

-40 ºC to 80 ºC ±0.2 ºC  EC800 

Mini-USB 

External sensor 

input

Mini-USB 

External sensor 

input
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13.3.2. External Sensor Types 

The EC800 and EC850 each has one external input, for connection to a range of 
adapters and probes.  

Adapter/Probe Measurement 
Range 

Current Adapter 4 to 20 mA 

Voltage Adapter 0 to 10 V 

Temperature NTC 10K Probe -50 to 110 ºC 

Temperature PT100 (2-wire) Adapter -200 to 400 ºC 

pH Adapter 1 to 14 pH 

13.3.3. User Defined Sensors 

DataSuite software provides a simple and straightforward tool for defining a limited 
number of custom sensors. Almost any sensor or transducer with 0 to 10 V or 4 to 20 
mA output is accepted by the MicroLogPRO II loggers, using the appropriate adapter. 
Electrical units are automatically scaled to meaningful user-defined engineering units. 

The sensor definitions are stored in the logger’s memory and are added to the 
sensors list in the Setup window.  

The logger LCD supports the following units for user-defined sensors: PSI, bAr, PH, 
mS, and PPm. 

All types of user-defined units are displayed in the DataSuite software.  

Refer to section ‎14.8.1 for more details.  

13.3.4. Sensor Alarms 

Via the software, users can define minimum and maximum alarm levels for each 
input individually. The MicroLogPRO II logger display indicates when the sensor 
reading is in alarm of any type. The symbols AL-H and AL-L are used in addition to 
the LED alarm indicator.  

13.3.5. Sensor Calibration 

The MicroLogPRO II data logger is shipped fully calibrated. However, further 
calibration can be applied via the DataSuite software. The calibration parameters are 
sent to the data loggers via USB connection and stored in the logger’s memory. 
Refer to section ‎14.19.4 for more details. 

13.4. Unit Serial Number and Comment 

Every MicroLogPRO II data logger unit is embedded with a unique serial number.  

The data logger only can be loaded with a descriptive comment to identify its task 
and location. You may add or edit the logger comment via the DataSuite software.  

Every time data is transferred to the computer it is labeled both with the logger’s 
serial number and comment and is displayed in the graph or data table view. 

The unit serial number is also marked on a sticker on the back of the product.  
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13.5. Power Supply 

The MicroLogPRO II data loggers run from one internal, replaceable 2/3 AA 3.6 V 
lithium battery. Depending on the logger configuration, from a new battery, the data 
logger can run for up to 2 years.  

Note: When connected to the PC via USB, the logger will draw its power via the USB 
port and not via the internal battery. 

13.5.1. Replacing the Battery  

Note: Removing the logger battery will result in logger memory being erased but the 

setup configuration will be retained. 

1. Unfasten the three screws on the back of the MicroLogPRO II. 
2. Carefully remove the back cover. 
3. Replace the battery, and be sure to insert the new battery into the correct 

corresponding polarities.  
4. Refasten the three screws on the back of the MicroLogPRO II. 

13.6. USB Communication Cable 

A mini USB communication cable is supplied as part of the DataSuite software kit. 
This cable connects the MicroLogPRO II data logger to the DaqLink PC workstation. 
When connected to the PC the logger can communicate with the software for 
configuration and data download purposes, for example.  

The USB cable also powers the logger when connected to the PC but it does not 
charge the internal battery. 

 

Figure 63: USB communication cable 

13.7. Operating the MicroLogPRO II 

This section explains how to operate the MicroLogPRO II loggers and provides an 
overview of the logger functionality. 

13.7.1. Turning on the Unit 

To turn on the unit from deep sleep mode (the LCD and LED are both off) simply 
press the Min/Max Hours button for over one second. 

If the unit is in sleep mode, whereby the logger is running or in Stop mode but the 
LCD is off, connecting the unit to the PC via USB or pressing the Min/Max Hours 
button will turn the unit on. 

Type A plug 

Connect to logger USB port 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type B plug  

Connect to PC USB port 
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13.7.2. Logger Sleep Mode 

The MicroLogPRO II battery’s long lifespan is achieved by putting the logger to sleep 
between recordings.  After ten minutes without any sampling or PC communication 
the logger will enter deep sleep. To wake up a unit from deep sleep, press the 
Min/Max Hours button. While in sleep mode, the data logger consumes a minimal 
amount of power. 

MicroLogPRO II wakes up every second for a few micro-seconds in order to check if 
one of the buttons has been pressed or if there is an incoming message from the 
computer. For this reason, you must press and hold a button for at least two seconds 
before a status message appears.  

13.7.3. Viewing Real-time Data on LCD   

When MicroLogPRO II is sampling data the readings from sensors is alternately 
displayed on the LCD followed by the relevant unit e.g. C or F. The data obtained 
from external sensors is displayed with a small EXT icon above the reading, following 
by the unit. 

13.7.4. Viewing Firmware Version  

From Stop Mode 

When the logger is in Stop mode pressing both buttons for two seconds will display 
the device’s current firmware version. 

 

From Run Mode 

When the logger is in Stop mode pressing both buttons for five seconds will display 
the device’s current firmware version. After two seconds the logger will take a time 
stamp and then three seconds later the firmware version will be displayed.  

13.7.5. LCD Mode of Operation  

In the Display tab in the logger Setup window the user has the option to define 
several modes of operation for the LCD screen when sampling. 

 Always On: The LCD will never turn off 

 LCD is off, and will turn on for 30, 60 or 120 seconds upon alarm or key press 

 

In addition, when the logger is not sampling (in Stop mode) the LCD will shutdown 
after five minutes of inactivity in order to conserve battery life. 

13.7.6. Logger Operating Modes 

MicroLogPRO II features the following modes: 

 Stop – MicroLogPRO II is idle and is not sampling. 

 To stop the logger when running via the logger keypad itself, select the Turn 
off on key press option in the logger Setup window. When logger is running, 
pressing both left and right buttons together for over 20 seconds will stop the 
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logger. A time stamp will also be recorded for this event and the T indication 
will display for 2 seconds. The LCD will then display STOP. 

 Run – MicroLogPRO II is sampling data and recording to its internal memory. It 
will stop recording automatically when its memory has reached full capacity 
(52,000 samples with one sensor). 

 Cyclic Run – Similar to Run mode, but the logger will record over the old data 
when the memory is full, beginning with the earliest data recording. This option is 
available in the Setup window.  

 Timer Run – The logger can be configured to start recording at a predetermined 
time. When the logger is set for such a run, its status is set to Timer Run and is 
indicated as tRUN on the LCD. 

 Push to Run – The logger will only begin logging data when the user pushes 
both of the unit’s buttons for at least 3 seconds. 

 Marking a Time Stamp 

 When the logger is running, pressing both logger buttons for over 2 seconds 
will record a new sample with a time stamp on the logger memory.  

 Each time stamp can mark a specific event such as the logger has reached its 
destination, if used during to record temperature during product 
transportation. 

 The time stamp is visible both in the DataSuite data graph and table, and the 
user can enter a comment in the table describing the event.  

 There is capacity for a maximum of 99 time stamps in the logger memory. 
When the memory is full, the LCD will display FULL when both buttons are 
pressed together for over two seconds. To reset the Time Stamp memory, 
perform a new logger setup. 

13.7.7. LCD Status Messages  

 USB – Indicates that the logger is connected to the PC via USB cable 

 Stop -  The logger is currently in Stop mode, not sampling data  

 Run – Visible immediately before the logger is about to start sampling data, once 
the Run command was sent. 

 Push – Indicates the logger is in Push to Run mode, as configured in the logger 
Setup window. Press both logger buttons for over 3 seconds to start running. 

 tRUN - Indicates the logger is in Timer Run mode, as configured in the logger 
Setup window. Press both logger buttons for over 10 seconds to start running. 

 T01, T02, etc. – Indicates that a time stamp has been taken, by pressing both 
logger buttons for over 2 seconds while running.  

13.7.8. Displaying Minimum and Maximum Values 

You can display minimum and maximum values on the LCD screen, ranging from the 
last 1 - 24 hours or from the last 1 - 30 days, by using the MicroLogPRO II left and 
right buttons. 
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Viewing Min. and Max Values in the last 1-24 Hours 

1. Select a time period by pressing the right button on the logger. The LCD will 
begin displaying the hour number, ranging from 1 to 24 hours. Once you’ve 
reached the desired time period, release the right button. 

2. Once you’ve released the right button, the logger will display the Min and Max 
values logged by the sensors during the selected time period, including Dew 
Point. 

 

Viewing Min. and Max Values for the last 1-30 Days 

1. Select a time period by pressing the left button on the logger. The LCD will 
display the day number, ranging from 1 to 30 days. Once you’ve reached the 
desired time period, release the left button. 

2. Once the left button is released, the logger will display the Min and Max values of 
the sensors for the selected time period, including Dew Point. 

13.7.9. Alarm Levels 

The logger displays an alarm notification whenever any alarm level is exceeded. 

AL-L – A sensor’s reading is lower than its low alarm level. 

AL-H – A sensor’s reading is higher than its high alarm level. 

The alarm notification remains until the next time you change the logger setup or run 
a new recording session. 

13.7.10. LED Indications 

The MicroLogPRO II features a LED primarily to give real-time indication of alarm 
and activation. 

 Logger alarm – The LED will flash red at one second intervals until the alarm is 
cleared. 

 Connected to USB – The LED will permanently indicate green as long as the 
unit is connected to the computer via USB and in Stop mode.  

 Normal sampling – The LED will flash green with each recorded sample, as long 
as the logger is in Run mode. 

 Turning on the unit – The LED will blink orange for one second when it is turned 
on from sleep mode. 

 Marking a time stamp – The LED will blink green when a time stamp is marked, 
as it is recording a new sample to the logger memory. 

 

  



 

129 

Chapter 14:  
Using the DataSuite Software  

 

This chapter provides a detailed description of the DataSuite 
software features, allowing you to configure and monitor your 
fourtec data loggers in a unified application. Each DataSuite 
module utilizes the same core functionality of the DataSuite 
platform, such as setup, calibration, defining new sensors, 
managing Email and SMS notifications, configuring reports, 
firmware updates and so on. In addition, each module 
includes specific features for the product it supports e.g. 
ZigBee network communication features for DataNet.  

14.1. Installing DataSuite Software 

Part of your product package includes a DataSuite software CD. Follow the software 
installation instructions provided below.  

14.1.1. System Requirements 

To work with DataSuite your system should be configured according to the following 
specifications: 

Software 

 Windows XP SP3, Windows Server 2003 SP2, Windows Vista (32-bit) or 
Windows 7 (32-bit or 64-bit) 

 Minimum screen resolution: 1024 x 768 (800 x 600 not supported) 

Hardware 

 Pentium 4, 2.0 GHz or better  

 512 MB RAM  

 250 MB available disk space for the DataSuite application  

14.1.2. Language Support 

DataSuite currently supports English interface only with additional languages to be 
added in future DataSuite versions. 

To toggle the software language, go to Help > Language. You must then exit 
DataSuite for the changes to take effect.  

14.1.3. Installation Procedure 

Note: If you are planning to use more than one fourtec system e.g. DataNet and 
MicroLogPRO II, only one DataSuite software installation is required. Each product is 

managed by a specific product module within the DataSuite modular application.  

Please read these instructions before proceeding with the installation process. 
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1. Insert the DataSuite software CD into your computer’s CD drive. The DataSuite 
Installation Wizard automatically starts running. 

2. The Wizard first downloads and installs Microsoft .NET Framework 2.0, if not 
already detected on the computer. The DataSuite software requires this platform 
in order to run. Follow the installation instructions to install the .NET Framework 
on your PC. This step can take up to two minutes to complete. Click Finish once 
installation is complete. 

Note: If .NET Framework is already installed on your computer this step is 

skipped. 

3. The main DataSuite Installation Wizard now resumes. Follow the installation 
instructions to install DataSuite on your computer.  

4. Following DataSuite software installation is the Silicon Laboratories USB driver 
installation. The driver is necessary for the computer to detect the DataNet and 
DaqLink Receiver hardware.  

Note: MicroLogPRO II and MicroLite II do not require driver installation. 

5. Follow the on-screen instructions to continue the installation process. The default 
installation location is C:\SiLabs. 

 

Figure 64: Installing Silicon Labs USB driver – Step 1  

6. During the driver installation, the following window will pop up. Make sure to 
select the checkbox to launch the driver installer, and click Finish. 

 

Figure 65: Installing Silicon Labs USB driver – Step 2 

7. In the subsequent window, click Install to install the driver. 

 

Figure 66: Installing Silicon Labs USB driver – Step 3 
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The installation of the driver could take up to one minute or more, depending on 
the system.  

 

Figure 67: Installing Silicon Labs USB driver – Step 4 

 

8. Once installed click Finish to close the USB driver Install Wizard dialog. 

9. The DataSuite software and components have now been installed. Double click 

the DataSuite shortcut on your desktop  to launch the software. 

10. The DataSuite Welcome window will open, prompting the user to configure the 
application before use. This must be done only once when first running the 
software. Click Next to continue. 

 

11. In specific versions of Windows, the user may have User Account Control (UAC) 
settings activated. If so, the user will be prompted the following instructions. 
Select the relevant option. 
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12. If you have an existing, registered, DataNet or DaqLink installation on the same 
computer, then DataSuite will detect it. You have the option to convert all data 
files from these previous installations into a format recognized by DataSuite. This 
will allow you to view all archived data in DataSuite as well as in the legacy 
software. Click Next to convert the data, or Skip to skip this step. If you skip, you 
will not be able to convert the data files later. 

 

13. You are then given the choice to activate the DataSuite software now or to do so 
later. To activate now click Next, to activate later click Skip. Even if the software 
is not activated using the license Serial Number, you still need to commence the 
Trial period in order to use the hardware.  

 

14. When choosing to activate the software, the DataSuite software registration 
window will open. Select the relevant module button e.g. DataNet.  
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15. Select Start trial to commence the free 30-day trial and click Next. The module 
registration can be completed at a later stage. For more details refer to section 
‎14.3. 

16. Once the Trial period has started, DataSuite will detect the connected loggers. To 
detect more than one product module at the same time, you must ensure that 
each module is either in Trial mode or activated using the unique software Serial 
Number.  

17. When completing the necessary tasks in the Validation window, click Exit. You 
will return to the window from step 13. Click Skip. You have reached the end of 
the configuration process. Click Finish to launch the application. 

18. Once the module is launched, connect the device to a USB port on your 
computer. It will automatically detect the logger as new hardware and the device 
will appear as a new icon in the DataSuite Map View.  

14.1.4. Working with Multiple User Accounts 

Each specific user account that accesses the DataSuite software module can 
commence trial period for that specific account. However, as soon as a user with 
Administrator privileges activates the module with a Serial Number, then all user 
accounts which had previously been in Trial mode, will now be fully activated.  

All users will have full access to the DataSuite module’s settings and data files.  

14.1.5. Installation Troubleshooting 

When connected to the PC USB port the device was not detected by the software. 

Ensure that the USB driver was installed properly.  

Go to Control Panel > Add/Remove Programs (in WinXP), and check that the 
driver is installed: 

 

 



 

134 

If not, you should run the Silicon Labs setup file to install the USB driver: 
CP210x_VCP_Win2K_XP_S2K3.exe setup.exe to install the driver.  

 

If the driver is installed, ensure that there is no other device sharing the USB com 
port with the device.  

If you didn’t select the Launch CP210x VCP Driver Installer checkbox during step 2 
of the driver installation wizard (see section ‎14.1.2), then the driver wasn’t installed. 
Run the wizard again and be sure to select the checkbox. 

14.2. DataSuite CFR Login 

When launching the DataSuite CFR software (following activation of the CFR 
module), the user is required to login to the system so that the system Administrator 
is able to follow user activity in the DatPass Admin software audit trail (per FDA 
regulations). 

1. Prior to running DataSuite CFR for the first time, the Admin must create a new 
user in the DatPass software. Once this is done, you may launch the DataSuite 
CFR software. 

2. The Login dialog will open. For first time login, click New User.  

 

Figure 68: User Login Dialog 

3. Select the user via the drop-down menu, and proceed to enter the username and 
password associated with that user profile. 

Note: If the system prompts a No New Users message, then request your DataSuite 

system administrator create a new user in DatPass. 

4. Click OK. 

5. Once logged into the DataSuite CFR software, you will only have access to those 
features for which the Administrator has granted privileges. 

6. To log off from the system, go to File > Logoff. The login dialog will remain open 
in case you wish to login again. 

14.3. DataSuite Software Registration 

DataSuite requires all modules to be registered within 30 days of installation, using a 
serial number provided with purchase of the specific DataSuite module:  

 DataSuite-DN (DataNet) 

 DataSuite-DQL (DaqLink) 

 DataSuite-ML (MicroLogPRO II) 

 DataSuite-CFR (CFR module) 

 DataSuite for MicroLite is free of charge and does not require activation. 
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 When the initial 30 day Trial period is over, the user will not be able to operate the 
software until a valid serial number is registered.  

Note: The software activation feature protects fourtec’s intellectual property for both 

its software and hardware.  

 

Please note that: 

 Each serial number is good for unlimited installations on a single computer. You 
cannot install the software using the same serial number on another computer.  

If you have replaced your computer and must reinstall DataSuite using the same 
serial number, contact fourtec Customer Support for assistance. 

 Registration can be performed from the computer with DataSuite installed, or if 
there is no Internet connection from that computer, then via another computer 
with Internet connectivity. 

 When the trial period for the CFR module ends, DataSuite will revert to the 
standard non-CFR environment unless activated. 

14.3.1. Software Registration Process 

Note: The software registration forms are all case sensitive. Incorrect entry will result 
in invalid registration.  

To register any one of the DataSuite modules, follow the instructions below: 

1. Locate the DataSuite module serial number (SN). The SN label is found on the 
DataSuite box as well as on the software CD case. 

Note: If you cannot locate your serial number, contact your fourtec distributor or 

fourtec Customer Support directly. 

2. Launch DataSuite. The registration wizard will open.  

3. To open the registration wizard from within DataSuite go to Help > Register. 

4. From the bottom of the wizard Home screen, select one of the module buttons to 
proceed to the registration screen for that module. 

 

5. Three choices are presented. Select the relevant option and click Next to 
proceed: 
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 Activation via the Internet 

Select to proceed with registration on the same computer on which DataSuite 
is running, ensuring it has a live Internet connection. 

 Activation via an Internet connection on another computer  

Select if the computer on which DataSuite is running does not currently have 
Internet connectivity.  

 Start  trial  

Select to commence the 30 day free trial period and continue working in 
DataSuite.  

6. After selecting one of the two available options for continuing with the registration 
process, and after clicking Next in step 4 above, you will be prompted to enter the 
software SN. Enter the SN and click Next. 

Note: Each serial number provides a single user license for the specific module. You 

cannot use a serial number already registered on another computer.  

7. The registration process now differs, depending on which option was selected in 
step 4 above. Read the relevant section below for further registration instructions.  

 

Activation via the Internet 

1. After entering the software serial number, a window requesting basic personal 
information will open. Enter the mandatory fields and click Next.  
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Figure 69: Personal information registration window 

2. DataSuite will now establish communication with the fourtec server to complete 
the registration process. If successful, a confirmation message will appear. In the 
event of any problem in the registration process, please contact your fourtec 
distributor or fourtec Customer Support.  

3. Click Close to return to the DataSuite software. 

 

Activation via Internet Connection on another Computer 

1. After entering the software serial number, a window providing additional 
registration instructions will open.  

  

Figure 70: Activating DataSuite from another computer 

 

2. Follow the steps as outlined in the window.  
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Note: It is recommended to generate a text file containing both the Application Key 

and the Web registration form URL. Press the  icon. Transfer this file to the 
computer with Internet connection, as the registration process must be continued 
from there.  

3. Record the License Key obtained from the Web registration form. Enter it into the 
License Key field in Step 1 and click Unlock. 

4. DataSuite will now establish communication with the fourtec server to complete 
the registration process. If successful, a confirmation message will appear. In the 
event of any problem in the registration process, please contact your fourtec 
distributor or fourtec Customer Support.  

5. Click Close to return to the DataSuite software. 

14.4. System Password 

Throughout the software you will be required to enter a password to perform certain 
functions such as calibration or firmware update.  

Note: The default password is 1234. 

To change the password: 

1. In the Password dialog box, click Change Password to open the Change 
Password dialog box. 

2. Enter the current password in the Current Password text box. 

3. Enter the new password in the New Password text box. 

4. Enter the new password a second time in the Confirm New Password text box 
to confirm your new password. 

5. Click OK. 

Note: The password must include at least 4 characters and is case sensitive. 

14.5. DataSuite Software Layout  

This section provides an overview of the default DataSuite window view as well as a 
guide to all of the icons available throughout the software. 

The most commonly used tools and commands are displayed on two toolbars. Tools 
that relate to all aspects of the program are located in the main (upper) toolbar. Tools 
specific to the graphs are located on the graph (lower) toolbar.  

Refer to section ‎14.5.5 for a description of these toolbars. 

 

As the DataSuite platform supports several fourtec products, the interface is common 
for most of their functionality. There are several areas such as logger configuration, 
where the interface differs. These differences will be detailed throughout the chapter.  

14.5.1. Map View  

When DataSuite is first launched and the device detection window closes, the default 
window that is opened is the Map View (see screenshot below). 

This view is used to monitor the status and data of all devices currently detected by 
the software. This may be via USB connection e.g. for the MicroLogPRO II, or via 
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wireless connection as with the DataNet system. In the case of the DataNet, the 
location and network connection of all of the data loggers and Repeaters in the 
network, in addition to the Receiver, is monitored from the Map View.  

You can also switch to Map View at any time by clicking the Map View button  in 
the main toolbar. In addition, the Map View can be printed. 

Icons are used to represent each of the fourtec devices, and using the mouse the 
user can select specific actions to be performed on the unit. 

Name tags can also be displayed for each DataNet icon on the Map View. 

 

Figure 71: Main window - Map View desktop 

Refer to section ‎14.16 for more details on working in Map View. 

14.5.2. Sensor View 

Clicking the Sensor View button  in the main toolbar switches the main 
DataSuite window to a display where sensor data is represented in individual 
windows. All sensors which are currently online will be displayed in this view. If a 
logger is currently offline then its data will not be visible. 

 

Figure 72: Main window – Sensor View 

 



 

140 

There are two modes for viewing the sensor data, which may be toggled by going to 
Tools > Switch Sensor View Mode in the main menu.  

 Expanded view 

 

In this view, the logger comment, sensor type and sensor data is displayed. 

 

 Slim view 

 

In this view, only the sensor type and sensor data is displayed. 

 

Sensor in Alarm 

When the sensor data is in alarm, the color of the sensor window will change 
according to the alarm type. There is a legend in the lower right corner of the main 
window: 

 

For example: 

 

This screenshot indicates that the Internal Digital Temperature reading is in High 
alarm, while the Internal Relative Humidity reading is at normal levels. 

 

Additional Features 

 The sensor windows may be dragged and placed anywhere on the screen. 

 Double clicking the sensor window will open the Data Display window, where the 
real-time sensor data is displayed in graph or table view. 

 When the logger is downloading data, a message in the sensor window will be 
displayed. 
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 Scrolling over the sensor window with the mouse cursor will bring up a tooltip 
displaying the following data: 

 Network Name (for DataNet system) 

 Network ID (for DataNet system) 

 Serial number 

 Logger comment 

 Battery level 

 Last sample time 

 Sensor type and reading 

 Downloading data indication (when relevant) 

  

14.5.3. History View 

Note: In History View you can view data from multiple fourtec products in the same 
view. For example, compare data from DataNet loggers side-by-side with 
MicroLogPRO II and DaqLink loggers.  

Clicking the History View button  in the main toolbar will switch the main window 
to view archived, offline data stored in the DataSuite directory on the workstation.  

You must first open the archived data file by clicking Open File on the main 
toolbar. When you open the data file it will be displayed in the History View, 
otherwise, the History View window will be blank.  

Refer to section ‎14.14: Viewing Archived (Offline) Data on page 163 for more details 
on opening files in History View. 

 

Figure 73: Main window – History View 
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In History View, the user may view the data in graph or table format by clicking the 
relevant tabs, as well as view a number of Statistics taken from the data set.  

To learn the functionality of the lower graph toolbar, refer to section ‎14.5.5 below. 

Note: Users of Windows 7 using right to left language settings e.g. Hebrew, may 
have problems viewing the Date/Time in the DataNet graph. This is a know Microsoft 
® bug. Until a bug fix is released, change the Regional Settings to English. 

14.5.4. Data Map 

The History View window also includes the Data Map pane, on the left of the window. 

The Data Map displays all data sets opened in History View, saved in the current 
project file, and includes nodes for each sensor in the data set.  

Clicking the sensor label removes the data from the graph. When the label is black, 
the data is not displayed on the graph. The sensor data plot color is matched to the 
color of the sensor label in the Data Map.  

Each data set is preceded by a Logger icon , which can be expanded or 
collapsed to display the associated sensor data. 

Clicking the Tree icon  in the lower graph toolbar removes the Data Map pane 
altogether allowing a full screen graph view. 

 

Figure 74: Data Map 

14.5.5. DataSuite Toolbar Icons 

This section outlines all of the toolbar icons available in the software. 

Main (Upper) Toolbar Icons 

 

 

Figure 75: Main toolbar icons 

 

The main toolbar is always available at the top of the DataNet application, no matter 
what window view the user is in.  

This toolbar cannot be moved or hidden. 

   Open file - Opens archived logger data file 
stored on the PC 

Data Map 
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   Map view - Switches main window to Map 
view, where the units connected to the 
computer are represented 

   Sensor view - Switches main window to 
Sensor view, where data from each 
running sensor is displayed in a simple 
view 

   History view - Switches main window to 
History view, where archived logger data 
can be viewed and analyzed 

   

 

Alarm mute/unmute - Mutes or unmutes 
an audible alarm in the system when a 
sensor reading has breached the user-
defined alarm level 

   Email Alarm Notifications - Configuration 
window for Email alarm notifications 

   SMS Alarm Notifications - Configuration 
window for SMS alarm notifications 

   

 

GSM Modem - Indicates if GSM modem is 
connected (green icon) or disconnected 
(grey icon) 

   Temperature unit toggle - Display all 
data in Celsius  

   Temperature unit toggle - Display all 
data in Fahrenheit 

   Reports Profile Manager – Opens 
Reports module 

   Report Browser – Opens window for 
browsing saved Reports 

Table 4: Main toolbar icon list 

14.5.6. Map View Icons 

The following icons representing the various statuses of the devices are viewed in 
Map View. Using these icons the user is aware of the status of each unit e.g. 
offline/online, alarm, power, etc.  

Alarm status is also indicated: Green = Normal ; Red = Alarm 

 

DataNet Icons 

  

 

Receiver is online and connected to the 
PC. 
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  

 

Receiver is offline, possibly as USB cable 
has been disconnected or it was removed 
from external power supply (and backup 
battery drained). 

  
 

Logger newly acquired by network and 
awaiting Setup.  

Running from internal battery supply. 

  
 

Logger newly acquired by network and 
awaiting Setup.  

Running from external power supply. 

  
 

Logger which has received its Setup but is 
in Stop mode. 

Running from internal battery supply. 

  
 

Logger which has received its Setup but is 
in Stop mode. 

Running from external power supply. 

  
 

Logger in Run mode and running on 
internal battery supply. 

Green indicates there are no alarms. 

  
 

Logger in Run mode and running on 
external power supply. 

Green indicates there are no alarms. 

  
 

Logger in Run mode with an alarm alert. 

Running from internal battery supply.  

  
 

Logger in Run mode with an alarm alert.  

Running from external power supply. 

  
 

Logger is offline and is no longer detected 
on the network. Its power supply may have 
failed or it’s out of range of the Receiver.  

  
 

Logger is processing a command sent 
from the software. 

  
 

Logger is downloading data. 

  
 

Logger is detected by DataSuite software 
via direct USB connection. Logger is in 
Stop mode and running from internal 
battery supply. 

  
 

Logger is detected by DataSuite software 
via direct USB connection. Logger is in 
Stop mode and running from external 
power supply. 

  
 

Logger is detected by DataSuite software 
via direct USB connection. Logger is in 
Run mode and running from internal 
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battery supply. 

  
 

Logger is detected by DataSuite software 
via direct USB connection. Logger is in 
Run mode and running from external 
power supply. 

  

 

Repeater is online and is running from 
external power supply. 

  

 

Repeater is offline and is no longer 
detected on the network. Its power supply 
may have failed or it’s out of range of the 
Receiver. 

  

 

Repeater is detected by DataSuite 
software via direct USB connection. 

Table 5: Main toolbar icon list 

 

DaqLink Icons 

  
 

Logger which has received its Setup but is 
in Stop mode. 

Running from internal battery supply. 

  
 

Logger which has received its Setup but is 
in Stop mode. 

Running from external power supply. 

  
 

Logger in Run mode and running on 
battery supply. 

Green indicates there are no alarms. 

  
 

Logger in Run mode and running on 
external power supply. 

Green indicates there are no alarms. 

  
 

Logger in Run mode with an alarm alert. 

Running from internal battery supply.  

  
 

Logger in Run mode with an alarm alert.  

Running from external power supply. 

  
 

Logger is offline and is no longer detected 
by the computer. Its power supply may 
have failed or the USB cable was 
disconnected. 

  
 

Logger is processing a command sent 
from the software. 

  
 

Logger is downloading data. 

  

 

Receiver is online and connected to the 
PC. 

  

 

Receiver is offline, possibly as USB cable 
has been disconnected or it was removed 
from external power supply (and backup 
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battery drained). 

  
 

Logger newly acquired by network and 
awaiting Setup.  

Running from internal battery supply. 

MicroLite II Icons 

  
 

Logger which has received its Setup but is 
in Stop mode. 

  
 

Logger in Run mode. Green indicates 
there are no alarms. 

  
 

Logger in Run mode with an alarm alert.  

  
 

Logger is offline and is no longer detected 
by the computer. Its power supply may 
have failed or the USB cable was 
disconnected. 

  
 

Logger is processing a command sent 
from the software. 

  
 

Logger is downloading data. 

 

MicroLogPRO II Icons 

  
 

Logger which has received its Setup but is 
in Stop mode. 

  
 

Logger in Run mode. Green indicates 
there are no alarms. 

  
 

Logger in Run mode with an alarm alert. 

  
 

Logger is offline and is no longer detected 
by the computer. Its power supply may 
have failed or the USB cable was 
disconnected. 

  
 

Logger is processing a command sent 
from the software. 

  
 

Logger is downloading data. 

14.5.7. Graph (Lower) Toolbar Icons 

The graph toolbar is located at the bottom of the open graph view, when the user is 
either in Online Data Display: 

  

Or History View: 

 

 

The toolbar cannot be moved or hidden. 
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   
Data Map (in History View only) – Hides or shows the Data 
Map pane in the History View window. 

   
Plot Legend (in Display Data View only) – Hides or shows 
the sensor labels from the bottom of the graph. 

   
Autoscale - Returns the data to its default scale.  

   
Zoom in – Zooms in on the graph data. 

   
Pan graph – Pans the graph along the x or y axis. 

   
Select first cursor – Adds a cursor to the designated plot 
on the graph 

   
Select second cursor – Adds a second cursor to the 
designated plot on the graph. 

   
Grid – Adds a grid to the graph background 

   Show/Hide Time Stamp – Shows or hides the time stamp 
markers on  the graph 

   
Add Custom View (in History View only) – adds the open, 
customized graph view to the Data Map 

   
Copy graph – Copies the graph to your clipboard, to be 
copied to a document or spreadsheet, for example. 

   
Graph properties – Opens the Graph Properties window.  

   
Export to Excel – Export the open data sets to Excel 
format. 

   
Print – Opens the Print dialog. Available for graph, table 
and statistics views. 

Table 6: Lower graph toolbar icon list 

14.5.8. Data Map Icons 

  
 

Displayed internal Temperature sensor 
data set 

  
 

Hidden internal Temperature sensor data 
set 

  
 

Displayed internal Humidity sensor data 
set 

  
 

Hidden internal Humidity sensor data set 

  
 

Displayed external sensor data set 

   
Hidden internal sensor data set 

  
 

Displayed graph function 
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  
 

Hidden graph function 

   Parent node for all logger data sets. Click 
to expand or collapse all child nodes. 

  
 

Logger data set. Click to expand or 
collapse the data set containing all 
measured inputs of the specific logger. 

  
 

Parent node for all custom graph views. 
Click to expand or collapse all child nodes.  

  
 

Displayed custom graph view. When 
hidden the icon is grayed out. 

Table 7: Data Map icons 

14.6. File Menu Items 

14.6.1. Open 

Select Open to access archived data files for each logger in your network. 

Shortcuts: You can also click the Open icon  or press Ctrl+O to open archived 

files. 

14.6.2. Open Project File 

Opens project files of offline data, containing data from one or more loggers, as 
opposed to standard data files containing data from only one logger.  

14.6.3. Save Project 

Saves multiple data sets and custom graph views into a single Project File. Only 
available in History View. 

14.6.4. Save Project As 

Saves an existing Project file under a different name. 

14.6.5. Backup System Files 

This feature allows the user to backup system data and configuration files for all 
DataSuite modules to a defined path on the local computer, network or US memory 
stick.  

Backing up these files to a secure location will ensure that in the event of damage to 
the computer hard disk, for example, you will be able to restore the critical files 
containing all the device data and configurations of the DataSuite itself. It will also 
enable you to setup mirror installations using the same devices.  
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14.6.6. Restore System Files 

Once the system files have been backed up, use this feature to restore them to the 
DataSuite workstation or to another computer. 

14.6.7. Print Map View 

Prints the current Map View with all unit icons, including their network paths and 
name tags. 

14.6.8. Exit 

Exits the DataSuite application.   

14.7. DataNet Network Menu Items 

This menu is specifically for DataNet users and applies to all DataNet networks 
currently detected by the software. Additional Network menu items are accessible via 
the Receiver context menu, by right-clicking the Receiver icon in Map View. 

14.7.1. Refresh All Network Connections 

Use this feature to send a command to all Receivers to re-establish connection to the 
end units in its specific network. This is useful when wanting to ensure the network 
connectivity is performing optimally without any delay or lag due to changes in 
environmental conditions or location of the end units. Such delays can explain logger 
icons not displaying the correct information or commands not being sent promptly to 
the end units. 

Note: The software automatically refreshes the network connections every 10 

minutes. 

14.7.2. Show All Network Paths 

While in Map View, enable this option to display the path that the RF signal of all 
units in the network takes to reach the Receiver. If Repeaters are used in the network 
it will show the signal routed via the Repeater, en route to the Receiver.  
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The paths are color-coded so you can also see the transmission strength. A legend 
appears at the bottom of the window.  

 

 Red = Low (0 to 23% strength) 

 Yellow = Medium (23 to 56%) 

 Green = High (56 to 100%) 

 

You can also enable this feature for specific loggers by opening the context menu on 
the Logger icon in Map View and selecting Show Network Paths. 

14.8. Tools Menu Items 

14.8.1. Define Sensor 

DataSuite enables the user to define custom sensors. This is a useful tool for when 
the data logger is communicating with many sensor types from different vendors.  

Any additional sensor that you would like to connect to the logger must comply with 
the following restrictions: 

The sensor’s output must be either voltage in the range of 0 to 1 V, 0 to 50 mV, 
current in the range of 4 to 20 mA or Pulse in the range of 0 to 65535 pulses. 

1. Click Tools > Define New Sensor and the Define New Sensor dialog will open.  

 

Figure 76: Define New Sensor dialog 

 

2. Click New to enable the fields. 

3. Select the Base sensor from the drop-down menu (depending on whether your 
sensor’s output is 0 to 1 V, 0 to 50 mV, 4 to 20mA, or measuring pulses).  
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4. If you wish to configure a defined sensor for the EC8XX or MicroLite II models, 
make sure to select the base sensor corresponding to the specific logger model. 

5. Enter the sensor name and sensor unit. 

6. Enter two calibration values (two real values and the corresponding output values 
of the sensor). 

7. Click Save. 

8. To make any changes to the existing sensor definitions, stand on the sensor 
name and click Edit. Otherwise, click New to define additional sensors or click 
Close to exit the dialog. 

 

To use the custom defined sensor: 

1. Enter the Setup dialog for the data logger you want to configure.  

2. Select the Input you wish to use and from the Sensor Type drop-down menu, 
select the custom sensor, which now appears in this list.  

3. Proceed with the setup as you would normally do. 

14.8.2. Switch Sensor View Mode 

While in Sensor View, selecting this option will switch the sensor view between large 
and small window sizes. By reducing the size of the sensor window you display only 
the sensor type and sensor data. Enlarging the size of the sensor window will display 
sensor type, sensor data and logger name. 

14.8.3. Lock Map View 

While in Map View, with Lock Map View selected the Map View icons are in a fixed 
position and can’t be moved. You must unselect this option in order to freely move 
the icons anywhere on the screen. This is essential if working with a custom 
background image.  

14.8.4. Options Menu 

Refer to section ‎14.9 for more details. 

14.8.5. Manage Contacts 

The Manage Contacts dialog is where the user can add, edit and remove all contacts 
and groups to which DataSuite Reports and Email/SMS notifications are sent.  

Refer to section ‎14.19.1 for more details regarding managing Contacts, and to 
section ‎14.19.2 for more details regarding managing Groups. 

14.8.6. Email Alarm Notifications 

The Email Alarm Notifications dialog is where the user can configure all notifications 
to be sent via Email to a predefined contact list. Refer to section ‎14.18 for details. 
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14.8.7. SMS Alarm Notifications 

The SMS Alarm Notifications dialog is where the user can configure all notifications 
to be sent via SMS to a predefined contact list. Refer to section ‎14.18 for details. 

14.8.8. Firmware Update Center 

The Firmware Update Center is where the DataNet firmware updates are managed. 
Please refer to section ‎15.2 for more details. 

14.9. Tools > Options Menu Items 

The Options dialog is divided into four main tabs:  

 Preferences 

 Device Settings 

 Email Settings 

 SMS Settings 

14.9.1. Preferences Tab 
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Figure 77: Options > Preferences tab 

The Preferences tab includes the following options: 

 

Minimize DataNet to system tray 

When this checkbox is selected, the DataSuite icon  will appear in the 
computer’s system tray in the lower right of the screen when the application is 
minimized. Simply double-click the icon to maximize the application to full screen. 

 

Run Application on Windows Startup 

When this option is selected DataSuite will automatically launch upon Windows 
startup. This feature is useful in the event where the computer unexpectedly resets 
and when it restarts, DataSuite will launch and online monitoring of the connected 
devices will be able to continue. 

Note: If running Windows Vista, User Account Control (UAC) must be turned off for 

this feature to work. If UAC is off then DataSuite will not launch on Windows startup.  

 

Map View background 

Use this option to toggle between Stretch and Center views for the background 
image used in Map View. 

 

Set decimal places for… 

For each logger sensor, internal or external, you may select between 0 and 6 decimal 
places to be used when displaying the data in the software. 

 

Date format 

Choose between four date formats to be used throughout the software when 
displaying data e.g. in the Graph display. 

 

Ignore regional settings when exporting to CSV 

Selecting this option will ensure that data will be corrected exported to a CSV file and 
will not use any custom regional settings in the Windows OS which might adversely 
affect the layout of the data in the CSV file. 

 

Application data files path 

The default path for saving all data recorded by the data loggers is:  

C:\Documents and Settings\All Users\Application Data\fourtec\DataSuite 

 

Click Browse to change this path e.g. to a network path. 

 

Save text data files 

Select this checkbox if you would like DataSuite to also save the logger data to a text 
file. This will allow you to export the data, in csv format, to another application that 
can display the logger data.  
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Default path on WinXP: C:\Documents and Settings\All Users\Application 
Data\fourtec\DataSuite\Text Files.  

Default path on Windows 7: C:\Users\Public\fourtec\DataSuite\Text Files 

 

Click Browse to change this path e.g. to a network path. 

Note: The text file cannot be updated with logger data as long as it is open. Make 
sure to close the file when you finish inspecting the data, or copy the file to another 
location and view it from there. Alternatively, open the file in Read-only mode. 

 

Path for Report files 

The default path where Report files are stored is: C:\Program 
Files\fourtec\DataSuite\Reports\<module name>\Reports. 

Click Browse to change this path e.g. to a network path. 

 

Default Paths 

If the user has modified any of the default data file or report paths e.g. to a network 
path, and should this path become available for any reason,  then the DataSuite 
application will automatically refer to the default path as shown under the Default 
Paths heading.  

This precaution is necessary as otherwise DataSuite cannot download any data from 
the data loggers if the data file path is not available. Data can therefore be lost.  

Default path on WinXP: C:\Documents and Settings\All Users\Application 
Data\fourtec\DataSuite\Data Files 

Default path on Windows 7: C:\Users\Public\fourtec\DataSuite\Data Files 
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14.9.2. Device Settings Tab 

 

 

Download data on application startup 

Select this checkbox if you want to have automatic download of data when the 
DataSuite software is launched. If there are many loggers in the system with fast 
sampling rates, then the download could burden the network. Therefore in some 
cases disabled this feature is advised. 

 

Generate and send Boomerang reports automatically 

Select this checkbox to enable the Boomerang feature to run automatically when a 
Boomerang-enabled logger is connected to the computer. By default, this option is enabled, 
so that the PDF data report is generated and Emailed as soon as the logger is detected by 

the DataSuite software.  

14.9.3. Email Settings Tab 

DataSuite’s alarm notification feature enables sending of Emails to notify the user of 
any alarm in the system.  

Clicking the Emails Settings tab will show the following window: 

 

 

DataSuite includes a Default Profile – this is a fourtec-configured email account, 
embedded into the software. This means that even if you don’t configure any email 
account, you are still able to send Email alarm notifications and Boomerang data 
reports using fourtec’s own email account. 

1. To edit existing Email profiles or add a new one, click Edit. 

The following window is opened: 
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Figure 78: Options > Email Settings tab 

 

You can view the Profile settings here. Note that the Default profile is un-editable.  

2. To add a new custom profile, click Add. A new entry named New Profile is 
created. Click on this entry to edit the settings, server information, etc. Make sure 
to enter the fields correctly e.g. with no extra spaces or typos. 

3. When finished, click OK to return to the main Email Settings window, displaying 
the list of profiles.  

4. To remove a profile from the Profile List, click Remove from the Email Profile 
Manager window. Note that the default profile cannot be removed. 

Note: DataSuite supports SMTP and MIME encoding, and POP3 mail protocols.  

 

Sending a Test Email  

To send a test Email to verify the Email configuration is correct: 

1. Once the Email profile configuration is complete click Test Email to open the 
Contact Information dialog. 

2. Select a contact from the DataSuite contact list or enter an Email address. Click 
OK to send the test Email.  
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3. The test Email will contain the following content: 

Subject: Test message sent from the  DataSuite  software 

Body: This is a test message sent from the DataSuite software. Sent on the 
dd/mm/yy  mm:hh 

14.9.4. SMS Settings Tab 

DataSuite’s alarm notification feature enables sending of SMS’s to notify the user of 
any alarm in the system. First select the Send SMS notifications check box. Using 
the SMS feature requires connection of a GSM modem and SIM card to the DataNet 
PC, or even just a cellular phone with an active SIM card.  

You must select the COM port which the GSM modem/cellular phone is connected to 
in order for the software to detect it. 

Note: When using a cellular phone as a modem, ensure that the PC software suite is 
disabled before connecting the phone to the PC com port. Otherwise the com port 
will not be available for the DataSuite software.  

Once the configuration is complete, DataSuite will be able to send SMS’s to 
predefined SMS contacts when your loggers have breached certain alarm levels.  

Refer to section ‎14.17.2 for setting Alarm levels on the logger and to section ‎14.18 
for managing the SMS alarm notifications.  

 

Figure 79: Options > SMS Settings tab 
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Note: Once the GSM modem is online you will see the green GSM icon  appear 

in the DataSuite upper toolbar. 

 

Sending a Test SMS 

To send a test SMS to verify the SMS configuration is correct: 

1. Once the SMS configuration is complete and the GSM modem has been detected 
by the software, the Test SMS button will be enabled.  

2. Click Test SMS to open the Contact Information dialog. 

3. Select a contact from the DataSuite contact list or enter a telephone number. 
Click OK to send the test SMS.  

4. The test Email will contain the following content: 

Subject: Test message sent from the  DataSuite software 

Body: This is a test message sent from the DataSuite software. Sent on the 
dd/mm/yy  mm:hh 

14.9.5. Email/SMS DataNet Offline Receiver and Reception 

Alarm Delay 

To prevent alarm notifications being sent unnecessarily for unit’s which momentarily 
get disconnected from the network, the user can define an alarm delay for Email and 
SMS notifications. The RF environment as well as the network behavior are very 
dynamic and can result in very brief instances of units going offline.  

In addition, if the Receiver USB cable is disconnected, or the unit is turned off for any 
reason (and therefore the USB connection is lost), an alarm will be sounded. By 
adding a delay you can mitigate any false alarms.  

 This feature is found on the Email and SMS Settings tabs in Tool > Options.  

 

 The alarm delay can be defined from between one minute to 24 hours, with a 
resolution of one minute. 

 If the DataSuite software is shutdown during a period when alarm delay is being 
timed i.e. after a unit has gone offline, then the time stamp when the unit went 
offline will be recorded. When the software is reopened if the period of the alarm 
delay has already passed then an Email/SMS notification will be sent.  

If the alarm delay period has not passed then the SMS/Email message will be 
initiated only if the time delay is reached. 

14.9.6. Analysis Menu Items 

The Analysis menu items are enabled when viewing offline data in History View. 

The Analysis options available are: 

 Functions Parameters 
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 Dew Point 

 FO Pasteurization 

 Histogram 

 MKT  

 Export to Excel 

 Export to CSV 

 

MKT (Mean Kinetic Temperature) 

Mean Kinetic Temperature or MKT is used for calculating temperature stress of 
perishable stock goods such as medicines or food, during storage and distribution 
cycles. The MKT is calculated on a temperature graph opened from an offline 
DataSuite data file, in History View. 

 

To use the MKT feature: 

1. Go to File > Open and open the data file containing the relevant temperature 
measurements. 

2. In History View, with the graph tab in view, go to Analysis > MKT in the main 
menu. The MKT dialog is opened. 

 

Figure 80: MKT dialog 

3. Use the cursors to select the data set, or leave the graph as is to perform the 
MKT calculation on the entire data set. 

4. Enter the relevant Activation Energy, and the Low and High Limits of the data set 
to be calculated (in °C), into the MKT dialog.  

5. Click Calculate. A Pass or Fail indication will be displayed and in the event of a 
Pass, the MKT value will also be displayed. 

6. Click Print to print the MKT dialog with the results. 

 

Export to Excel 

You may export offline data to Excel by selecting this menu item or by clicking the 

Export to Excel icon  in the lower graph toolbar in History View. The data is 
opened in an Excel worksheet and includes pertinent information such as logger 
name, SN, sensor names, alarm levels as well as the actual data readings. 

Refer to section ‎14.22 for more information. 
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Export to CSV 

You may export offline data to CSV file format by selecting this menu item. Upon 
selecting this option, you will be prompted to save the file either in the default 
DataSuite directory or in directory of your choosing. The data is opened in CSV file 
format and includes pertinent information such as logger name, SN, sensor names, 
alarm levels as well as the actual data readings. 

Refer to section ‎14.22 for more information. 

14.10. Devices Menu Items 

14.10.1. Detect Device 

When DataSuite is launched it automatically scans all ports for DataSuite supported 
devices. Select this menu item to manually detect devices. 

 

 

All devices are automatically detected by the software when connected to the 
computer. If you connect a device when it is switched off, and then switch the device 
on, the software won’t detect the unit. You will have to use the Detect Devices 
feature. 

The device may also lose power and go offline while connected to the USB, in which 
case you will also need to detect it manually. 

Connecting the data logger or Repeater to the computer via USB and selecting this 
menu item supports:  

 For DNL910 and DNL920: Direct data download, firmware update and turning off 
of the unit. Refer to section ‎14.16.7‎15.2.4 regarding firmware update via USB.  

 For DNR900 Repeater: Firmware update. Refer to section ‎15.2.4. 

14.10.2. Stop All 

To stop all the online loggers in the Map View simultaneously, go to the Devices > 
Stop All menu item. Prior to stopping the loggers, DataSuite will first download and 
data not already transmitted to the computer. 
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This feature is password-enabled. 

14.10.3. Run All 

To run all the online loggers in the Map View simultaneously, go to the Devices > 
Run All menu item. Prior to running the loggers, DataSuite will first clear the logger 
menu. This command will not apply to any devices currently in Timer Run or Push to 
Run modes. 

This feature is password-enabled. 

14.11. Search Devices 

If you have many device icons situated in the Map View and have trouble locating the 
specific device to configure, the Search feature can be very helpful. 

In the top right corner of the main window you will find the Search window: 

 

 

The search criteria are:  

 Device Serial Number e.g. 7002354 

 Device Comment e.g. Lab 1/F 

 Device Type e.g. DNL910-PA 

 

Enter the relevant search criteria in the text window and all relevant matching devices 
will appear in the Search Results box.  

 

 

The Search Results box will filter the results as the search criteria more closely 
match the devices in the Map View. 
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Once you have located the relevant device you may configure it directly from the 
Search Results box by right-clicking on the device icon to open the context menu. 

 

 

To locate the device on the Map View itself, simply click on the device row in the 

Search Results box and the icon will flash three times with a red outline: . 

 

14.12. Data Recovery 

For DataNet Loggers 

The ability to recover data when part of the system goes offline or is shutdown is a 
key feature of the DataSuite system.  

Note: USB-enabled DataNet data loggers support data download via USB if wireless 

transfer is not possible. 

When the data loggers are acquiring data they transmit to the Receiver at the 
predefined rate, either directly or via one or more Repeaters.  

There may be occasions when the data transmission fails and the data is not 
updated in real-time in the software window. When this happens, the software has 
several ways of recovering the data so the user will always be able to view all 
samples recorded by the logger. The online system will never lose data i.e. the data 
integrity will always been maintained.  

If the end unit tries to send data to the Receiver but fails, it will continually try to send 
the data until it succeeds. In such a case, the software or workstation may be 
shutdown or its parent unit, the Repeater, may be offline. Or the end unit itself may 
go offline due to a drained battery. Once the end unit has reconnected with the 
network, for instance when the software is reopened or the Repeater is back online, it 
will be able to complete the transmission of all its data and the software will be 
updated with this data. The data recovery is all completed automatically and the user 
is not required to perform any specific actions. 

Note: In the Tools > Option menu, select the checkbox to enable automatic data 
download when the software is launched. Otherwise you will have to perform manual 
download from the Logger context menu. 
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For Standalone Loggers 

For DaqLink, MicroLogPRO II and MicroLite loggers, when the units are connected to 
the computer and detected by the DataSuite software, they will automatically begin 
downloading data.  

If they were already connected and streaming online data, and the DataSuite 
software or computer was shutdown, the units will continue to collect data. Upon re-
detection by DataSuite, data will again be downloaded ensuring full data recovery to 
the DataSuite database.  

14.13. Saving Data 

As soon as a logger starts to record data the software creates a data file to which it 
writes the logger data. 

In Windows XP, for example, logger data files are stored in the following default 
location: 

C:\Documents and Settings\All Users\Application Data\fourtec\DataSuite\Data Files 

In Windows 7, the data files are stored here: 

C:\Users\Public\fourtec\DataSuite 

 

A folder is created for each data logger and is named according to the logger Serial 
Number. In this folder is stored the data files. A file is created for each day that the 
logger is recording data. The file name format is the date followed by the file 
extension e.g. 2007-12-30.dat.  

 

The data is saved automatically by the software. There is no need for the user to 
save the data manually.  

For applications where the data is being streamed online, directly to the software the 
data file is saved as follows: 

 Every 15 minutes  

 When the software is closed 

 When the user opens an archived data file, the file is updated with all data not 
saved to that point 

 

You can also save the data in a text file format. Refer to section ‎14.9.1 for more 
details. 

14.14. Viewing Archived (Offline) Data  

The user can view the logger data online or can choose to open archived data of one 
or more loggers, including loggers of different models. Archived data is all data that 
was logged by a specific logger and recorded by the software into the DataSuite 
directory on the PC.  

Follow the instructions below to open archived data. 

1. Click the Open icon to launch the Open Data Files dialog. 

2. Select the logger from the list of loggers in the dialog. The loggers can be listed in 
ascending or descending order according to logger serial number or comment by 
clicking the relevant header.  
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3. Using the calendar define the date and time period for which you wish to view 
your data and click OK. 

Note: The DataSuite data file path is displayed at the top of the Open Data Files 

dialog. 

  

Figure 81: Open Data Files dialog 

 

4. In the Sync Data dialog, you can select the sampling rate at which you wish to 
display the data. The default option is the original rate. Click OK. 

 

Figure 82: Sync Data dialog 

 

The data is opened in History View. Refer to section ‎14.5.3 for an explanation of the 
History View.  

You may display data sets from more than one logger and display them all in History 
View, using the Data Map to navigate through the data. Refer to section ‎14.5.4 for 
more details regarding the Data Map. 
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14.15. Viewing Online Data 

You can view the data from any of your loggers in real-time, as the data is being 
recorded and transmitted to the PC. For DataNet units, the Receiver must be 
connected and the network up and running. For all other standalone loggers, the 
units must be connected via USB cable to the DataSuite software to enable online 
data view. 

 While the logger is running double click the Logger icon in the Map View. 

 While the logger is running open the logger context menu and select Display 
Data. 

 

Figure 83: Online data window 

 

The data displayed in this window is the data that was transmitted by the logger in 
the current software session. Data transmitted during a previous session of the 
software being open will not be displayed. For example, when you setup the logger it 
creates a new online session. This data can be viewed by opening archived data. 
Refer to section ‎14.14. 

You may view the data in a graph or table by clicking the relevant tabs in the online 
data window. While in either or these views, the data is constantly being updated in 
real-time in the respective view according to the transmission rate of the logger.  

Note: Users of Windows 7 using right to left language settings e.g. Hebrew, may 
have problems viewing the Date/Time in the DataNet graph. This is a know Microsoft 
® bug. Until a bug fix is released, change the Regional Settings to English. 

14.15.1. Showing/Hiding the Data Sets 

In the online graph display, where you have data from only one logger displayed, you 
can show or hide the individual sensor data by using the sensor labels at the bottom 
of the graph. 
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In the screenshot above you can see two labels, Internal Digital Temperature and Int 
RH. At present, each label is active meaning the sensor data corresponding to the 
label is shown on the graph. 

By clicking any of the sensor labels, you can hide the data from the graph. The label 
will then be grayed out. See the screenshot below: 

 

Note: You can hide all of the sensor labels (not plots) from the graph by clicking the 

Plot Legend icon . 

14.16. Working in Map View 

The Map View is the main view from which you monitor your connected devices. It is 
in this view that you can see all the icons representing the units in your system.  

Refer to section ‎14.5.1 for a quick overview of the Map View and section ‎14.5.5 for a 
list of all the Map View icons. 

14.16.1. Loading Map View Wallpaper 

You can load an image file representing a map of your facility in which the network is 
operating. You can then move the unit icons into their actual positions on the map. 

 Double-click on the Map View background to go straight into the Open dialog and 
locate the image file. 

 Right-click on the Map View background to open the context menu and select the 
option to either Load or Reset the wallpaper. 

Note: When deploying the system for the first time it is highly recommended to use a 
map of the facility to make the deployment work efficiently. 

14.16.2. Printing the Map View 

To print the Map View go to File > Print Map View. This will also print the icon name 
tags and network paths, if enabled.  
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The Map View maintains its aspect ratio when printed. 

14.16.3. Displaying Icon Name Tags 

You can display a name tag for each device on the Map View. The name tag consists 

of the unit Comment, as defined in the unit Setup:   

To toggle this feature, right-click on the Map View background and select Display All 
Units' Name. 

When this feature is enabled, clicking the unit icon will also highlight the name tag in 
red. 

14.16.4. Moving Icons around the Screen 

Go to Tools > Lock Map View and ensure this menu item is not selected in order to 
freely move the unit icons around the screen. When you have finished placing the 
icons into position you may then lock the Map View so as not to mistakenly place an 
icon out of position. 

14.16.5. DataNet Multiple Network Connections 

DataSuite supports connection of more than one DataNet Receiver simultaneously. This 

means that you are able to manage multiple DataNet networks from one DataSuite interface.  

With a Map View featuring many device icons, to identify which network each device belongs 
to, each device tooltip includes the network name and unique ID. In addition, when scrolling 
over the Receiver icon with the mouse, all devices associated to that Receiver’s network is 

highlighted by a green frame.  

 

14.16.6. DataNet Logger Icon Context Menu – Wireless 

Connection Options 

Right clicking the DataNet Logger icon when connected wirelessly to the network will 
give the following options: 

Display Data 

Displays the logger’s data in Graph view. The graph displays the data in real-time. 
There is also the option to display the data in Table view or to view the data statistics. 

Download Data 

Downloads all data in the logger memory to the DataSuite software. When logger is 
downloading the data, the Logger icon in Map View will appear as follows: 
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Note: Data download is also available via USB connection. Refer to section ‎14.16.7. 

  

Cancel Download 

When logger is downloading data you may cancel the download per logger by 
selecting this menu item. 

As cancelling the data download results in data not being downloaded to the 
computer, there is a chance that data may be lost if the download isn’t completed at 
a later stage and the logger’s cyclic memory has meanwhile erased these readings.  

Note: Cancel Download feature works only if there are no other commands in the 
queue following the Download process. For example, if the data is downloading and 
you sent the command Call Unit to the logger, and then selected Cancel Download, 
the download will not be cancelled.   

 

Reset Alarm 

When the logger is in a state of alarm, this option will reset the alarm state to normal 
on both the logger and the software. The visual and audible alarms will return to 
normal. If after reset the logger is still in alarm conditions, then the visible and audible 
alarms will return. 

 

Call Unit (Beep) 

This feature sends a command to the logger to emit intermittent audible beeps for up 
to one minute. This is useful when trying to physically locate a logger in your facility. 

Press the Menu button on the logger to stop the audible alarm. 

 

Calibration 

Refer to section ‎14.19.4 on page 194 for an overview of the Calibration feature. 

Note: A logger can’t be calibrated while it is in Run mode. The option will be grayed 

out. You must Stop the logger first. 

 

Update Firmware 

Refer to section ‎15.2 on page 218 for an overview of the Update Firmware feature. 

  

Leave Network 

Selecting this feature will kick the logger off the network. The logger will reset and will 
start scanning for a new network to join.  

You will be prompted to enter a password when selecting this feature.  

Note: The default password is 1234. 

 

Setup  

Refer to section ‎14.17 on page 175 for an overview of how to setup the logger. 
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Multi-Setup  

By using multi-setup you can select more than one logger on the Map View and send 
the same configuration to all of the loggers. When this option is selected, a dialog will 
open listing all of the loggers in the multi-setup selection. 

 

Stop 

Sends a command to the logger to stop logging data. 

 

Multi-Stop 

Sends a command to multiple loggers to stop logging data. 

Run 

Sends a command to the logger to start logging data. This command will also clear 
the existing logger memory. 

 

Multi-Run 

Sends a command to multiple loggers to start logging data. This command will also 
clear the existing logger memory. 

 

Show Network Path 

Displays the path of the logger RF data transmission to the Receiver. The 
Transmission Strength legend appears in the bottom right of the screen when this 
feature is enabled. Refer to section ‎14.7.2 for more details. 

 

Enable/Disable Short Range Repeater 

Changes the unit between Logger mode and Short Range Repeater (SRR) mode, 
whereby the logger operates as both a logger and Repeater.  

Note: In SRR mode the logger must be connected to AC power at all times as the 

power consumption is much greater. 

The logger tooltip and logger LCD menu will both indicate that the unit is in SRR 
mode.  

 

Remove 

This option removes from the Map View any icons of loggers that are not on the 
network anymore and so are irrelevant.  

 

Turn Off 

This option will turn the unit off and is password enabled. As a precaution to avoid 
any data loss all data not yet transmitted will first be downloaded to the computer 
prior to turning the unit off. 

14.16.7. DataNet Logger Icon Context Menu – USB 

Connection Options 

When connected to the computer via mini-USB cable, the DNL910, DNL920 and PA 
models supports the following features: 
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 Data Download – Downloads logger memory directly to the DataSuite data files 
folder. To view the data refer to section ‎14.14. 

 Firmware Update – Refer to section ‎15.2.4 for more details. 

 Turn Off – Turns off the unit. 

 

To detect the logger using USB: 

1. Make sure the data logger is joined to an existing network. When connected to 
the computer via USB go to Devices > Detect Device in the DataSuite main 
menu. 

2. Right-click on the logger USB icon  to open the context menu and select one 
of the relevant options. 

14.16.8. Viewing DataNet Logger Status  

When you scroll the mouse cursor over the Logger icon a tooltip will pop up 
displaying data relevant to the Logger status at the time. 

 

Logger Tooltip 

The tooltip will always display the following data, even if offline:  

 Network Name 

 Network ID 

 Logger Type 

 Serial Number 

 Logger Name/Comment 

 

When the logger is online and running the following tooltip is displayed: 

DataNet Logger Tooltip 

 

In online mode, the logger also displays:  

 Device mode – Logger or Short Range Repeater 

 The power status (% Battery left or Connected to AC) 

 Reception quality: Strength of RF signal between logger and Receiver 

 Version number: Firmware version of the logger 

 Last sample time: If logger is running, time stamp of last recorded sample.  
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 Real-time Sensor values: All sensor values are displayed, including sensor name 
and alarm status. 

 

DataNet Command Queue Progress 

The tooltip is updated with specific commands being performed by the DataNet 
logger. For example, if the logger is downloading data to the software you can see 
the progress in the tooltip. In addition, the Logger icon has a blue progress indicator 
so you can monitor the progress without using the tooltip.  

 

Common commands include Download, Setup, Stop, Run, Beep and more. 

14.16.9. DataNet Receiver Icon Context Menu 

Right clicking the Receiver icon will give the following options: 

 Setup 

 Update Firmware 

 Lock Network 

 Form New Network 

 Refresh Network Connections 

 Show Network Paths 

 Mini DataNet Device Filter 

 Change to Repeater 

 

 

Setup  

Receiver Setup lets the user change the name of the network name assigned to that 
specific Receiver. The network name appears in the tooltip of every device 
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connected to that network. Click Setup to implement the change or Close to close 
the dialog without making any changes. 

 

Update Firmware 

Selecting this option will launch the Receiver firmware update process. Refer to 
section ‎15.2 for more details. 

 

Lock Network 

By locking the network you do not allow any additional units to join the network. 
During the network scan, the logger will not even detect the network if it is locked. 

By unlocking the network you leave it open for any unit to join the network, even if 
you do not wish them to. 

 

Form New Network 

Select this option to form a new network on the Receiver. The Receiver will then form 
a new network based on your RF environment. This will ensure optimal network 
performance. 
Refer to section ‎3.8 for more details on optimizing the performance. 

Once a new network is formed, any loggers connected to the old network will need to 
rescan and join the new network. This must be done manually by going to each 
logger and resetting it via the LCD menu options. 

 

Refresh Network Connections 

Use this feature to send a command to the Receiver to re-establish connection to the 
end units in its specific network. This is useful when wanting to ensure the network 
connectivity is performing optimally without any delay or lag due to changes in 
environmental conditions or location of the end units. Such delays can explain logger 
icons not displaying the correct information or commands not being sent promptly to 
the end units. 

Note: The software automatically refreshes the network connections every 10 

minutes. 

 

Show Network Paths 

While in Map View, enable this option to display the path that the RF signal of all 
units in the network takes to reach the Receiver. If Repeaters are used in the network 
it will show the signal routed via the Repeater, en route to the Receiver.  
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The paths are color-coded so you can also see the transmission strength. A legend 
appears at the bottom of the window.  

 

 Red = Low (0 to 23% strength) 

 Yellow = Medium (23 to 56%) 

 Green = High (56 to 100%) 

 

Mini DataNet Device Filter 

When working with Mini DataNet units, in order for the device to be allowed onto the 
DataNet network, the device Serial Number must first be added to the Device Filter. 

Refer to section ‎3.5.3 for more details.  

 

Change to Repeater 

Use this feature to convert the unit from Receiver to Repeater mode. Do not perform 
this operation on a Receiver with a dedicated network as the network and all related 
devices will then go offline. 

14.16.10. Viewing DataNet Receiver Status  

When you scroll the mouse cursor over the Receiver icon a tooltip will pop up 
displaying data relevant to the Receiver status at the time. 

 

Receiver Tooltip 

The tooltip will always display the following data, even if offline:  

 Unit type (Receiver)  

 

When the Receiver is online the following tooltip is displayed: 
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In online mode, the Receiver also displays:  

 Serial Number 

 Network: The Network ID of the currently formed network 

 Version: Firmware version of Receiver 

14.16.11.  DataNet Repeater Icon Context Menu – Wireless 

Connection Options 

Right clicking the Repeater icon will give the following options: 

Setup  

Repeater Setup lets the user change the name of the unit. Once the name has been 
changed, click Setup (or Close to close the dialog without making any changes). 

 

Multi-Setup  

By using multi-setup you can select more than one Repeater on the Map View and 
send the same configuration to all of the Repeaters. 

  

Call Unit (Beep) 

This feature sends a command to the Repeater to emit intermittent audible beeps for 
up to one minute. This is useful when trying to physically locate a logger in your 
facility. 

Press the Menu button on the Repeater to stop the audible alarm. 

 

Leave Network 

Selecting this feature will kick the Repeater off the network.  

You will be prompted to enter a password when selecting this feature.  

Note: The default password is 1234.  

 

Update Firmware 

Selecting this option will launch the Repeater firmware update process. Refer to 
section ‎15.2 for more details. 

 

Show Network Path 

Displays the path of the Repeater RF data transmission to the Receiver. The 
Transmission Strength legend appears in the bottom right of the screen when this 
feature is enabled. Refer to section ‎14.7.2 for more details. 

 

Remove 

This option removes from the Map View any Repeater icons that are not on the 
network anymore and so are irrelevant.  
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14.16.12.  DataNet Repeater Icon Context Menu – USB 
Connection Options 

Update Firmware 

Selecting this option will launch the Repeater firmware update process. Refer to 
section ‎15.2 for more details. 

 

Turn Off 

This option will turn the unit off and is password enabled.  

 

Change to Receiver 

This option will change the Repeater to Receiver mode, and form a network. If the 
Repeater has end units connected to it, performing this option could result in units 
losing their connection to the network.  

 

Change to Substitute Receiver 

In the event that a Receiver is no longer working, any existing Repeater on the 
Receiver’s network can be transformed into a Substitute Receiver, to enable the 
network to continue working in online mode. 

14.16.13.  Viewing Repeater Status  

When you scroll the mouse cursor over the Repeater icon a tooltip will pop up 
displaying data relevant to the Repeater status at the time. 

Repeater Tooltip 

The tooltip will always display the following data, even if offline:  

 Unit type (Router)  

 Serial Number 

 Repeater Name/Comment 

 

When the Repeater is online the following tooltip is displayed: 

 

In online mode, the Repeater also displays:  

 The Power status (% battery left or Connected to AC) 

 Reception quality: Strength of RF signal between logger and Receiver 

 Version: Firmware version of Repeater 
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14.16.14.  DaqLink Logger Icon Connection Options 

Right-clicking the DaqLink logger icon will give the following options: 

 

Display Data 

Displays the logger’s data in Graph view. The graph displays the data in real-time. 
There is also the option to display the data in Table view or to view the data statistics. 

Download Data 

Downloads all data in the logger memory to the DataSuite software. When logger is 
downloading the data, the Logger icon in Map View will appear as follows: 

 

 

Cancel Download 

When logger is downloading data you may cancel the download per logger by 
selecting this menu item. 

Note: This feature works only if there are no other commands in the queue following 
the Download process.  

 

Reset Alarm 

When the logger is in a state of alarm, this option will reset the alarm state to normal 
on both the logger and the software. The visual and audible alarms will return to 
normal. If after reset the logger is still in alarm conditions, then the visible and audible 
alarms will return. 

 

Calibration 

Refer to section ‎14.19.4 on page 194 for an overview of the Calibration feature. 

Note: A logger can’t be calibrated while it is in Run mode. The option will be grayed 

out. You must Stop the logger first. 

 

Cancel Firmware Update 

When a firmware update is in progress, select this option to cancel the update and 
continue using the previous firmware version. 

Setup  

Refer to section ‎14.17 on page 175 for an overview of how to setup the logger. 

 

Stop 

Sends a command to the logger to stop logging data. 

 

Run 

Sends a command to the logger to start logging data. This command will also clear 
the existing logger memory. 
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Turn Off 

This option will turn the unit off and is password enabled. As a precaution to avoid 
any data loss all data not yet transmitted will first be downloaded to the computer 
prior to turning the unit off. 

14.16.15. MicroLite Logger Icon Connection Options 

When connected to the computer via USB, the MicroLite models support the 
following features: 

Display Data 

Displays the logger’s data in Graph view. The graph displays the data in real-time. 
There is also the option to display the data in Table view or to view the data statistics. 

Note: MicroLite II models with external input caps (4-20 mA, 0-10 V and NTC 

Temperature) do not support online, real-time data view. 

 

Download Data 

Downloads all data in the logger memory to the DataSuite software. When logger is 
downloading the data, the Logger icon in Map View will appear as follows: 

 

  

Cancel Download 

When logger is downloading data you may cancel the download per logger by 
selecting this menu item. 

As cancelling the data download results in data not being downloaded to the 
computer, there is a chance that data may be lost if the download isn’t completed at 
a later stage and the logger’s cyclic memory has meanwhile erased these readings.  

 

Reset Alarm 

When the logger is in a state of alarm, this option will reset the alarm state to normal 
on both the logger and the software. The visual and audible alarms will return to 
normal. If after reset the logger is still in alarm conditions, then the visible and audible 
alarms will return. 

 

Calibration 

Refer to section ‎14.19.4 on page 194 for an overview of the Calibration feature. 

Note: A logger can’t be calibrated while it is in Run mode. The option will be grayed 
out. You must Stop the logger first. 

 

Update Firmware 

Selecting this feature will commence update of the logger firmware, as long as the 
firmware file is situated in the main DataSuite directory.  

Note: If the logger is currently in Push to Run or Timer Run mode, Update Firmware 

option will be disabled. 
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Setup  

Refer to section ‎14.17 on page 175 for an overview of how to setup the logger. 

 

Multi-Setup  

By using multi-setup you can select more than one logger on the Map View and send 
the same configuration to all of the loggers. When this option is selected, a dialog will 
open listing all of the loggers in the multi-setup selection. 

 

Stop 

Sends a command to the logger to stop logging data. 

 

Run 

Sends a command to the logger to start logging data. This command will also clear 
the existing logger memory. 

 

Remove 

This option removes from the Map View any icons of loggers that are not on the 
network anymore and so are irrelevant.  

14.16.16.  Viewing MicroLite Logger Status  

MicroLite Logger Tooltip 

 

In online mode, the logger displays:  

 Device model and memory size 

 Serial Number 

 Device Name 

 Power status (% Battery left) 

 Logger firmware version number 

 Last sample time: If logger is running, time stamp of last recorded sample.  

 Real-time Sensor values: All sensor values are displayed, including sensor name 
and alarm status.  

14.16.17. MicroLogPRO II Logger Icon Connection Options 

When connected to the computer via mini-USB cable, the MicroLogPRO II models 
support the following features: 
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Display Data 

Displays the logger’s data in Graph view. The graph displays the data in real-time. 
There is also the option to display the data in Table view or to view the data statistics. 

 

Download Data 

Downloads all data in the logger memory to the DataSuite software. When logger is 
downloading the data, the Logger icon in Map View will appear as follows: 

 

  

Cancel Download 

When logger is downloading data you may cancel the download per logger by 
selecting this menu item. 

As cancelling the data download results in data not being downloaded to the 
computer, there is a chance that data may be lost if the download isn’t completed at 
a later stage and the logger’s cyclic memory has meanwhile erased these readings.  

 

Reset Alarm 

When the logger is in a state of alarm, this option will reset the alarm state to normal 
on both the logger and the software. The visual and audible alarms will return to 
normal. If after reset the logger is still in alarm conditions, then the visible and audible 
alarms will return. 

 

Calibration 

Refer to section ‎14.19.4 on page 194 for an overview of the Calibration feature. 

Note: A logger can’t be calibrated while it is in Run mode. The option will be grayed 

out. You must Stop the logger first. 

 

Update Firmware 

Selecting this feature will commence update of the logger firmware, as long as the 
firmware file is situated in the main DataSuite directory.  

Note: If the logger is currently in Push to Run or Timer Run mode, Update Firmware 
option will be disabled. 

  

Setup  

Refer to section ‎14.17 on page 175 for an overview of how to setup the logger. 

 

Multi-Setup  

By using multi-setup you can select more than one logger on the Map View and send 
the same configuration to all of the loggers. When this option is selected, a dialog will 
open listing all of the loggers in the multi-setup selection. 

 

Stop 

Sends a command to the logger to stop logging data. 
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Run 

Sends a command to the logger to start logging data. This command will also clear 
the existing logger memory. 

 

Remove 

This option removes from the Map View any icons of loggers that are not on the 
network anymore and so are irrelevant.  

14.16.18.  Viewing MicroLogPRO II Logger Status  

MicroLogPRO II Logger Tooltip 

 

In online mode, the logger also displays:  

 Device model – EC800 or EC850 

 The power status (% Battery left) 

 Version number: Firmware version of the logger 

 Last sample time: If logger is running, time stamp of last recorded sample.  

 Real-time Sensor values: All sensor values are displayed, including sensor name 
and alarm status. 

14.17. Configuring the Logger 

DataSuite software allows you to configure each logger, via direct USB connection or 
wirelessly in the case of DataNet.  

To configure the logger once it’s detected by the DataSuite software, right-click the 
Logger icon in the Map View and select Setup. 

The DataNet, DaqLink, MicroLite and MicroLogPRO II setup dialogs differ, as each 
model has different parameters. Each Setup window is described below. 

14.17.1. DataNet Setup Window – Device Setup Tab 

The DataNet Setup window has two tabs, Device Setup and Alarm Setup. 

The main logger configuration is performed on the Device Setup tab. Any alarm 
levels you wish to configure is performed on the Alarm Setup tab. 

 



 

181 

 

Figure 84: DataNet Device Setup tab 

 

Comment 

This is the name of the logger. It is advisable to name the logger according to the 
location in the facility. 

Note: The Comment field in the software and on the logger display supports all 
standard alphanumeric characters except for the following: ', ", ~, &, \  

 

Sampling Rate 

Sampling rate is one sample per second to one sample per 18 hours. However, there 
are programming limitations you must be aware of when configuring the loggers. The 
sampling rate will vary depending on the number and type of sensors you setup. 
Refer to section ‎4.7.5 on page 46. 

 

Transmission Interval 

You can define how often the logger will actually transmit to the network. You may 
wish to have the logger transmit with every sample, if you have slower sampling 
rates, or less frequently, if you have a fast sampling rate. 

The transmission interval must be a multiple of the sampling rate, so for example if 
the sampling rate is 3 seconds, then the minimum transmission rate must be every 3 
seconds, and then every 6 seconds, 9 seconds, and so on. 



 

182 

This parameter was designed to ease the burden on the network if you have many 
loggers as each logger can transmit at different rates. 

Averaging Points 

You can choose have online averaging of up to 10 points around the real value in 
order to smooth the data readings, if they are a little noisy. The recommended 
averaging is 4 samples. 

 

Temperature Units  

Toggle between °C and °F. This applies to the readings displayed on the logger LCD 
as well as in the software.   

 

Active Sensors  

Depending on the logger model, you can activate up to two internal sensors and four 
external sensors. Simply select the inputs you want to use and then select the sensor 
types from the adjacent drop-down menu. You don’t have to select the external 
sensor input in any order. You may select only Input 4 if you desire. 

Note: On the DNL920 you cannot run the humidity sensor without running the 
temperature sensor in parallel. 

This is because when using the DNL920 data logger and selecting the internal 
humidity sensor in the Device Setup dialog, the internal digital temperature sensor 
will automatically be selected as well. This sensor provides the temperature 
compensation necessary for the humidity sensor to reach the 3% accuracy as stated 
in the sensor specifications. It is not used for recording temperature. The internal 

digital sensor is used to record temperature on the DNL920. 

 

Custom Sensor Names  

You can also give the sensor a custom name, which will appear in the software when 
viewing the data. This is convenient when using several of the same type of sensors 
and you wish to differentiate between them in terms of their environment or material it 
is measuring. 

 

Recording Time 

This field displays the length of time the logger memory will be able to record for 
depending upon the number of sensors used and sampling rate. 

 

Setup and Run 

Clicking Setup and Run will send the setup to the logger and immediately start 
logging data. 

 

Setup Only 

Clicking Setup Only will send the setup to the logger but it will not actually start 
logging data. You will need to select Run from the Logger context menu or go back 
into the Setup dialog.  

 

Close  

Clicking Close will close the Setup dialog without saving any of your configurations. 



 

183 

Note: Running the logger clears the logger memory. All previously recorded data will 
be erased when you begin a new logging session. 

14.17.2. DaqLink Setup Window – Device Setup Tab 

The DaqLink Setup window has two tabs, Device Setup and Alarm Setup. 

The main logger configuration is performed on the Device Setup tab. Any alarm 
levels you wish to configure is performed on the Alarm Setup tab. 

 

Figure 85: DaqLink Device Setup tab 

 

Comment 

This is the name of the logger. It is advisable to name the logger according to the 
location in the facility. 

Note: The Comment field in the software and on the logger display supports all 
standard alphanumeric characters except for the following: ', ", ~, &, \  

 

Sampling Rate 

Sampling rate is one sample per second to one sample per 18 hours. However, there 
are programming limitations you must be aware of when configuring the loggers. The 
sampling rate will vary depending on the number and type of sensors you setup. 
Refer to section ‎7.3.5 on page 84. 
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Memory State 

From the drop-down menu you have the following options: 

 Online Mode:  For working with logger connected to PC. Data will be transmitted 
in real-time i.e. at the same time as the sampling rate. 

 Optimized Memory Mode: For working with the logger as a standalone device, 
not connected to the PC. In this mode, the memory is more efficiently managed 
as the data does not need to be transmitted together with the sampling rate. Use 
the Transmissions interval parameter in the Setup window to see the rate at 
which the data will be displayed on the logger or in the software. 

Note: If used when connected to the PC, the data will not be transmitted in real-time. 

 

Cyclic Mode 

If this checkbox is not selected, the logger will stop recording data when the memory 
capacity is filled.  

Enabling Cyclic mode will result in the oldest samples in the memory being 
overwritten by new samples once the memory is full. This allows continuous data 
logging. 

 

Averaging Points 

You can choose have online averaging of up to 10 points around the real value in 
order to smooth the data readings, if they are a little noisy. The recommended 
averaging is 4 samples. 

Note: If configuring Alarm duration with averaging points selected, the alarm will be 

counted from the time of the last sampling point used to calculate the average.  

Temperature Units  

Toggle between °C and °F. This applies to the readings displayed on the logger LCD 
as well as in the software.   

 

Anti Tamper Mode 

To prevent tampering with the DaqLink logger, selecting this option will disable the 
following features on the logger menu:  

 Pause 

 Reset 

 Stop and turn off unit 

 

Active Sensors  

Depending on the logger model, you can activate up to two internal sensors and four 
external sensors. Simply select the inputs you want to use and then select the sensor 
types from the adjacent drop-down menu. You don’t have to select the external 
sensor input in any order. You may select only Input 4 if you desire. 
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Note: On the DBSA720 you cannot run the humidity sensor without running the 
temperature sensor in parallel. 

This is because when using the DBSA720 data logger and selecting the internal 
humidity sensor in the Device Setup dialog, the internal digital temperature sensor 
will automatically be selected as well. This sensor provides the temperature 
compensation necessary for the humidity sensor to reach the 3% accuracy as stated 
in the sensor specifications. It is not used for recording temperature. The internal 
digital sensor is used to record temperature on the DBSA720. 

Custom Sensor Names  

You can also give the sensor a custom name, which will appear in the software when 
viewing the data. This is convenient when using several of the same type of sensors 
and you wish to differentiate between them in terms of their environment or material it 
is measuring. 

 

Recording Time 

This field displays the length of time the logger memory will be able to record for 
depending upon the number of sensors used and sampling rate. 

 

Setup and Run 

Clicking Setup and Run will send the setup to the logger and immediately start 
logging data. 

 

Setup Only 

Clicking Setup Only will send the setup to the logger but it will not actually start 
logging data. You will need to select Run from the Logger context menu or go back 
into the Setup dialog.  

 

Close  

Clicking Close will close the Setup dialog without saving any of your configurations. 

Note: Running the logger clears the logger memory. All previously recorded data will 

be erased when you begin a new logging session 

14.17.3. DataNet and DaqLink Alarm Setup Tab 

A major feature of the DataNet and DaqLink systems is the ability to configure alarm 
levels into the loggers so any breach of these levels as recorded on the data logger 
is monitored by the software, and the user is notified via Email/SMS/audible and 
visual indicators. 

 

The Alarm Setup tab lets you configure each sensor for the following alarms: 

 Low 

 Pre-Low 

 Pre-High 

 High 

 Contact Open / Contact Close (when the Contact sensor is selected) 
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Using the Pre Alarms gives the user ample warning of a possible breach of real 
alarm levels, so necessary measures can be taken to prevent such a breach.  

Simply select the check box for the type of alarm you wish to be notified. You can 
select all alarms too. Enter the alarm value in the text box. 

 

Figure 86: DataNet and DaqLink Alarm Setup tab 

 

Alarm Delay and Pre-alarm Delay 

The time until the alarm (or pre-alarm) is activated. You may not want to have the 
alarm sound immediately after the alarm level is breached as you are only interested 
in a condition where the alarm level lasted a certain amount of time. 

For example, if monitoring change of temperature in a freezer, you would only be 
interested in a High alarm which lasted more than one minute as anything else could 
just be caused by the freezer door opening for a few seconds, as opposed to a power 
failure leading to rise in temperature.  

 

Alarm Duration 

The duration of the alarm that is set off by one or more sensors breaching the alarm 
level. 

 

Sound Alarm during Pre-alarm 

You also have the option to sound the alarm in the software during a pre-alarm 
scenario, not just for a standard alarm. 
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Once you have configured your alarms, you may return to the Device Setup tab or 
click one of the Setup buttons at the bottom of the tab. 

14.17.4. MicroLite & MicroLogPRO II Setup Window – 

Properties, Sensors and Display Setup  

The MicroLite and MicroLogPRO II Setup window include the following tabs: 
Properties, Sensors and Display. They contain the same parameters for both 
products. 

In addition, the MicroLite II has a tab named Boomerang Report, for configuration of 
the Boomerang feature. Refer to section ‎14.25 on page 212 for more details. 

 

The main logger configuration is performed on the Properties tab. The Sensor and 
Alarm setup is performed on the Sensors tab, and LCD options are available on the 
Display tab. 

 

Figure 87: MicroLogPRO II Properties tab 

 

Properties Tab 

Comment 

This is the name of the logger and supports up to 15 characters. It is advisable to 
name the logger according to the location in the facility. 

Note: The Comment field in the software supports all standard alphanumeric 
characters except for the following: ', ", ~, &, \  

 

Temperature Scale 

Toggle between °C and °F. This applies to the readings displayed on the logger LCD 
as well as in the software.   
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Options 

 Cyclic Run – Select to enable the logger memory to continue running in cyclic 
mode, whereby the logger will not stop once the memory capacity is reached but 
will erase the first samples in memory. If this option is left unchecked, the logger 
will stop when the memory is full. 

 Push to Run – Select to enable logger activation via the device keypad by 
pressing both buttons together to start running (MicroLogPRO II) or via the 
magnet key (MicroLite II). 

 Stop on key press – Select to enable the user to stop the logger running via the 
keypad (MicroLogPRO II) or magnet key (MicroLite II) and not just via the 
software. 

 Stop on sensor disconnect – For MicroLite II External input models only. Select 
to enable the logger to stop recording data, when the external cap is 
disconnected from the main body of the logger. This prevents garbage data being 
recorded when the external sensor is disconnected. 

 Timer Run – Select the time at which the logger should start running. Until that 
time the logger will remain in standby mode. 

 

Sampling Rate 

Sampling rate is one sample per second to one sample per 18 hours. 

 

Averaging Points 

You can choose have online averaging of up to 10 points around the real value in 
order to smooth the data readings, if they are a little noisy. The recommended 
averaging is 4 samples. 

 

Recording Time 

This field displays the length of time the logger memory will be able to record for 
depending upon the number of sensors used and sampling rate. 

 

Setup and Run 

Clicking Setup and Run will send the setup to the logger and immediately start 
logging data. 

 

Setup Only 

Clicking Setup Only will send the setup to the logger but it will not actually start 
logging data. You will need to select Run from the Logger context menu or go back 
into the Setup dialog.  

 

Close  

Clicking Close will close the Setup dialog without saving any of your configurations. 

Note: Running the logger clears the logger memory. All previously recorded data will 

be erased when you begin a new logging session. 
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Sensors Tab 

Use this tab to configure the specific logger inputs which should be run, in addition to 
relevant alarm levels. A major feature of the DataSuite system is the ability to 
configure alarm levels into the loggers so any breach of these levels is recorded on 
the data logger and monitored by the software, if the unit is connected via USB. The 
user may be notified of these alarms via Email/SMS/audible and visual indicators.  

 

 

Alarm Delay 

The time until the alarm is activated. You may not want to have the alarm sound 
immediately after the alarm level is breached as you are only interested in a condition 
where the alarm level lasted a certain amount of time. 

For example, if monitoring change of temperature in a freezer, you would only be 
interested in a High alarm which lasted more than one minute as anything else could 
just be caused by the freezer door opening for a few seconds, as opposed to a power 
failure leading to rise in temperature.  

 

Sensor Configuration 

Select the relevant checkbox to configure the logger internal and/or external sensors 
to be used for measurement. 

To enable Dew Point measurement on the EC850 or MicroLite II RH model, you must 
select both the internal Temperature and Humidity checkboxes. 

After selecting one or more of the sensor checkboxes, the Alarm checkbox is 
enabled. Enter the minimum and maximum alarm levels dependent on your specific 
thresholds. 
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Display Tab 

 

 

The Display tab allows the user to select one of four LCD options: 

 Always On – The LCD will always remain on during logging 

 On for 30, 60 or 120 seconds on key press and alarm – Selecting one of these 
options will result in the LCD coming on for the defined period, after the logger 
keypad is pressed or after an alarm is reached. After the defined number of 
seconds, the logger LCD will shut off again. Even if the LCD is off, the logger is 
continually recording data. 

14.18. Entering Alarm Reason 

In the DataSuite CFR software, and as part of the CFR requirements, any recorded 
sensor alarm must be assigned an explanation why the alarm occurred. 

Whenever an alarm is recorded the Alarm Reason icon will flash in the upper 
DataSuite toolbar. It will continue to flash until all alarms are assigned a Reason. 

When exiting the application a system message will pop up warning that there are 
alarms without an explanation.   

To add an alarm reason: 

1. Click the Alarm Reason icon to open the Update Alarm Reason dialog. 

 

Figure 88: Update Alarm Reason dialog 

1. Select the relevant alarm from the drop-down menu and enter the reason in the 
text box. 

2. Click OK when finishing entering all alarm reason. The Alarm reason icon will 

now be disabled: . 

3. The alarm reasons will be updated in the DatPass database and will appear in 
the DatPass Audit Trail. 

14.19. Alarm Notifications Setup 

Once you have completed the logger alarm setup, you can configure DataSuite to 
send alarm notifications via Email or SMS.  

From the Tools menu select one of the following options, depending on the type of 
notifications required: 
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 Email Alarm Notification 

 SMS Alarm Notification  

Or click the Email  or SMS  icons located in the upper toolbar in order to 
launch the notification dialog. 

Note: To enable sending of Email or SMS first define the Email and SMS settings in 
the Tools > Options dialog. Connect a GSM modem to the PC if sending SMS’s. 
Refer to section ‎14.9 on page 152 for more details. 

 

You may manage your contact list of alarm notification recipients from either the 
Manage Contacts menu item in the Tools menu, or from within the Alarm 
Notification dialog itself. 

 

Figure 89: Alarm Notifications Setup dialog 

 

As the Email and SMS Alarm Notifications must be defined separately, they each 
have separate dialogs. However the interface is identical and the contacts are stored 
in the same database.  

The Email/SMS Notifications dialog is divided into the following tabs: 

 Notifications Setup 

 Contacts tab 

 Groups tab 

14.19.1. Contacts Tab 

The first step is to create the contacts who shall be receiving the notifications. The 
ability to manage contacts is possible from both the Email and SMS Notifications 
dialogs.  

1. Click the Contacts tab and then click Add Contact. 
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Figure 90: Adding a contact 

 

2. In this dialog you must first enter the contact name in the Name field. That is the 
only mandatory field but if you don’t enter at least the phone number or Email 
then they won’t receive any alarm notifications. 

The other fields in the dialog are as follows: 

 Title: Corporate position 

 Phone number: The number the DataSuite software will use to send the 
SMS notification. 

 Note: The phone number field supports the following characters: 0-9, # , *, -, ( 
), +  

 Email: The address the DataSuite software will use to send the Email 
notification. 

 Workday Start and End: You can define the hours in which the contact will 
be eligible to receive the notifications i.e. so they don’t receive SMS or Email 
while in the office, or vice versa. 

 Vacation: You can define when the contact is on vacation so they won’t 
receive any notifications over this period. 

 Number of SMS resends: The number of times DataSuite will send follow-up 
SMS’s with the alarm notification. The maximum is nine resends per alarm. 
The gap between each resend is five minutes. 

Note: In order to stop receiving SMS resends, you can simply send an SMS 

with ‘OK’ in the message body to the GSM SIM card’s phone number.  

3. When the contact details have been entered, click OK. 

4. The contact will be added to the Contacts tab. You may choose to add another 
contact, edit an existing contact or remove a contact from the list. 

14.19.2. Groups Tab 

1. Click the Groups tab and then click Add Group. The Group Details dialog will 
open.  
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Figure 91: Adding a group 

 

2. Enter a Group name and add your existing contacts to the group by selecting the 
checkbox next to the Contact name. 

3. Click OK to create the Group. In the Groups tab you may choose to add a group, 
edit an existing group or remove a group from the list. 

14.19.3. Notifications Setup Tab 

1. Once the contacts have been created you may start defining which contacts 
should receive the alarm notifications. 

2. The pane on the left-hand side of the Notifications Setup tab displays all the 
units, loggers or DataNet Repeaters and their serial numbers, which have been 
configured in your network. You must define the alarm notifications for each unit 
in turn. Select the first unit you wish to define.  

3. The Email or SMS tab is now active for the unit selected in step 1 above. In this 
tab, select the type of alarm for which the notification should be sent in the event 
that the predefined alarm level is breached.  

4. Only the sensors which were configured in the logger Setup, with alarms levels, 
are enabled in this tab. In addition, any online DataNet Repeater will be enabled 
for sending battery alarm or reception alarm notifications. 

 

Figure 92: SMS and Email notification setup 

 

5. Select the checkboxes according to the type of sensor alarm for which 
notifications should be sent. 
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You may also select the following alarms: 

a. Battery alarm: Notification will be sent for low battery alarm when battery 
level is at or drops below 10%. When the battery level goes above 10% 
again, when unit is connected to AC power, another email notification is sent 
stating the battery is charging.  

b. Reception alarm: For DataNet units, an Offline alarm notification will be sent 
when there is no RF reception from a unit. When the unit is back online, an 
Online notification is sent. 

c. Normalized: Notification will be sent when the logger return to normal levels 
having been in alarm. 

6. Click the Contact button adjacent to each of the sensors which have defined 
alarms. In the Select Contact dialog, select the contact and/or group that will 
receive the notification. 

7. You can also click Check All to select all the sensor alarms for notification. 

Note: If the DataNet logger transmission rate is slower than the sampling rate, an 
alarm notification is still sent even if the logger transmission time hasn’t passed. 
For example, if the sampling rate is every 5 minutes, and the transmission rate is 
every 10 minutes, if a logger reaches a high alarm after 7 minutes a notification 
will be sent. The system won’t wait until the scheduled transmission time. 

14.19.4. Email and SMS Notification Formats 

Email Notification Format 

When the Email notification is sent the recipient receives the Email in the following 
format: 

Email Header:  

DataNet Alarm: Internal Temperature High Alarm, Value Detected: 25.47C)  

Email Body: 

DataNet Alarm 

Comment: Factory 1/F  

S/N: 808932 

08-07-09 13:53:41 

Internal Temperature Low Alarm, 

Value Detected: 25.47 C 

The Email header contains the sensor type, last recorded sample, and alarm type. 

In addition the Email body contains the logger comment, serial number, time stamp 
of last sample and value of last sample. 

 

SMS Notification Format 

When the SMS notification is sent the recipient receives the SMS in the following 
format. (The logger comment is displayed in the first row). 

S/N 515244, Test 810#2, Int. Temperature 15/1/10 17:25 – High Alarm, Value 
Detected: 24.24C 
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14.20. Calibration 

All fourtec data loggers are shipped fully calibrated either with a calibration certificate 
or a Declaration of Accuracy certificate. However, DataSuite does provide a simple 
and efficient process for users wishing to calibrate their data loggers themselves. The 
process itself can be performed wirelessly (for DataNet units) or with the unit 
connected via USB cable. As with any data logger calibration a calibrator or other 
type of calibration instrument is necessary. 

 

The Calibration options are accessible via the Logger context menu in the Map View 
(right-clicking the Logger icon).  

Before performing logger calibration, the logger must be in Stop mode. In addition, 
all of the calibration options are accessible with a password making it difficult for non-
authorized users of the system to tamper with the loggers’ calibration settings. 

Note: The default password is 1234. The password can be changed in the password 

dialog box. 

 

The Calibration option menu options are: 

 Calibration: Opens the main Calibration dialog 

 Save Calibration: Saves the logger’s current calibration settings 

 Load Calibration: Loads a logger’s previously saved calibration settings. 

 Reset Calibration: Resets the logger’s calibration settings so that the raw 
hardware data is obtained, without any software calibration applied to these 
values. 

 Restore Factory Calibration Default: Restores the logger’s calibration settings 
to the factory calibration i.e. the calibration settings it received prior to shipment 
from fourtec. 

14.20.1. Introduction to Calibration  

Although the data loggers come fully calibrated, the software enables you to calibrate 
any of the logger sensors, on any input (in the case of the multi-input loggers). The 
calibration parameters are sent to the data logger and stored in its memory.  

DataSuite employs two different calibration methods: Two-point calibration and 
Offset calibration. 

Each sensor can be calibrated using the Two-point calibration method, and then 
tweaked using offset calibration, except for the Thermocouples. These sensors 
require offset calibration only. 

 

DataNet and DaqLink Sensor Inputs 

 

Sensor Type Calibration Method 

Current 4 – 20 mA Two-point calibration 

Humidity 
(Internal) 

Digital Two-point calibration 
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Temperature 
(Internal) 

Digital Two-point calibration 

Temperature 
(Internal)  

PT-100 
Two-point calibration and 
offset 

Temperature PT-100 2-wire 
Two-point calibration and 
offset 

Temperature Thermocouple J Offset calibration 

Temperature Thermocouple K Offset calibration 

Temperature Thermocouple T Offset calibration 

Voltage 0 to 1 V Two-point calibration 

Voltage 0 to 50 mV Two-point calibration 

 

MicroLite Sensor Inputs 

 

Sensor Type Calibration Method 

Temperature 
(Internal) 

Digital  
(LITE5032-RH) 

Two-point calibration and offset 

Temperature 
(Internal)  

NTC  
(LITE5008, 
LITE5008P, 
LITE5016 
LITE5032P) 

Two-point calibration and offset 

Humidity (Internal) 
Digital  
(LITE5032-RH) 

Two-point calibration and offset 

External Current * 
4 – 20 mA 
(LITE5032P-4/20) 

Two-point calibration and offset 

Voltage * 
0 to 10 V 
(LITE5032P-V) 

Two-point calibration and offset 

External 
Temperature * 

NTC 10K  
(LITE5032P-EXT) 

Two-point calibration and offset 

 

* Online calibration is not supported, as external sensor cannot be connected to cap 
while logger is connected to computer via USB 

 

MicroLogPRO II Sensor Inputs 

 

Sensor Type Calibration Method 

Temperature 
(Internal) 

Digital (EC850) 
Two-point calibration and 
offset 

Temperature 
(Internal)  

NTC (EC800) 
Two-point calibration and 
offset 

Humidity 
(Internal) 

Digital (EC850) 
Two-point calibration and 
offset 
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External Current 4 – 20 mA 
Two-point calibration and 
offset 

Voltage 0 to 10 V 
Two-point calibration and 
offset 

External 
Temperature 

NTC 10K  
Two-point calibration and 
offset 

 

Calibration Tips 

Prior to any two-point calibration it is recommended to restore factory calibration 
defaults. 

Prior to calibrating any of the thermocouple sensor types, calibrate the Voltage 50 
mV sensor as this will set the gain (slope) of all thermocouple sensor types.  

After calibrating 50 mV, TC-J, TC-K or TC-T sensor types for all inputs you can refine 
the offset calibration for each input individually. 

You may calibrate all thermocouple sensor types at once, or individually. 

Prior to calibrating the PT-100 input, you must first perform Reset Calibration in the 
Calibration dialog. 

 

Two-point Calibration 

The two-point calibration sets the gain (slope) and offset (intercept) of the sensor's 
conversion function. 

Use the two-point calibration to calibrate all DataNet sensors except for the 
Thermocouples. In some cases you may need to refine your calibration using the fine 
offset tuning tool. 

 

Offset Calibration 

To calibrate the Thermocouple temperature sensors: TC-J, TC-K and TC-T, first 
calibrate the 50 mV sensor type. That will set the slope for all Thermocouple 
temperature sensors. Then proceed to adjust the offset using the Offset calibration 
technique. 
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14.20.2.  Calibrating the Data Logger 

 

Figure 93: Calibration dialog 

 

1. From the Map View, open the Logger context menu and select Stop. 

2. Select Calibration > Calibrate and enter the password in the Password dialog. 

3. Select the sensor you wish to calibrate from the Sensor drop-down menu.  

4. For DataNet/DaqLink loggers, if calibrating an external sensor, select the inputs 
to calibrate. Select All or an individual input, 1 to 4. 

5. Click Apply to send the sensor setup to the logger.   

Note: The calibration process does not delete the logger’s setup prior to calibration. 

Once Calibration is complete the original logger setup will be restored.  

6. If you selected All inputs, then by default the logger will be setup to log data on 
Input 1 during the calibration process. Otherwise, if you selected a specific input, 
it will setup the logger to calibrate on that input.  

 

Logger Data Pane 

The Logger Data pane displays real-time readings on the logger, at a default 
sampling rate of one per second. You can also view the logger’s general status. Use 
the Logger Data pane to verify your logger is properly calibrated.  

The Calibration dialog will enable either Two-point or Offset calibration, or both, 
depending on the sensor selected. 

Note: The calibrated sensor parameters will be saved both in the logger and in the 
software memory, so there is no need to calibrate the logger every time you run the 

software. 

14.20.3. Performing a Two-point Calibration 

To perform a two-point calibration, you must have two reference points to input 
against the real logger sensor values.  
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Figure 94: Two-point calibration window 

 

1. In the Point #1 field, enter the first Reference Value and the corresponding 
Logger Value.  

2. In the Point #2 field, enter the second Reference Value and the corresponding 
Logger Value.  

Note: If you are using a calibrator and the logger is currently displaying the real value 
to be calibrated, press the Copy button to copy the real value to the Logger Value 
text box. 

3. Press Send Calibration to send these values to the logger memory.  

4. Compare the real value in the Logger Data pane to the reference value. If the 
values are within an acceptable margin of error you may close the Calibration 
window, or move on to the next sensor or input. 

5. If the values are still not accurate enough, you can perform Offset calibration to 
tweak with values further. 

Note: fourtec strongly recommends calibrating using the default Reference values 

that appear in the two Reference value text boxes for each sensor. 

14.20.4. Performing an Offset Calibration 

If, after the Two-point calibration procedure, the logger still exhibits some offset value 
use the Offset calibration tool to correct it. 

The offset value is the difference between the value displayed by the logger and the 
reference value. For example if the calibrator is set to 0 °C and the logger reads 1 °C 

the offset value is 1, but if the logger reads 1 °C then the offset value is 1.  

 

To perform an Offset calibration, simply select the Offset calibration radio button to 
enable the Offset text box. For Thermocouples you will only have the option to 
perform an Offset calibration. 

Enter the offset value in the text box and click Send Calibration. Continue to adjust 
the offset accordingly until satisfied with the readings. 

14.20.5. Setting the Offset to a Specific Input 

For DataNet and DaqLink loggers, after setting the offset to all inputs simultaneously, 
you can set the offset of each input separately for even better accuracy.  

To set the offset of a specific input: 

1. Measure two known reference values making sure to use the input you need to 
calibrate. 

2. Enter the offset value as described in section ‎14.20.4 above, making sure to 
select the correct input number instead of All. 
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3. You can repeat the procedure for every input. 

14.20.6. Calibrating the Internal Temperature Sensor on the 

DNL910 

The DNL910’s internal temperature sensor is a PT-100 sensor. Calibration of this 
sensor is performed by calibrating the external PT-100 input i.e. two-point calibration 
followed by offset calibration. 

1. In the Calibration dialog, select PT-100 in the Sensor drop-down menu and select 
All inputs.  

2. Press Setup to proceed.  

3. Connect a calibrator or an actual PT-100 sensor to Input-1. Calibrate the input 
using the reference values. 

Once this calibration procedure is complete both the logger’s internal temperature 
sensor (PT-100) and external PT-100 inputs will be calibrated. 

14.20.7. Calibrating the External PT-100 Sensor Input 

DataNet and DaqLink PT-100 calibration is a standard 2-point calibration followed by 
offset calibration. Once the PT-100 sensor has been selected in the Sensor drop-
down menu, click the Reset Calibration button. Then proceed with the 2-point 
calibration procedure. 

Before each calibration this step must be performed otherwise the calibration will not 
be accurate. 

14.20.8.  Saving Calibration Settings 

At any time you may manually save the logger’s calibration settings locally to your 
PC.  

1. Open the logger context menu, select Calibration > Save Calibration and enter 
the password to access this feature. 

2. The Save As dialog will open. Name the calibration file (with extension .dcf) and 
save it either in the default Calibration folder in the DataNet directory or in a folder 
of your choice.  

14.20.9.  Loading Calibration Settings 

You can load a previously saved DataNet .dcf calibration file at any time to restore a 
logger’s restore specific calibration settings. 

1. Open the logger context menu, select Calibration > Load Calibration and enter 
the password to access this feature. 

2. In the Open dialog, browse to the calibration file you need and click Open. The 
logger will be updated with the new calibration settings. 

14.21. Analyzing the Data 

When in offline (History View) or online data displays, you have a number of features 
for analyzing the on-screen data. The features for analyzing data while in the graph 
display are practically the same when in offline or online mode. 
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14.21.1.  Using the Graph Features 

The following section explains how to use the numerous graph analysis features, 
including an overview of the graph toolbar options. 

Please first refer to section ‎14.5.5: DataSuite Toolbar Icons for a full overview of the 
graph toolbar. 

 

Autoscaling 

Click Autoscale  on the graph toolbar to view the full data display, thereby 
restoring the axis range to its default settings. 

 

Zooming 

To zoom in to a specific area of the graph: 

1. Click Zoom in  on the graph toolbar. 

2. Drag the cursor diagonally to select the area you want to magnify. Release the 
mouse button to zoom in to the selected area. 

3. Click Zoom in  a second time to disable the zoom tool. 

4. Click Autoscale to restore the default display. 

 

Panning 

Use the Pan tool  to pan along the x or y axis or after zooming in, to see any part 
of the graph that is outside the zoomed area. 

1. Click Pan  on the graph toolbar, then click anywhere on the graph and drag 
the mouse to view another area. 

2. Click the Pan icon a second time to disable the Pan tool. 

 

The Cursor 

You can display up to two cursors on the graph simultaneously. 

Use the first cursor to display individual data recording values. 

Use two cursors to display the difference between two coordinate values, to display 
the frequency of periodic data or to select a range of data points. 

 

Figure 95: Example of using two cursors 
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When using two cursors, the Statistics feature will calculate statistics according to the 
data set between the two cursors. 

To display the first cursor: 

Click 1st Cursor  on the graph toolbar. You can drag the cursor with the mouse 
onto any other point on the plot, or onto a different plot. For finer cursor movements 
use the forward and backward keys on the keyboard.  

The coordinate values of the selected point will appear in the information bar at the 
bottom of the graph window. 

 

To display the second cursor: 

Click 2nd Cursor  and drag the cursor with the mouse onto any other point on the 
plot. The information bar will now display the difference between the two coordinate 
values. 

 

To remove the cursors: 

Click the cursor icons a second time. 

 

Grid 

Click the Grid icon  to add a grid to the background of the graph view. To remove 
the grid, click the icon again. 

 

Figure 96: Graph with grid in background 

Show/Hide Time Stamps 

By default, the Time Stamp icon  is enabled to display in the online or offline 
graph, any time stamp marked using the MicroLite or MicroLogPRO II data loggers.  

Refer to section ‎14.21.2 for more details. 

 

Add Custom View 

Whenever the graph in History View is modified, either by using the Zoom tool, 
changing the scale, panning the graph, etc. you have the option to add this customer 
graph view to the Data Map, under the Custom Views node. This will enable you to 
save projects which include the custom graph view for future reference.  

Click the Add Custom View icon  to perform this function. 
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Copying the Graph 

Click the Copy Graph icon  to copy the graph to the clipboard, and paste it into 
another application, such as a word processing or spreadsheet application. 

 

Displaying Alarm Levels 

Open the Alarm drop-down menu and select the relevant sensor to display its alarm 
levels.  

 

 

The Stretch/Compress Axis Tool 

Move the cursor onto one of the graph axes. The cursor icon changes to the double 
arrow symbol (↔), indicating that you can stretch or compress the axis scale. Drag 
the cursor to the desired location. Repeat the procedure for the other axis if 
necessary. 

To select a data set to display on the Y-axis, click on the data set’s name in the 
Y-axis list. To display more than one curve, click on the data sets you want. 

 

Formatting the Graph  

You can change the plot line’s color and width. The color of the Y-axis matches the 
corresponding plot’s color and will automatically change with any change made to the 
color of the corresponding plot.  

1. Click Graph properties  on the graph toolbar. 

2. Click the Style tab, and unselect the Use system line properties checkbox.  

3. Select the axis you want to format in the Axis drop-down menu. 

4. Select the color and line width.  

5. Click OK. 

6. To restore the default formatting, select the Use system line properties 
checkbox again.  

 

Manual Scaling 

1. Click Graph properties  on the graph toolbar. 

2. Select the Axis Scaling tab and with the Group plots by units checkbox 
unselected, select the axis to manually scale from the drop-down menu e.g. Date 
& Time axis.  

3. Uncheck the Autoscale check box and enter the custom values in the text box 
i.e. a time range, in the case of the Time & Date axis, or a set of values.  

4. Click OK. 

5. To restore auto scaling select the Autoscale checkbox.  

 



 

204 

Manual Scaling - Grouping Plots by Unit 

You may choose to group all of the sensors measuring the same unit, to the same 
scale. For example, if you have several temperature sensors in your data set, all 
measuring Celsius, you can apply a common scale when displaying the data from 
these sensors. 

1. Click Graph properties  on the graph toolbar. 

2. Select the Axis Scaling tab and select the Group plots by units checkbox. 

3. In the Axis drop-down menu select the unit by which you wish to group the plots.  

4. Uncheck the Autoscale check box and enter the custom values in the text box.  

5. Click OK. 

6. To restore auto scaling select the Autoscale checkbox.  

 

Figure 97: Grouping plots by units 

14.21.2. Viewing Time Stamps 

MicroLite or MicroLogPRO II users may mark time stamps on the logger memory to 
indicate specific events, and later view them in DataSuite software.  

In  the Online and Offline graph views, the lower toolbar features a Time Stamp icon 

. By default it is enabled to display all time stamps marked in the current data set.  

Each time stamp is marked as a large dot in the same color as the sensor plot: 

 

 

Scrolling over the time stamp marker will display the time stamp comment, which by 
default is the time stamp of the sample itself. 

 

Viewing the time stamp in Table View 

Each time stamp is displayed in the data table in addition to the regular samples 
taken at the defined sampling rate. The time stamp is highlighted in yellow, and a 
default comment is listed in the Comment column, per device. 

To edit the time stamp comment simply click on the relevant cell and enter the 
desired comment.  
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Statistics View 

The Statistics View also includes the time stamp when calculating Min, Max, and 
average. 

 

Export to Excel 

Time stamps are also exported to Excel along with the rest of the data set. 

Each time stamp is easily indicated by its comment in the Time Stamp Comment 
column: 

 

 

14.21.3. Changing the Graph, Table or Statistics View Header 

Each Graph, Table or Statistics tab has a header located above the specific view. 
The default headers are: 

 DataSuite - Graph 

 DataSuite - Table 

 DataSuite - Statistics    

The header will also be included when printing the graph.  

To change the header: 

1. Click Graph Properties  on the graph toolbar. 

2. Click the Style tab and enter the graph header in the Header field.  
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14.21.4. Statistical Analysis 

DataSuite also provides some basis statistics regarding the open data sets. While in 
History View or online Data Display view, click the Statistics tab.  

For each of the sensors in the data set, you will have the following statistics 
displayed: 

 Minimum / Maximum values 

 Average value 

 Number of samples 

You will also see the Logger name and SN, as well as the start and end time of the 
statistics data range. 

While in online mode these statistics are updated in real-time. 

If you zoom onto a section of the graph, the statistics are dynamic and will therefore 
display statistics of the zoomed graph, not of the whole graph.  

If using the cursors, the statistics will be calculated according to the data set between 
the two cursors. 

 

 

Figure 98: Statistics View 

14.22. Exporting Data to Excel or CSV Formats 

DataSuite supports exporting data to Excel or CSV file formats (CSV stands for 
comma separated values).  

To export to Excel, click Export to Excel  in the online or offline lower graph 
toolbar, or go to Analysis > Export to Excel (while viewing data in History View). 
The data currently displayed on the graph is exported. Data from more than one data 
logger may be exported simultaneously.  

DataSuite will then open a new Excel workbook displaying the data as well as other 
pertinent information such as logger comment, serial number and the alarm level 
setup. Data that exceeds any of the alarm levels will be indicated. 

 

Figure 99: Example of data exported to Excel 
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Only offline data opened in History View can be exported to CSV and is available 
under the Analysis menu.  

14.23. Printing the Data 

You are able to print data by clicking the Print icon  from the lower toolbar in 
Graph, Table or Statistics tabs of the offline or online data displays. Clicking the Print 
icon will open the Print Setup dialog where you will need to select the printer to print 
to. 

When printing a table, you can select the specific data range you wish to print. You 
are able to adjust the date and time in order to narrow the data range. 

 

Figure 100: Printing a table 

14.24. Reports Module 

The Reports module provides an intuitive interface for creating and generating 
DataSuite reports. Each report contains a wide range of parameters garnered from 
all units supported by the software. Each report can be sent via e-mail to a selected 
distribution list, at pre-defined time intervals, in PDF and Excel format. 

 

All reports are saved in the default directory:  

C:\Program Files\fourtec\DataSuite\Reports 

To change this path go to the Preferences tab in Tools > Options.  

14.24.1. Creating a Report Profile 

The first step when creating a report is to create a new Report Profile. The user can 
create multiple profiles, each configured with different parameters. To generate a 
report, at least one profile must be enabled. 

1. Go to Reports > Reports Profile Manager in the main menu, or click the 

corresponding icon  in the upper toolbar. 

2. Enter the system password. The Reports Profile Manager window will open.  

3. Click Create New Profile. 
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Figure 101: Reports Profile Manager window 

4. Select the Enable Report Profile checkbox to enable all fields in the window. 
Each profile that is enabled will have a report generated. If no profiles are 
enabled, DataNet will not generate any reports. 

5. Enter a suitable profile name in the Profile Name field. 

6. Enter your name in the Report Generated By field. 

7. Enter a description of the report in the Report Comment field. 

8. Each report created in PDF format contains a header. To change the report’s 
header, select the PDF Header Image checkbox and click Browse to locate the 
relevant image. The default fourtec header is: 

9.  

Note: The recommended header dimensions are 525 x 50 pixels, 72 dpi. If a header 
with different dimensions is loaded, then the software will automatically resize the 
header dimensions. 

10. Toggle the temperature unit to appear on the report, if any of the logger’s are 
configured to measure temperature. 

11. Next to Report Format, select the checkbox next to the required format in which 
to generate the report. Excel, PDF or both formats. For PDF format, select the 
page size, A4 or Letter, from the drop-down menu. 

12. Click the Generated Report checkbox to send the report via email to a selected 
distribution list. Click Contacts to open your contact list and select the relevant 
contacts to receive the report via e-mail. If your contact list is empty then the 
Select Contacts window will automatically open when first clicking Generated 
Report. 

Note: To send reports via e-mail, ensure the DataSuite e-mail settings are 
correctly configured in Tools > Options > e-mail Settings. 

13. The DataSuite CFR module provides the ability to send reports for Review and 
Approval by users with specific privileges to review and/or approve reports 
generated by the software. Select Reviewed Report and/or Approved Report and 
select the required contacts from the Contacts dialog. Recipients of these reports 
will be able to enter the DataSuite CFR using their assigned username and in the 
Reports Browser, declare the report was reviewed or approved. 

14. In the Report Type pane, select at least one of the report type checkboxes. You 
will not be able to save the profile unless a report type has been selected.  
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15. The available types are below. For more details regarding each type, refer to 
section ‎14.24.2: 

 Alarm Log 

 Events Log 

 Unit Setup Log 

 Unit Statistics 

 Sent Email Log 

 Sent SMS Log 

 Received SMS Log 

 Sensors Graph 

 Sensor Histogram 

16. Once a Report Type has been selected, immediately click Save Profile to avoid 
losing your unsaved profile. 

17. Use the Report Time pane to select the interval when the report will be 
generated and emailed to the contact list (if desired): 

a. Next to Generate Report at select the time when the report should be 
generated.  

Note: To allow for data samples recorded in the last minute prior to the 
defined time, the report will actually be generated 10 minutes after the defined 
time.  

b. Select the date when the report should be generated. The options are daily, 
weekly or monthly. Select the specific day for the latter two options. 

c. The user can also select a report according to a specific time period. Select 
the User Defined option, choose the period and click Generate to manually 
generate the report according to the defined parameters. 

18. Use the Units pane to select which loggers should be included on the report 
itself.  

a. Select the All Units checkbox to include all network units.  

b. To include a specific selection of units, unselect the All Units checkbox and 
manually select the checkbox for each unit.  

c. The order in which the units will appear on the report can be defined 
according to Serial Number by selecting By S/N and clicking the S/N header 
or manually, by selecting Manual and clicking the Up and Down arrows. 

d. The definition of the report is now complete. Click Save Profile and then 
Close to exit the Reports Profiles Manager. A report will be generated at the 
defined time. 

14.24.2. Report Types 

Each report contains at least one Report Type, with the data displayed in table 
format. A description of each Report Type parameter in the Reports Profile Manager 
is provided below. 

 

Alarm Log 

 Parameters include sensor name, setup, alarm parameters, and setup time. In 
addition, each sensor alarm value is listed according to the relevant setup. If 
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there are other setups in the report time frame then additional setup tables and 
alarm tables will be displayed. 

 Battery and Reception alarms will be listed after the sensor alarms. 

 If no alarms were recorded during the report time frame, a No Alarm Events 
message will be displayed. 

 

Events Log 

Logs all events of each logger in the Report, as well as the time of the event. The 
events are: 

 Setup 

 Run 

 Stop 

 Connection to network 

 Disconnection from network 

 Firmware updated, including indication of previous and updated firmware version  

 Leave Network 

 

Unit Setup Log 

 Logs all the setups of the logger during the logging period 

 If no setups were performed during the report time frame the a No New Setup 
message will be displayed 

 

Unit Statistics 

Displays statistics for each sensor in the report. The calculated parameters are: 

 Min 

 Max 

 Average 

 Number of samples 

 

Sent Email Log 

Logs all emails that were sent during the report time frame. 

The details in the Sent Emails Log are: 

 Message that was sent 

 Date 

 Time 

 To whom the message was sent (groups will be displayed as groups) 

 

Sent SMS Log 

Logs all SMS’s that were sent during the report time frame. 

The details in the Sent SMS Log are: 

 Message that was sent 



 

211 

 Date 

 Time 

 To whom the message was sent (groups will be displayed as groups) 

 

Received SMS Log 

Logs all SMS’s that were sent to the DataSuite software during the report time frame. 

The details in the Received SMS Log are: 

 Message that was received 

 Date 

 Time 

 From whom the message was sent  

 

Sensor Graph 

The Sensor Graph log includes the following parameters: 

 Unit comment and S/N indicated as the graph header 

 Indication of sensor name, sensor type, start time & date and end time & date 
under each graph 

 A small graph of each sensor that is defined in the logger with its alarm levels 
displayed according to the alarm colors. The graph will be created according to 
the last logger setup. 

 The graph scaling will be set to autoscale 

 The graph will include grid lines 

 The alarm levels will be marked according to the alarm color and the alarm limit 
value will be indicated on the Y- axis 

 The graph dimensions will be 7.5 cm x 10.5 cm 

 

Sensor Histogram 

 Unit comment and S/N indicated as the graph header 

 Under each Histogram there will be indication of the sensor name, sensor type, 
start time & date and end time & date 

 A small histogram of each sensor defined in the logger will be displayed 

 The histogram will include an indication of the value of each bin on top of the bin 

 The graph dimensions will be 7.5 cm x 10.5 cm 

14.24.3. Removing a Report Profile 

To remove an existing report profile:  

1. Go to Reports > Reports Profile Manager in the main menu, or click the 

corresponding icon  in the upper toolbar. 

2. In the Profile list on the left side of the window, right-click the Report name to be 
removed and select Remove from the context menu. 

3. Enter the system password and when prompted, confirm the action. 
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14.24.4. The Report Browser 

Use the Report Browser to:  

 Open or delete generated reports saved in the Reports folder in the default 
DataSuite directory.  

 For DataSuite CFR module only, assign a Reviewed By or Approved By stamp on 
each report, based on the user’s privilege as defined in DatPass. 

 

Reports are displayed per Profile. 

1. Go to Reports > Report Browser in the main menu, or click the corresponding 

icon  in the upper toolbar. The Report Browser window will open. 

2. Select one of the profiles in the Profiles pane on the left side of the window. All 
reports generated under that profile will appear in the main Report pane. 

3. Use the Excel, PDF, Reviewed and Approved checkboxes to filter the reports to 
be displayed in the Report pane.  

 

4. To open a report click one of the reports in the list and click Open. 

5. In DataSuite CFR only, to sign the PDF report (Excel reports cannot be signed), 
select the specific report. The Review and Approve buttons are enabled.  

6. Depending on the user’s assigned privileges, click Review or Approve. The 
following dialog will pop up. Enter a Comment relating to the read report. 

 

7. Click OK. An updated report contained the user’s relevant report sign-off, 
(Reviewed or Approved) will be emailed to the user who generated the report. 

8. To delete a report click one of the reports in the list and click Delete. 

9. Click Close to close the Reports Browser window. 

14.25. Boomerang Report Overview 

Currently supported on the MicroLite II models only, the Boomerang feature is 
primarily designed for applications where the data logger is used to monitor ambient 
conditions during goods transportation, and a data report is required in order to verify 
the integrity of the shipment.  

The report can be generated at any stage during the shipment when the logger is 
connected to a computer with DataSuite installed, and will include all data recorded 
up to that stage of the shipment. Data is automatically and immediately sent via email 
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to the relevant parties upon connection. No configuration is required on the 
destination computer.  

In the event of any breach of defined thresholds, relevant action can be taken by 
onsite personnel in order to ensure the goods reach their markets in optimal 
conditions. 

14.25.1. Boomerang Setup – Point of Origin 

When configuring the MicroLite II logger in order to activate the Boomerang, the user 
must define the email addresses of the contacts to receive the Boomerang report. 
This information is saved to the logger flash memory and is retained as part of the 
logger setup, even if the battery is removed. The temperature unit (C or F) in which 
the data is to be recorded is also defined, as well as the time zone (GMT) that the 
report should be issued.  

 

To enable Boomerang: 

1. Right-click on the MicroLite II logger icon the Map View and select Setup. 

2. Perform logger setup using the Properties, Sensors and Display tabs. When 
complete, click on the Boomerang Report tab.  

3. Select the Include Boomerang Report checkbox. This enables the Boomerang 
feature on the connected logger, allowing generation of a data report when 
connected to another computer with DataSuite installed. When this checkbox is 
unselected, Boomerang is not enabled on the logger. 

4. Select the relevant temperature unit, C or F, for MicroLite II models measuring 
temperature. 

5. Enter the relevant name in the Generated by field. This is normally the name of 
the person responsible for the logger shipment. 

6. Enter a relevant comment in the Comment field. The comment can be a brief 
description of the specific shipment, so the report recipient will now which 
shipment or logger it is referring to.  
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7. To add the Boomerang report recipients, click the Add Contacts button and 
select from the DataSuite contact list or use the Custom Email field to add 
emails on-the-fly. 

8. When complete, use the buttons at the bottom of the window to continue with the 
logger setup. 

14.25.2. Boomerang Setup – Destination Computer 

By default, DataSuite (version 1.01.36 and higher) is already enabled to support 
generation and sending of Boomerang reports whenever a Boomerang-enabled 
logger is connected to it. 

To disable Boomerang on a destination computer (the computer where the logger will 
be connected during or post-shipment), go to Tools > Options > Device Settings 
and unselect the Generate and send Boomerang reports automatically checkbox. 

In addition, DataSuite (version 1.01.36 and higher) has a built-in default email 
account so the user is not required to configure their own email account from where 
the Boomerang report is sent. Of course, the user may choose to do so if necessary.  

14.25.3. Boomerang Email and Report Examples 

The Boomerang data report is sent to the defined contacts by the destination 
computer, as soon as the logger is detected by the software, and as long as an 
Internet connection is available. The report contains numerous parameters such as 
data statistics, data graph, and histogram, as well as the time/date the report was 
issued, and the time range of the report data. 

 

The email includes the report PDF, and indicates the logger Serial Number and the 
logger name, which in this case is ‘fourtec’ 

 

 

The Boomerang report is similar in structure to a standard DataSuite report but only 
contains data from the specific logger. 

 

Report Cover Page example: 
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Report Data Graph example: 
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Chapter 15:  
Updating DataSuite Software and 

Firmware 

DataSuite supports automatic software and firmware update whenever DataSuite is 
launched, as long as the computer is connected to the Internet. The update process 
is managed by fourtec’s Uptodata client. This client checks for updated software and 
firmware files located on the fourtec server, and if any have been detected they are 
downloaded and updated on the user’s computer. The user can also have DataSuite 
automatically update the network units’ firmware or can choose to do so manually.  

 

DaqLink, MicroLogPRO II and MicroLite all support easy firmware update via direct 
USB connection. A major benefit specific to the DataNet system is that units’ 
firmware can also be updated over the air as well as via USB (except for Mini 
DataNet). Without moving one deployed DataNet unit out of position in the network, 
the user can send a new firmware file wirelessly to all of the data logger end units 
and Repeaters. The Receiver firmware is updated via the USB cable.  

In addition to automatic firmware update, the DataSuite user can also manually 
update the firmware via the Firmware Update Center or from the Logger/Repeater 
icon in Map View. Refer to the relevant sections in this chapter for more details. 

15.1. Using the Uptodata Client 

Use the Uptodata client to perform automatic checks for updated DataSuite software 
module and firmware versions, including updated versions of this DataNet user 
guide. Once downloaded, DataSuite software and firmware is automatically updated. 
However, you also have the option to manually update firmware rather than 
automatically.  

To use the Uptodata client follow the instructions below.  

1. Ensure the computer is connected to the Internet and launch DataSuite. 

2. Launch the Uptodata update client from the DataSuite main menu: Help > 
Check for Updates.  

3. You will be prompted to proceed to check for new updates. Click Next. The client 
will then check for updates on the server, including updates to the Uptodata client 
itself. 

 

Figure 102: Uptodata dialog  
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4. Once the check is complete, any new updates will be displayed in the Uptodata 
dialog. Select the checkbox next to the file you wish to update and click Next. 

 

5. The files will be downloaded to your default application directory. Click Finish to 
close the dialog once the download is complete. 

 

6. Click the Options  icon in the main Uptodata dialog for further options 
such as:  

 Checking for updates on startup (select Further Configurations menu item 
to modify frequency of update checking) 

 Automatic firmware update on startup 

 

Figure 103: Uptodata configuration dialog 

 

Note: If the update was canceled for any reason and was not completed, none of the 
previous installation files will be affected. 
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15.2. Updating Device Firmware 

There are several ways to update firmware for your DataSuite supported hardware 
units. 

 Automatically, using the Uptodata client. Refer to section ‎15.1. 

 Manually using the Firmware Update Center. Refer to section ‎15.2.2. 

 Manually, using the context menu on the device icons in Map View.  

15.2.1. Downloading the Firmware File 

There are two ways to obtain the DataNet firmware file.  

1. Using the Uptodata client to download from the fourtec server. Refer to section 
‎15.1. 

2. Downloading the latest firmware version directly from the fourtec Download 
Center at: www.fourtec.com  

3. Uptodata downloads the firmware file, named Firmware.dfw, to the DataSuite 
directory on the computer. The default path is: C:\Program 
Files\fourtec\DataSuite. 

Note: The firmware file combines firmware for all DataSuite supported hardware 
units into one file. There is no need to download separate files for each type of unit.  

4. If you download the firmware file from the fourtec Download Center make sure to 
copy the file to the same path listed above. 

Once the file is downloaded the next step is to update the units. 

15.2.2. Using the Firmware Update Center 

To launch the Firmware Update Center: 

1. Once the downloaded firmware file is in the DataSuite directory, go to Tools > 
Firmware Update Center from the main menu. Enter the password in the 
Password dialog to access the Update Center.  

2. If no firmware file is detected in the DataSuite directory, then an error message is 
displayed and the Firmware Update Center opens with a blank screen.  

 

3. Copy the firmware file to the directory and reopen the Firmware Update Center. 

Note: The default password is 1234. 

4. The Firmware Update Center dialog lists all units which were detected by the 
software and displays pertinent information such as available firmware versions, 
firmware update status, online/offline status and unit info.  

file://aio1200/Documents/Ind-Docs/User%20Guides/Working%20Files/DataSuite/www.fourtec.com
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Figure 104: Firmware Update Center dialog 

5. If the unit status is Requires an update, then select the checkbox in the Update 
column adjacent to the unit you wish to update. You may select as many units as 
you like to update, but only two units can be updated at a time.  

6. As soon as you select the Update checkbox, the command will be sent to the unit 
to begin uploading the firmware. The firmware is first uploaded to the unit’s 
memory and then installed. Even if the update is stalled halfway due to the unit 
shutting down, for example, the unit will not lose its current firmware and so will 
continue to be operable.  

7. When the upload begins the Firmware Update Center status will change to 
Uploading firmware file and the unit display will read Loading firmware. The 
progress will also be displayed on both hardware and software. 

 

8. When the upload is complete the unit will reset and the Firmware Update Center 
will display the status No update required. The firmware version will be updated 
as well. 

Note: You can quit the firmware update at any time by unselecting the Update 
checkbox in the Update Center. 

9.  When the unit resets it will automatically rejoin the network (for DataNet units) or 
reconnect via USB and will be in Stop mode. However the unit configuration will 
still be saved. For loggers which have completed firmware update, run the logger 
to start recording data again. 

 

Checking Available Firmware Versions 

1. Available firmware versions are displayed at the top of the Firmware Update 
Center dialog. The information is taken from the firmware file Firmware.dfw stored 
in the DataSuite directory. The same firmware file is used for all units. 
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Unit Status Options 

 Offline – unit is offline and firmware status can’t be determined. 

 No update required – Unit has latest firmware installed. 

 Uploading firmware file – Firmware file is being uploaded to the unit. Progress 
is displayed in percentages. 

 Updating firmware – Once firmware file is uploaded then the actual firmware 
update begins, overwriting the existing firmware on the unit. 

 Downloading – Logger unit is first downloading all data before beginning the 
firmware update.  

 Waiting to upload firmware – Unit is in a queue to upload the firmware, as the 
network can update two units at a time.  

 

Unit Information  

Additional information provided in the Firmware Update Center includes:  

 The unit comment/name 

 Serial number 

 Current firmware version 

 Unit status 

 Update progress 

15.2.3. Manual Firmware Update via Map View Icon 

Each DataSuite supported device, including data loggers and DataNet Receivers and 
Repeaters, have the Update Firmware option in its Map View icon context menu.  

DataNet units may have firmware updated wirelessly, or via USB. Refer to section 
‎15.2.4 for an overview of DataNet USB firmware update.  

1. To perform a direct update from a specific unit, open the context menu and select 
Update Firmware. 

2. Enter the password in the Password dialog box. 

3. Depending on the product model, a DataSuite system message may prompt you 
to confirm the update. Click Yes. 

 

4. The firmware will begin updating and you can monitor its progress in the unit’s 
tooltip. 
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15.2.4. DataNet Firmware Update via USB  

All DataNet units with USB port can also be updated via direct USB to PC 
connection. Follow the instructions below. 

DNR900 Receiver 

1. Connect the DNR900 to the computer via USB. Go to Devices > Detect Device 
in the DataSuite main menu. 

2. Right-click on the Receiver icon  and select Update Firmware from the 
context menu. 

3. Enter the password in the Password dialog box. 

4. A DataSuite system message will prompt you to confirm the update. Click Yes. 

 

5. The firmware will begin updating and you can monitor its progress in the unit’s 
tooltip. 

 

 

DNR900 Repeater  

1. Make sure the DNR900 is in Repeater mode and joined to an existing network. 
When connected to the computer via USB go to Devices > Detect Device in the 
DataSuite main menu. 

2. Right-click on the Repeater icon  and select Update Firmware from the 
context menu. 

3. Enter the password in the Password dialog box. 

4. A DataSuite system message will prompt you to confirm the update. Click Yes. 
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5. The firmware will begin updating and you can monitor its progress in the unit’s 
tooltip. 

 

6. When complete, disconnect the USB cable and reconnect the Receiver to 
continue using the DataNet system. 

 

DNL910, DNL920 and PA Data Loggers  

1. Make sure the data logger is joined to an existing network. When connected to 
the computer via USB go to Devices > Detect Device in the DataSuite main 
menu. 

2. Right-click on the logger icon  and select Update Firmware from the context 
menu. 

3. Enter the password in the Password dialog box. 

4. A DataSuite system message will prompt you to confirm the update. Click Yes. 

 

5. The firmware will begin updating and you can monitor its progress in the unit’s 
tooltip. 

 

6. When complete, disconnect the USB cable and reconnect the Receiver to 
continue using the DataNet system. 
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15.2.5. Cancelling Firmware Update 

To cancel a firmware update, right-click the unit’s icon in the Map View and select the 
Cancel Firmware Update option. 

If a data logger was in Run mode prior to the firmware update, when cancelling it the 
logger will resume operation in Stop mode. 

15.2.6. Interrupted Firmware Update  

There are several ways an in-progress firmware update may be interrupted:  

 Unselecting the checkbox next to the unit name in the Firmware Update Center  

 Disconnecting the USB from the Receiver  

 Disconnecting the USB from the device during USB firmware update  

 Exiting the DataSuite software 

In each case, when the unit is back online the firmware update will automatically 
resume (from the beginning of the update). 

If a data logger’s firmware update was interrupted, and it was in Run mode prior to 
the update, the logger will continue to run even after the interruption.  
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Appendix A:  
DataNet Specifications 

A.1. DNR900, DNL910, DNL920, PA Unit Outputs 

  

DNL910, DNL920 and PA Models 

External Inputs 

Four external inputs with selectable 
sensor type for each input:  

 4 to 20 mA 

 0 to 1 V 

 0 to 50 mV 

 PT-100 (2-wire) 

 Contact (Open/Closed) 

 Thermocouple J, K or T 

 Pulse counter (Input 4 only) 

 Frequency (Input 4 only)  

 User-defined sensors 

Internal Inputs 

DNL910 

 PT-100 Temperature 

DNL920 

 Digital Temperature 

 Digital Relative Humidity 

DNL804 

External Input  

Current 4 to 20 mA 

Internal Inputs 

None 

DNL808 

External Input  

NTC 10 KΩ 

Internal Inputs 

None 

DNL810  

External Input 

None 

Internal Inputs 

Digital Temperature 

Digital Humidity 

 

Alarm Output (Output 1) External Power Excitation 
(transducers usage) 

Open collector 

Close position resistance: 50 Ω 

Max. Load: 50 mA, 3 V DC 

 

12 VDC @ 2 A 

Reset fuse overload protection 
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A.2. Logger Input Specifications DNL910, 

DNL920 and PA models 

Internal PT-100 
Temperature  

(DNL910) 

Internal Digital 
Temperature  

(DNL920) 

Internal Digital  

Relative Humidity 

(DNL920) 

Type: PT-100 

Range: -20 to 50 ˚C 

Resolution: 0.1 ˚C  

Accuracy: ±0.3 ˚C 

Type: Digital sensor 

Range: -20 to 50 ˚C 

Resolution: 0.1 ˚C  

Accuracy: ±0.5 ˚C 

Range: 5 to 95 % 

Resolution: 0.5% 

Accuracy: 3% (software) 

4% (Logger LCD) 

Temperature 
Thermocouple J 

Temperature 
Thermocouple K 

Temperature 
Thermocouple T 

Range: -200 to 1,000 ˚C 

Resolution: 0.1 ˚C  

Accuracy: 

-200 to – 60 ˚C ±0.5 % 

60 to 1,000 ˚C ±0.5 % 

-60 to 60 ˚C ±0.5 ˚C 

Cold junction 
compensation: ±0.3 ˚C 

Range: -200 to 1,000 ˚C 

Resolution: 0.1 ˚C  

Accuracy:  

-200 to – 60 ˚C ±0.5 % 

60 to 1,000 ˚C ±0.5 % 

-60 to 60 ˚C ±0.5 ˚C 

Cold junction 
compensation: ±0.3 ˚C 

Range: -200 to 400 ˚C 

Resolution: 0.1 ˚C  

Accuracy:  

-200 to – 60 ˚C ±0.5 % 

60 to 400 ˚C ±0.5 % 

-60 to 60 ˚C ±0.5 ˚C 

Cold junction 
compensation: ±0.3 ˚C 

Temperature PT-100 

(2-wire) 

Pulse Counter  

(Input 4 only) 

Frequency  

(Input 4 only) 

Range: -200 to 400 ˚C 

Resolution: 0.1 ˚C) 

Accuracy:  

-200 to - 60 ˚C ±0.5 % 

60 to 400 ˚C ±0.5 % 

-60 to 60 ˚C ±0.3 ˚C 

Range: 1 to 65,536 
counts 

Resolution: 1 count 

Frequency range: 0 to 4 
KHz 

Input signal: 0 to 3.2 V 

Input impedance: 470 Ω  

Range: 20 Hz to 4 KHz 

Input signal: 0 to 5 V 

Input impedance: 470 Ω 

 

 

4 to 20 mA 0 to 1 V 0 to 50 mV 

Range: 4 to 20 mA 

Resolution: 4.76 μA 

Accuracy: ±0.5 % 

Loop impedance: 21 Ω 

Range: 0 to 1 V 

Resolution: 200 μV 

Accuracy: ±0.5 % 

Input impedance: 25 
MΩ 

Maximum voltage: 3.2 
V 

Range: 0 to 50 mV 

Resolution: 3 μV 

Accuracy: ±0.5 % 

Input impedance: 25 
MΩ 

Maximum voltage: 3.2 
V 

Contact   

Range: Open/Close   
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A.3. Mini DataNet Sensor Specifications  

Current 

(DNL804) 

NTC 10 KΩ  

(DNL808) 

Range: 4 to 20 mA 

Resolution: 1.16 uA 

Accuracy: 0.5 % 

Loop impedance: 21 Ω 

 

Range: -50 to 150 °C 

Resolution: 0.06 °C 

Accuracy:  

-50 to 60 ˚C ±0.3 ˚C 

60 to 150 ˚C ±0.5 % 

Internal Digital Temperature  

(DNL810) 

Internal Digital  

Relative Humidity 

(DNL810) 

Temp range: -20 to 50 °C 

Temp resolution: 0.04 °C 

Temp accuracy: ±0.4 °C 

RH range: 5 to 95 % 

RH resolution: 0.5 % 

RH accuracy: ±3 % 

A.4. General Specifications 

DataNet Logger Sampling Features 

 Memory capacity: ~59,000 samples 

 Sampling rate: Once every second to once every 18 hours 

 Sampling resolution: 16-bit 

 Channel separation: 80 dB 
 

DataNet RF Network Communication  

 Frequency: 2.4 GHz 

 Network units: 65,000 

 Data rate: 250 Kbps 

 Full mesh network architecture supported 

 128-bit network security encryption 

 Worldwide license-free 

 Transmission strength: 

 DNL8xx and DNL9xx: 4 dbm   

 DNR900, DNL9xx-PA: 17 dbm   

 DNR800: 20 dbm    

 

DNR900, DNL910, DNL920, DNL910-PA and DNL920-PA Hardware 
Specifications  

Display  

 2-row LCD 

 16 character display 
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Power Supply  

 Battery:  

 Internal rechargeable 4.8 V, 800 mAh  NiMH battery (2 batteries in series) 

 Built-in battery charger 

 Battery Life: Up to six months * 

* PA models have battery life of up to three hours  

 AC Power: 

 External 12 V DC input @ 300 mA 3.6 VA 

 Center Negative 
   

Operating Temperature Range 

 -20 to 50 ˚C 

 Water and dust proof: IP54 
 

DNR900 PC Communication 

 USB 2.0 compliance 

 Mini USB type B cable 

 

Casing 

 Plastic ABS box 

 Dimensions: 97 x 93 x 27 mm   

 Weight: 200 gr  

 Table and wall mounting 
 

DNR800 Hardware Specifications 

Power Supply  

 External 12 V DC input @ 300 mA 3.6 VA 

 Center Negative  

 

Casing 

 Dimensions: 68 x 68.6 x 26.5 mm (without the cradle and the external antenna) 

 Weight: Device: 61 gr; Cradle: 10 gr; External Antenna: 17.5 gr 

 Table and wall mounting 
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Operating Temperature Range 

 -30 to 75 ˚C 

 Water and dust proof: IP54 

 

Mini DataNet Hardware Specifications 

DNL804, DNL808 and DNL810  

Power Supply 

 Internal 2/3 AA lithium battery 

 Battery voltage range: 2V - 3.6 V 

 Battery life: Up to 10 months depending on sampling rate  
 

Casing 

 Dimensions: 68 x 68.6 x 26.5 mm (without the cradle and the external antenna) 

 Weight: Logger: 53 gr; Cradle: 10 gr; External Antenna: 17.5 gr 

 Table and wall mounting 
 

Operating Temperature Range 

 -30 to 75 ˚C 

 Water and dust proof: IP54 
 

Mini DataNet Extended Battery Pack Hardware Specifications 

DNL804-BXT, DNL808-BXT, DNL810-BXT 

 

Power Supply 

 External battery pack 

 4 x AA 3.6 V lithium battery 

 Battery life: Up to 3 years depending on sampling rate  

 

Casing 

 Dimensions 

 DNL810-BXT: 10.2 x 8.8 x 5.3 cm (without the external antenna) 

 DNL804-BXT and DNL808-BXT: 9 x 8.8 x 5.3 cm (without the external 
antenna and strain relief add-on) 

 Weight:  

 137 g not including batteries 

 218 g including four batteries 

 External Antenna: 17.5 g 

 Wall mounting 
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Operating Temperature Range 

 -30 to 75 ˚C 

 Water and dust proof: IP54 

 

Man Machine Interface 

Full keyboard operation 

  

Standards Compliance 

CE, FCC, FCC Canada 

A.5. System Requirements 

Software Hardware 

OS Platform: Windows XP SP3, Windows 
Vista (32-bit) and Windows 7 (32-bit) 

Browser: Internet Explorer 5.01 or higher 

Screen Resolution: Minimum 1024 x 768 

Processor: Pentium 4, 2.0 GHz or better  

Memory: 512 MB RAM  

Storage Memory: 250 MB available disk 
space for the DataSuite application 
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Appendix B:  
DaqLink Specifications 

B.1. Data Logger Input Types 

DBSA710 and DBSA720 

External Inputs 

Four external inputs with selectable sensor 
type for each input:  

 4 to 20 mA 

 0 to 1 V 

 0 to 50 mV 

 PT-100 (2-wire) 

 Contact (Open/Closed) 

 Thermocouple J, K or T 

 Pulse counter (Input 4 only) 

 Frequency (Input 4 only)  

 User-defined sensors 

Internal Inputs 

DBSA710 

 PT-100 Temperature 

DBSA720 

 Digital Temperature 

 Digital Relative Humidity 

B.2. DBSA710 and DBSA720 Outputs   

Alarm Output (Output 1) External Power Excitation 
(transducers usage) 

Open collector 

Close position resistance: 50 Ω 

Max. Load: 50 mA, 3 V DC 

12 VDC @ 2 A 

Reset fuse overload protection 

 

B.3. Logger Input Specifications DBSA710 and 

DBSA720 

Internal PT-100 
Temperature  

(DBSA710) 

Internal Digital 
Temperature  

(DBSA720) 

Internal Digital  

Relative Humidity 

(DBSA720) 

Type: PT-100 

Range: -20 to 50 ˚C 

Resolution: 0.1 ˚C  

Accuracy: ±0.3 ˚C 

Type: Digital sensor 

Range: -20 to 50 ˚C 

Resolution: 0.1 ˚C  

Accuracy: ±0.5 ˚C 

Range: 5 to 95 % 

Resolution: 0.5% 

Accuracy:  

3% (DataSuite software) 

4% (Logger LCD) 
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Temperature 
Thermocouple J 

Temperature 
Thermocouple K 

Temperature 
Thermocouple T 

Range: -200 to 1,000 ˚C 

Resolution: 0.1 ˚C  

Accuracy: 

-200 to – 60 ˚C ±0.5 % 

-60 to 60 ˚C ±0.5 ˚C 

60 to 1,000 ˚C ±0.5 % 

Cold junction 
compensation: ±0.3 ˚C 

Range: -200 to 1,000 ˚C 

Resolution: 0.1 ˚C  

Accuracy:  

-200 to – 60 ˚C ±0.5 % 

-60 to 60 ˚C ±0.5 ˚C 

60 to 1,000 ˚C ±0.5 % 

Cold junction 
compensation: ±0.3 ˚C 

Range: -200 to 400 ˚C 

Resolution: 0.1 ˚C  

Accuracy:  

-200 to – 60 ˚C ±0.5 % 

-60 to 60 ˚C ±0.5 ˚C 

60 to 400 ˚C ±0.5 % 

Cold junction 
compensation: ±0.3 ˚C 

Temperature PT-100 

(2-wire) 

Pulse Counter  

(Input 4 only) 

Frequency  

(Input 4 only) 

Range: -200 to 400 ˚C 

Resolution: 0.1 ˚C) 

Accuracy:  

-200 to - 60 ˚C ±0.5 % 

-60 to 60 ˚C ±0.3 ˚C 60 to 
400 ˚C ±0.5 % 

 

Zero crossing detector 

Range: 1 to 65,536 counts 

Resolution: 1 count 

Frequency range: 0 to 4 
KHz 

Input signal: 0 to 5 V 

Input impedance: 470 Ω  

Zero crossing detector 

Range: 20 Hz to 4 KHz 

Input signal: 0 to 5 V 

Input impedance: 470 Ω 

 

 

4 to 20 mA 0 to 1 V 0 to 50 mV 

Range: 4 to 20 mA 

Resolution: 4.76 μA 

Accuracy: ±0.5 % 

Loop impedance: 21 Ω 

Range: 0 to 1 V 

Resolution: 200 μV 

Accuracy: ±0.5 % 

Input impedance: 25 MΩ 

Maximum voltage: 5.2 V 

Range: 0 to 50 mV 

Resolution: 3 μV 

Accuracy: ±0.5 % 

Input impedance: 25 MΩ 

Maximum voltage: 5.2 V 

Contact   

Range: Open/Close   

B.4. General Specifications 

DaqLink Logger Sampling Features 

 Memory capacity:  ~38,000 samples in Online Mode 

 ~59,000 samples in Optimized Memory Mode  

 Sampling rate:  Once per sec to once every 18 hours 

 Sampling resolution: 16-bit 

 Channel separation: 80 dB 
 

DBSA710 and DBSA720 Hardware Specifications  

Display  

 2-row LCD 

 16 character display 
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Power Supply  

 Battery:  

 Internal rechargeable 4.8 V, 800 mAh  NiMH battery (2 batteries in series) 

 Built-in battery charger 

 Battery Life: Up to six months depending on logger configuration 

 AC Power: 

 External 12 V DC input @ 300 mA 3.6 VA 

 Center Negative 
   

Operating Temperature Range 

 -20 to 50 ˚C 

 Water and dust proof: IP54 
 

Man Machine Interface 

Full keyboard operation 

  

Standards Compliance 

CE, FCC, IC Canada 

B.5. System Requirements 

Software Hardware 

OS Platform: Windows XP SP3, Windows 
Vista (32-bit) and Windows 7 (32-bit) 

Browser: Internet Explorer 5.01 or higher 

Screen Resolution: Minimum 1024 x 768 

Processor: Pentium 4, 2.0 GHz or 
better  

Memory: 512 MB RAM  

Storage Memory: 250 MB available 
disk space for the DataSuite application 
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Appendix C:  
MicroLite Specifications  

C.1. General Specifications 

 LITE5008 

LITE5016 

LITE5008P 

LITE5032P 

LITE5032P-RH LITE5032P-
4/20 

LITE5032P-V LITE5032P-EXT 

Specification Internal Temp Internal Temp Internal Temp/RH 4-20 mA 0-10 V External NTC 

Range  
Temp: -40 to 

80 °C 

Temp: -40 to 

80 °C 

Temp: -40 to 80 °C 

RH: 5-95 % 
4-20 mA 0-10 V -50 to 150 °C 

Accuracy  Temp: 0.3 ˚C Temp: 0.3 ˚C 
Temp: 0.3 ˚C 

RH: ± 2% 
± 380 pA ±0.5 % 

-50 to 60 ˚C 

±0.3 ˚C 

60 to 150 ˚C 

±0.5 % 

Resolution  

0.1 °C (display) 

0.06 °C 

(software) 

0.1 °C (display) 

0.06 °C 

(software) 

Temp:  
0.1 °C (display) 
0.06 °C (software) 

RH: 0.5% 

1.16 uA 200 μV 

0.1 °C 

(display) 

0.06 °C 

(software) 

Maximum Load N/A N/A N/A 25 mA, 3 V 12 V N/A 

Dew Point X X √ N/A N/A N/A 

LCD Display √ √ √ √ √ √ 

LED Alarm 

Indicator  
X √ √ √ √ √ 

USB 2.0 √ √ √ √ √ √ 

Sample 

Memory 

8,000 and 

16,000 

8,000 and 

32,000 

32,000 

(16K per channel) 
32,000 

Sampling Rate 

Once per 
second / once 

every 2 hours 
Once per second / once every 18 hours 

Battery Type/ 

Battery Life 

CR2032 3V 

1.5 years, 
depending on 

sampling rate 

CR2032 3V 

2 years, depending on sampling rate 

Operating 

Environment 
-40 to 80 C 

Dimensions 
(with cap) 

 

11 x 3.9 x 2.6 cm 

 

11 x 3.9 x 3 cm 

 

14 x 3.9 x 2.6 cm 

 

Weight 45.5 g 

Standards 

Compliance 

CE, EN12830,  

IP68 

CE, EN12830,  

IP54 

Wall Mount X Logger cradle accessory provided 
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C.2. System Requirements 

Software Hardware 

OS Platform: Windows XP SP3, 
Windows Vista (32-bit) and Windows 7 
(32-bit) 

Browser: Internet Explorer 5.01 or 
higher 

Screen Resolution: Minimum 1024 x 
768 

Processor: Pentium 4, 2.0 GHz or 
better  

Memory: 512 MB RAM  

Storage Memory: 250 MB available 
disk space for the DataSuite 
application 
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Appendix D:  
MicroLogPRO II Specifications  

D.1. General Specifications 

 EC800 EC850 

Internal sensor range Temp:  
-40 to 80 °C 

Temp:  
-40 to 80 °C 

RH: 5 to 95% 

Temperature 
accuracy 

± 0.2 °C 

Humidity accuracy N/A ± 2% 

Temperature 
Resolution 

0.06 °C 0.04 °C 

Humidity Resolution N/A 0.1 % 

External Sensor 
Support 

Temperature, 4-20 mA, 0-10 V, pH 

Memory capacity 52,000 samples 

(over 3 channels) 

Sampling rate Minimum: Once every second 

Maximum: Once every 18 hours 

LCD display Four digit, 7-segment LCD with decimal point 

Dew Point LCD and Software indication 

LED  Bi-color Alarm 

PC Connection Mini-USB 

Power supply 2/3 AA 3.6V Lithium battery 

Battery life ~ 2 years depending on sampling rate 

Dimensions Diameter: 72 mm 
Thickness: 22.9 mm 

Weight 55 g 

Wall Mount Cradle accessory 

Standards 
Compliance 

CE, IP65 CE, IP54 

 



 

236 

D.2. System Requirements 

Software Hardware 

OS Platform: Windows XP SP3, 
Windows Vista (32-bit) and Windows 7 
(32-bit) 

Browser: Internet Explorer 5.01 or 
higher 

Screen Resolution: Minimum 1024 x 
768 

Processor: Pentium 4, 2.0 GHz or 
better  

Memory: 512 MB RAM  

Storage Memory: 250 MB available 
disk space for the DataSuite 
application 

 



 

237 

Appendix E:  
DataNet Mounting Diagrams 

This appendix includes mechanical diagrams of the DNL and DNR DataNet models. 
The diagrams include dimensions to be used as a reference for mounting the units 
on the wall. 

Rear Casing Dimensions for DNL9XX and DNR9XX Wall Mounting 
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Cradle Dimensions for DNL8XX and DNR800 Wall Mounting 
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Appendix F:  
Mini DataNet BXT Assembly 

Instructions 

Upgrade Kit Contents 

 Main plastic body (with key pad) 

 Circuit board compartment cover + 2 screws 

 Battery holder compartment cover + 1 screw 

 Battery holder with 2 wires + 4 x AA 3.6 V batteries 

 Sensor strain relief cover + 2 screws 

 2 screws and dibbles for logger wall mounting 

 

To convert standard DNL8XX Mini DataNet units to the new DNL8XX-BXT featuring 
the extended battery pack plastic casing, follow the instructions below. 

Note: Only an authorized fourtec distributor should perform the BXT conversion.  

 

1. Remove the two screws located on the top panel of the standard Mini DataNet 
logger (where the antenna is connected) and with care pull out the internal 
compartment containing the logger circuit board and battery.  

2. Remove the battery from the circuit board. 

3. Take the main BXT plastic body from the BXT packaging and gently pull the red 
and black wires out from the compartment which will house the Mini DataNet 
circuit board.  

4. Solder the wires to the circuit board: Black wire on the negative (-) battery 
contact, Red wire on the positive (+) battery contact. See example below: 

 

5. Insert the Mini DataNet circuit board into the main BXT plastic body, so that the 
logger button will be facing the outside of the plastic casing.  
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6. Close the compartment housing the circuit board with the plastic panel, using the 
two screws provided. Re-attach the Mini DataNet antenna to the screw terminal 
which sticks out from the plastic panel. 

7. Remove the black battery holder from the main BXT plastic body and insert the 4 
x AA batteries provided.  

 

8. Place the battery holder back into the BXT body and close the battery 
compartment with the provided plastic cover. Secure the cover to the plastic body 
using the screw provided.  

9. The BXT logger is now ready for use. Please contact support@fourtec.com with 
any problems. 

 

 

 

  

mailto:support@fourtec.com
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Appendix G:  
Safety Information and FCC IDs 

The DataNet system complies with relevant safety regulations for data processing 
devices. Please contact fourtec with any questions regarding DataNet safety issues.  

Note: The manufacturer is not responsible for any radio or TV interference caused by 
unauthorized modifications to this equipment. Such modifications could void the 
user’s authority to operate the equipment. 

 

FCC ID for DataNet System 

DNR900: 

 

DNL910: 

 

DNL920: 

 

DNR800: 

 

DNL910-PA 

 

DNL920-PA 

 

DNL804: 

 

DNL808: 

 

FCC ID: XGO-DNR9XX

This device complies with Part 

15 of the FCC Rules. Operation 

is subject to the following two 

conditions:

(1) This device may not cause 

harmful interference and

(2) This device must accept any 

interference received, including 

interference that may cause 

undesired operation.

FCC ID: XGO-DNL9XX

This device complies with Part 

15 of the FCC Rules. Operation 

is subject to the following two 

conditions:

(1) This device may not cause 

harmful interference and

(2) This device must accept any 

interference received, including 

interference that may cause 

undesired operation.

FCC ID: XGO-DNL9XX

This device complies with Part 

15 of the FCC Rules. Operation 

is subject to the following two 

conditions:

(1) This device may not cause 

harmful interference and

(2) This device must accept any 

interference received, including 

interference that may cause 

undesired operation.

FCC ID: XGO-DNR8XX

This device complies with Part 

15 of the FCC Rules. Operation 

is subject to the following two 

conditions:

(1) This device may not cause 

harmful interference and

(2) This device must accept any 

interference received, including 

interference that may cause 

undesired operation.

FCC ID: XGO-DNL9XX-PA

This device complies with Part 

15 of the FCC Rules. Operation 

is subject to the following two 

conditions:

(1) This device may not cause 

harmful interference and

(2) This device must accept any 

interference received, including 

interference that may cause 

undesired operation.

FCC ID: XGO-DNL9XX-PA

This device complies with Part 

15 of the FCC Rules. Operation 

is subject to the following two 

conditions:

(1) This device may not cause 

harmful interference and

(2) This device must accept any 

interference received, including 

interference that may cause 

undesired operation.

FCC ID: XGO-DNL8XX

This device complies with Part 

15 of the FCC Rules. Operation 

is subject to the following two 

conditions:

(1) This device may not cause 

harmful interference and

(2) This device must accept any 

interference received, including 

interference that may cause 

undesired operation.

FCC ID: XGO-DNL8XX

This device complies with Part 

15 of the FCC Rules. Operation 

is subject to the following two 

conditions:

(1) This device may not cause 

harmful interference and

(2) This device must accept any 

interference received, including 

interference that may cause 

undesired operation.
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DNL810: 

 

 

 

DataNet Battery 

The DataNet DNR900, DNL910, DNL920, DNL910-PA and DNL920-PA devices are 
supplied with internal rechargeable 4.8 V NiMH batteries as well as connection to AC 
power. 

The Mini DataNet DNL804, DNL808 and DNL810 data loggers are supplied with 1 x 
2/3 AA lithium battery. 

 

 Do not tamper or drop the battery to avoid leakage of hazardous chemicals 
contained within.  

 Do not puncture, incinerate, disassemble or expose the battery to temperatures 
above 122 ºF (50 ºC). 

 Keep the battery away from children. 

 Dispose of the battery only in accordance with local regulations concerning 
potentially hazardous waste. Do not throw in the garbage bin. 

 Remove the battery when not using the DataNet loggers for a significant period of 
time e.g. when the DataNet loggers are placed in long-term storage.  

 

DataNet AC Power Adapter 

 Only use the AC adapter provided by fourtec. 

 Verify that your power outlet is suitable for the voltage of the AC adapter. 

 If the AC adapter is connected to an AC outlet, make sure the area around the 
outlet is accessible and the adapter is not covered while in operation. 

 Do not place the AC adapter on heat-sensitive material. 

 Do not charge the DataNet while situated in a carrying case or without sufficient 
airflow surrounding the loggers. 

 Do not expose the adapter to direct sunlight or water. 

 Do not tamper with the adapter components. 

 

DataNet Operating Environment 

 DNR900, DNL910, DNL920, DNL910-PA and DNL920-PA: -20 to 50 ˚C 

 DNR800, DNL804, DNL808, DNL810 and BXT models: -30 to 75 ˚C 

 

FCC ID: XGO-DNL8XX

This device complies with Part 

15 of the FCC Rules. Operation 

is subject to the following two 

conditions:

(1) This device may not cause 

harmful interference and

(2) This device must accept any 

interference received, including 

interference that may cause 

undesired operation.
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Appendix H:  
Ordering Information 

For the full list of fourtec products, and to place fourtec orders please visit 
http://www.fourtec.com or contact your local fourtec distributor: 

 

Product Suite 

Part Number Product Name Product Description 

DNR900 

 

DataNet 
Receiver/Repeater 

Two-mode module for creating 
and managing DataNet ZigBee 
network, and extending network 
transmission range 

DNR800 

 

DataNet Mini Repeater  Module for extending network 
transmission range 

 External AC power supply only 

DNL910 

 

DataNet Temp. Data 
Logger  

 Internal Temperature PT-100 
sensor 

 Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 

DNL920 

 

DataNet Temp/RH Data 
Logger 

 Internal Digital RH and 
Temperature sensors 

 Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 

DNL910-PA 

 

DataNet Temp. Data 
Logger with Power 
Amplifier   

 Internal Temperature PT-100 
sensor 

 Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 

 Includes Power Amplifier for 
long-range transmission 

DNL920-PA 

 

DataNet Temp/RH Data 
Logger with Power 
Amplifier 

 Internal Digital RH and 
Temperature sensors 

 Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 

 Includes Power Amplifier for 
long-range transmission  

http://www.fourtec.com/
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Part Number Product Name Product Description 

DNL810 

 

Mini DataNet Temp/RH 
Logger 

 Internal Digital Temperature 
and Humidity sensors 

 Battery operated 

DNL808 

 

Mini DataNet External 
Temp. Logger 

 External NTC 10 KΩ 
Temperature input with NTC 
probe 

 Battery operated 

DNL804 

 

Mini DataNet External 
Current Data Logger 

 External 4-20 mA input 

 Battery operated 

DNL810-BXT 

 

Mini DataNet Temp/RH 
Logger 

 Internal Digital Temperature 
and Humidity sensors 

 External battery pack 
supporting 4 x AA 3.6 V 
battery, 3-year life  

DNL808-BXT 

 

Mini DataNet External 
Temp. Logger 

 External NTC 10 KΩ 
Temperature input with NTC 
probe 

 External battery pack 
supporting 4 x AA 3.6 V 
battery, 3-year life 

DNL804-BXT 

 

Mini DataNet External 
Current Data Logger 

 External 4-20 mA input 

 External battery pack 
supporting 4 x AA 3.6 V 
battery, 3-year life 

DBSA710 

 

DaqLink Data Logger   Internal Temperature PT-100 
sensor 

 Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 
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Part Number Product Name Product Description 

DBSA720 

 

DaqLink Data Logger  Internal Digital RH and 
Temperature sensors 

 Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 

LITE5008 

 

MicroLite USB Temp 
Logger 

 Internal NTC Temp sensor 

 8k sample memory 

LITE5016 

 

MicroLite USB Temp 
Logger 

 Internal NTC Temp sensor 

 16k sample memory 

LITE5008P 

 

MicroLite II USB Temp 
Logger 

 Internal NTC Temp sensor 

 8k sample memory 

LITE5032P 

 

MicroLite II USB Temp 
Logger 

 Internal NTC Temp sensor 

 32k sample memory 

LITE5032P-RH 

 

MicroLite II USB 
Temp/RH Logger 

 Internal Digital Temp/RH 
sensor 

 32K sample memory 

LITE5032P-EXT 

 

MicroLite II USB External 
Temp Logger 

 External NTC Temp input 

 32K sample memory 

LITE5032P-V 

 

MicroLite II USB Voltage 
Logger 

 External 0-10 V input 

 32K sample memory 

LITE5032P-4/20 

 

MicroLite II USB Current 
Logger 

 External 4-20 mA input 

 32K sample memory 

EC800 

 

MicroLogPRO II Temp 
Data Logger 

 Internal NTC Temp sensor 

 External sensor input 

EC850 

 

MicroLogPRO II Temp 
Data Logger 

 Internal Digital RH and Temp 
sensor 

 External sensor input 
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Part Number Product Name Product Description 

DT139A 

 

External Current Adapter 
for MicroLogPRO II 

External 4-20 mA input 

DT140A-ML2 

 

External Voltage Adapter 
for MicroLogPRO II 

External 0-10 V input 

DT132A 

 

External Temperature 
NTC probe for 
MicroLogPRO II 

 -50 to 110 °C temperature 
range 

 2.5 m cable length 

DT277A External PT-100 adapter 
for MicroLogPRO II 

-200 to 400 °C temperature range 

 

DataSuite-SW 

  

Software CD and 
Accessories 

DataSuite software CD and USB 
communication cable 

13825 

 

External Alarm Siren + 
Strobe 

Connects to DataNet and DaqLink 

12504 

 

GSM Modem Quad band GSM modem for 
sending SMS alarm notifications 
from DataSuite 

DT332 

 

NTC temperature sensor 
and cable 

NTC 10 kΩ temperature sensor  

 Range: -50 to 150 °C  

 2.5 m cable length 

12753 

 

PT-100 temperature 
sensor and cable 

PT-100 temperature sensor  

 Range: -70 to 400 °C   

 2.5 m cable length 

12752 

 

PT-100 temperature 
sensor and cable 

PT-100 temperature sensor  

 Range: -70 to 400 °C   

 4 m cable length 

12751 

 

PT-100 temperature 
sensor and cable 

PT-100 temperature sensor  

 Range: -70 to 400 °C   

 6 m cable length 
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Part Number Product Name Product Description 

13330 

 

 

 

3 m mini-USB 
communication cable 

For connection between device 
and PC 

12928 

 

Replacement internal 
battery 

 

 Replacement internal battery 
for Mini DataNet and 
MicroLogPRO II 

 2/3 AA 3.6 V lithium  

11199 

 

Calibration Certificate Available through advance order 

DataSuite-CFR DataSuite CFR software 
module 

Compliance for FDA Title 21 CFR 
Part 11 
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